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Preface

This guide covers the configuration, use, and troubleshooting of SolsticeTM X.25 9.2. It
also provides reference material. This guide does not cover the installation and
licensing of Solstice X.25 9.2. For this, refer to the Solstice X.25 9.2 Installation Guide
and Release Notes. It also does not cover the use of the Packet Assembler/
Disassembler delivered as part of the product. For this, refer to the Solstice X.25 9.2
PAD User’s Guide.

How This Book Is Organized
Chapter 1, provides an overview of the Solstice X.25 9.2 product.

Chapter 2, provides background information on the X.25 Recommendations.

Chapter 3, covers points to consider when planning your configuration.

Chapter 4, introduces the x25tool and provides a step-by-step example of a basic
configuration.

Chapter 5, introduces the configuration files and provides a step-by-step example of
editing the files to create a basic configuration.

Chapter 6, covers the configuration of the IP and PAD applications.

Chapter 7, provides reference information on all available parameters.

Chapter 8, contains descriptions of some common configurations.

Chapter 9, lists the available command line utilities.

Chapter 10, is a description of how to configure uucp and tip to run over X.25.

Chapter 11, contains information to help you deal with common problems.

Preface xvii



Appendix A, describes the cables you will need.

Appendix B, lists the available keywords and parameters for the configuration files.

Appendix C, lists and explains error messages.

Appendix D, provides the information you need to manage Solstice X.25 using
Domain Manager (formerly known as SunNet Manager).

Appendix E, provides the information you need to manage Solstice X.25 using SNMP
agent.

Appendix F, provides the special information you will need if you require Solstice
X.25 9.2 to co-exist on a network with SunNet X.25 7.0. (Solstice X.25 9.2 is already
fully compatible with SunLink X.25 8.x and 9.0 and Solstice X.25 9.1.)

Glossary is a list of words and phrases found in this book and their definitions.

What Typographic Changes Mean
The following table describes the typographic changes used in this book.

TABLE P–1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your.login file.

Use ls -a to list all files.

machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su

Password:

AaBbCc123 Command-line placeholder:

replace with a real name or
value

To delete a file, type rm filename

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in User’s Guide.

These are called class options.

You must be root to do this

xviii Solstice X.25 9.2 Administration Guide ♦ October 1999



CHAPTER 1

About Solstice X.25

The information in this section is specific to the Solstice X.25 9.2 product. For general
X.25 information, refer to Chapter 2.

Overview

Solstice X.25

Ethernet

Other X.25

Solstice X.25

X.25
PSDN

PAD call

PAD call
uucp

rlogin

Figure 1–1 Solstice X.25 Overview

Solstice X.25 9.2 is an implementation of the ITU-T’s (formerly CCITT) X.25
Recommendations, together with some other, related software. Using Solstice X.25 9.2,
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you can make connections to a Packet Switched Data Network (PSDN), and connect
to remote devices that are running any standard-compliant implementation of X.25.

Figure 1–1 shows some of the ways you can use Solstice X.25 to make connections
with remote devices:

� PAD calls from Sun workstations running Solstice X.25 to Sun workstations and
servers running Solstice X.25, and to remote systems running other
implementations of X.25.

� PAD calls from one X.25 device to another, from where the user can rlogin to a
non-X.25 IP host.

� uucp connections with remote X.25 devices.

� IP routed between TCP/IP networks.

Note - All of the connections shown in the diagram are made across the X.25 PSDN.

Solstice X.25 9.2 Features
This section summarizes the features provided by Solstice X.25 9.2.

New in this Release
Solstice X.25 9.2 offers the following new features:

� Updated software which now runs in either 64bit or 32bit mode.

� New LLC2 module which handles LAN plumbing and PPA assignment for
applications which run directly over LLC2.

� The ability to specify the name of a a file containing PAD commands when using
the pad command.

Feature Summary
In addition to the new features added to the current release, Solstice X.25 offers the
following features:

� A user-friendly GUI based on Motif.

� HTML-based on-line help that provides x25tool specific information.

� A PAD Printer which makes it possible to print locally while logged in to a remote
terminal.
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� A Call Filtering module filters incoming calls based on specific criteria which are
then stored in a configuration file. The criteria you can specify include X.121
address, time of day, call user data.

� The software allows for a total up to 32,763 virtual circuits distributed over any
number of links (with a maximum of 4096 virtual circuits on any one line).
Machine resources and the configuration of your X.25 network may constrain you
to a smaller number.

� Maximum data rates of:

� 2.048 Mbits per second on one HSI port
� 1.544 Mbits per second on two HSI ports
� 19.2 Kbits per second on SPARCstation CPU ports

� X.29 packet-mode host (PAD daemon) and X.3/X.28 virtual terminal (PAD)
support.

� Encapsulation of IP packets in X.25 packets, as defined in RFC 1356.

� Address Extension Facility (AEF) for running OSI over X.25.

� Standard configuration file templates for major PSDNs.

� Domain Manager agent (formerly known as SunNet Manager agent).

� Security mechanism (through full or partial address specification) for incoming
calls to PAD daemon.

� APIs: STREAMS-based Network Layer Interface and sockets module for backward
compatibility with SunNet X.25 7.0.

� The X.25 Packet Layer includes:

� Extended packet sequence numbering.
� Large flow control windows (up to 127 packets) and large packet sizes: up to

1024 bytes over 1980-compliant X.25 networks, and up to 4096 bytes over 1984
and 1988 X.25 networks.

� Basic and extended frame sequence numbering for LAPB (1984 and 1988).

� ISO 8208 for DTE-to-DTE operation.

� LLC2 for running X.25 over a LAN (802.x or FDDI)

� Reverse charging, RPOA selection, flow control parameter negotiation, CUG
selection, throughput class negotiation, and fast select on a per-call basis.

� Multiple physical links per system. You can have as many connections as serial
ports and other resources allow.

� MultiLink Procedure enables more than one physical interface to be used to
connect a DTE and a DCE. This allows load sharing and link failure recovery.

� The Data Link Provider Interface (DLPI) is a standard way of writing application
programs directly above the datalink layer.

About Solstice X.25 3



� A client-only implementation of X.32, which provides authentication and is most
useful for dial-up calls.

� V.25bis allows Solstice X.25 to be used in dial-up configurations.

� Routing (automatic link selection) among multiple links.

� Configuration files. You can also configure Solstice X.25 9.2 by editing the
configuration files delivered with the product. This allows users who do not have
access to a Graphical User Interface such as the OpenWindows or Motif
environments to carry out a full configuration of the X.25 software.

� The ability to connect to the Defense Data Network via X.25 Standard and Basic
Service.

Components of the Solstice X.25 9.2 Product
The Solstice X.25 9.2 product contains the following components:

X.25 Packet Layer Layer 3 of the ITU-T X.25 Recommendation is
known as the X.25 Packet Layer. Sometimes this
is shortened to just X.25.

LLC2 Logical Link Control Class 2. This provides the
datalink layer for 802 LANs, such as Ethernet,
Token Ring and FDDI.

LAPB Link Access Procedure Balanced. This provides
the datalink layer over WAN interfaces.

MLP MultiLink Procedure. This provides the datalink
layer allowing a DTE and a DCE to connect using
more than one WAN interface.

EXPX The driver for the SCiiExpress-X card used by the
x86 version of the product.

Loopback The driver for the loopback interface.

XTY A pseudo-device that lets applications access the
PAD software to make outgoing calls.

PAD Software The Packet Assembler/Dissassembler software.
This allows you to make PAD calls to remote
machines that are running X.25.

PAD Daemon The software that listens for incoming PAD calls
and determines how they are to be treated.
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PAD Printer Printing is routed through an X.25 server, making
it possible for a user to print to the local printer
even if the user is logged in remotely.

XXX The three ITU-T software implementation
recommendations —X.3, X.28 and X29— that
control operation of the PAD. They are often
referred to as the triple X standards.

IXE Software providing an interface between IP, the
Internet Protocol and the X.25 Packet Layer.

Domain Manager Agent The Domain Manager agent (formerly known as
SunNet Manager agent) allows access to the MIB
through the RPC protocol.

SNMP Agent The Simple Network Management Protocol
(SNMP) agent allows access to the MIB through
the SNMP.

Call Filtering Module This optional facility enables the X.25
administration software to define a list of
authorized remote stations.

The Solstice X.25 9.2 product, together with the software provided with the Solaris
2.x operating software, is enough to make full use of the facilities offered by X.25.
You can also interwork with the other Sun products shown in Figure 1–2.

Standards Support
The X.25 Recommendations were first specified in 1976, and have subsequently been
revised on a number of occastions. It is common to refer to versions of the X.25
Recommendation by the year in which they were issued—for example X.25(1984).
The 1980, 1984 and 1988 versions are the most widely used.

Solstice X.25 supports the following features from the 1984 and 1988 X.25
recommendations:

� optional user facilities:

� extended packet sequence numbering
� one-way incoming and one-way outgoing logical channels
� non-standard default packet and window sizes
� default throughput classes assignment
� flow control parameter negotiation
� throughput class negotiation

About Solstice X.25 5



� CUG-related facilities
� bilateral CUG-related facilities
� fast select and fast select acceptance
� reverse charging and reverse charging acceptance
� local charging prevention
� charging information
� RPOA selection
� incoming and outgoing calls barred
� called line address modified notification
� call redirection notification
� call deflection
� transit delay selection and indication
� TOA/NPI address format
� Network User Identifier (NUI)
� protection
� priority

� permanent virtual circuits

� two-way logical channels

� called and calling AEF

� expedited data negotiation

� minimum throughput class

� user data on Accept and Clear with Fast Select

� non-X.25 facilities (in Call Request and Call Accepted packets)

� programmable facilities field

� up to 32 bytes of interrupt data

� up to 109 bytes of facilities in Call Request and Call Accepted packets

� DTE-originated cause codes

� MLP

Solstice X.25 does not support:

� on-line facility registration

� the hunt group facility
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How Solstice X.25 9.2 Interworks With
Other Sun Products

Higher layers
(layers 4 -7)

Network Layer
(layer 3)

Datalink Layer
(layer 2)

Physical Layer
(layer 1)

PAD
PAD

Printer

IP

IXEXXX

X.25 Packet Layer

LLC2

802.3 FDDI

ZSH EXPX

line discipline

OSI

HSI loop-
back

protocolsXTY

MLP

SLP SLP SLP SLP

Part of the Solstice X.25 product software

Part of the Solaris 2.x operating system software

Also available from Sun Microsystems

Defined by the ITU-T X.25 Recommendations

SNMP
Agent

call filtering module

PAD
Daemon

Domain
Manager
Agent

LAPB

Figure 1–2 How Solstice X.25 Interworks With Other Sun Products
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Solaris System Software used with Solstice X.25
The Solstice X.25 9.2 product can be used in conjunction with the following software
that is supplied as part of the Solaris 2.x system software:

IP The Transmission Control Protocol/Internet Protocol. The
TCP/IP protocol suite is the de facto standard for
networking. IP, the Internet Protocol, can be run above
X.25, creating a Wide Area Network using TCP/IP. This
allows for the use of rlogin , ftp and other useful
facilities. The TCP/IP protocol suite is delivered as part of
the Solaris system software

Line Discipline The standard STREAMS line discipline modules.

802.3 The Ethernet interface.

ZSH The onboard serial port of a Sun workstation.

Products that Interwork with Solstice X.25
Solstice X.25 9.2 forms part of a complete networking solution. As such, it interworks
with other products—both from Sun and from other vendors. You can use the
following software, available from Sun Microsystems, with the Solstice X.25 9.2
product:

OSI You can run the OSI protocol stack, using the Solstice X.25 9.2
product as the bottom 3 layers.

FDDI You can run Solstice X.25 9.2 on an FDDI network.

HSI This is the High Speed Interface, available from Sun Microsystems.
This provides four WAN interfaces and allows for higher speeds
and better performance than the onboard serial port.
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CHAPTER 2

About X.25

This section provides an overview of X.25 concepts. None of the information in this
chapter is specific to Solstice X.25 9.2—it applies to any implementation conforming
to the X.25 Recommendations. Understanding the concepts explained here will help
you make better use of the Solstice X.25 9.2 product.

Refer to Chapter 1 for an overview of Solstice X.25 9.2.

The X.25 protocol suite enables the exchange of data between X.25 systems across
Packet Switched Data Networks (PSDN), and Local Area Networks. Systems running
one implementation of X.25, for example Solstice X.25, can exchange data with
systems running any other implementation of X.25.

X.25 Overview
It is conventional to represent an X.25 network as a cloud, as in Figure 2–1.
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X.25

Ethernet LAN

FDDI LAN

X.25

X.25

X.25
PSDN

Ethernet LAN

Figure 2–1 X.25 Overview

As Figure 2–2 shows, X.25 defines the way the interface between a system running
X.25 (often referred to as a DTE) and a system providing a network connection (often
referred to as a DCE) works. There is almost always a modem between the DTE and
the DCE to handle the physical connection. However, this is transparent to X.25. X.25
does not define the means of transmission that should be used between the two
DCEs.

DCE DCE

X.25 protocols X.25 protocols

virtual circuit

means of
transmission

DTE
DTE

Figure 2–2 X.25 Detail

Dial-Up and Leased Lines
When connecting to a public network, for example one administered by a phone
company, you must choose between using dial-up access and leased lines.

A leased line is a line allocated to you by the network’s administration. You pay for
exclusive use of this line and for it to be configured to your specification. You can
only change the characteristics of this line in consultation with your network
provider. For leased lines, the service provider typically provides a suitable modem
for connecting your DTE to the network.
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Dial-up access means that there is no particular line allocated for your use. When a
DTE needs to access the public network, it uses a modem to place a call to the
network. This means that there are no rental or set-up charges as there are with a
leased line; charging is done on a per-call basis. Most dial-up services use the X.32
protocols to provide a degree of authentication, so the network knows the call is
coming from an approved user.

Permanent and Switched Virtual
Circuits
The end-to-end (DTE to DTE) connection provided by the X.25 Recommendations is
called a virtual circuit. This is not a physical connection between the DTEs; it is a
logical communication path. Public networks offer two types of virtual
circuit—permanent and switched. Typically a subscription consists of a mixture of
the two.

A permanent virtual circuit (PVC) is a permanent association between two DTEs that
is established when a user subscribes to a public network. Many providers charge a
flat rate per month for a PVC in addition to the charge per unit of data.

A switched virtual circuit (SVC) is a temporary association between two DTEs that
exists only for the duration of a call. Most providers charge per minute for an SVC in
addition to a charge per unit of data.

In general, SVCs are less expensive than PVCs unless two end-points need to be in
constant communication, but this varies between providers depending on their tariff
structure.

SVCs and PVCs can both be used across both dial-up and leased lines. However,
using a PVC with a dial-up line is unlikely to be useful.

The X.25 Recommendations
X.25 is defined in a series of documents issued by the International
Telecommunication Union—Telecommunication Standardization Sector. These
documents are called the X.25 Recommendations and specify the following:

� X.25 Physical Layer

� X.25 Datalink Layer - LAP, LAPB and MLP

� X.25 Packet Layer Protocol
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The component layers of X.25 fit together as shown in Figure 2–3:

Network Layer
(layer 3)

Datalink Layer
(layer 2)

Physical Layer
(layer 1)

Higher Layers
(layers 4 to 7)

WAN device

X.25

LAP, LAPB, MLP

Figure 2–3 X.25 Protocol Layers Overview

X.25 Physical Layer
As with any protocol stack, the physical layer specifies the mechanical, electrical,
functional, and procedural characteristics that are necessary to activate, maintain,
and terminate a physical connection between the DTE and DCE.

The ITU-T X.25 Recommendation does not itself specify how the physical layer
should work. Instead, it refers to other ITU-T Recommendations, and specifies which
of these may be used. The Recommendations specified are: X.21, X.21 bis, X.31 and
the V-series interfaces, that is V11, V24 and V25bis.

Electronic Industries Association (EIA) specifications are often compatible with the
V-series interfaces and can be used with X.25. The chart below lists equivalent
standards.
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TABLE 2–1 ITU-T V-series and Equivalent EIA Inferfaces

ITU-T Equivalent EIA

V24, V28 RS232, RS423

V11 RS449

X.25 Datalink Layer
The datalink layer’s role is to specify the link access procedure for the exchange of
data across the physical link. This layer must ensure that all data transmitted at one
end of a link reaches the other end intact.

This means that as well as mechanisms for transmitting data, the datalink layer must
provide ways of telling whether data has reached its destination correctly, and
retransmitting if it has not.

The X.25 Recommendation defines two possible datalink layers: LAP and LAPB. In
practice, LAP is rarely used. A Multilink Procedure (MLP) allows for multilink
operations. It is used along with LAPB.

Single Link Operations
Figure 2–4 shows the standard frame structure for a bit-oriented datalink layer
frame. The shaded parts are supplied by the datalink layer. The Data field contains
the data supplied by higher layer protocols. Sizes are given in octets

1                  1                    1                0 - ?                           2                             1

        Flag            Address         Control           Data                   Checksum                    Flag

Figure 2–4 Datalink Layer Frame Structure

Datalink layer frames are structured as follows:

Flag Frames are delimited at each end by a flag, with the value
01111110. This is necessary because X.25 is synchronous -
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in other words, data is transmitted as a continuous
stream.

Address This is one octet. The value varies, depending on the
direction of data flow, and on whether this is a single or
multilink operation.

Control The control octet define the type of frame this is: an
I(nformation)-frame containing data, a
S(upervisory)-frame, which is a response frame, or an
U(nnumbered)-frame, which performs control functions.

Data The data field contains X.25 protocol information, as well
as user data from higher layer protocols. A frame need
not contain data.

Checksum The two-octet checksum follows the data, and is derived
from the contents of the data packet. It is usually
generated automatically by the hardware.

Multilink Operations

means of
transmission

DCE DCE

Figure 2–5 Multilink Operation

The Multilink Protocol (MLP) lets you use more than one physical connection to make
a single logical connection. This increases the amount of bandwidth available between
the DTE and DCE improving response times and increasing traffic levels. An MLP
connection does not provide a multiple channel end to end connection to remote
DTEs. Not all of the DTEs attached to the PSDN need to use MLP and not all DTEs
need to use the same number of physical connections.

The internal structure of X.25 when using MLP is shown below:
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Network Layer
(layer 3)

Datalink Layer
(layer 2)

Physical Layer
(layer 1)

X.25

MLP

Link Link Link

multilink
sublayer

HSIEXPXZSH

Figure 2–6 Internal Structure of X.25 When Using MLP

MLP frames have two additional octets placed between the control octet and the
data. These octets enable each frame to have a sequence number so that it can be
reassembled in the correct order at the receiving end. The two extra octets are not
present in the standard datalink frame shown in Figure 2–4.

X.25 Packet Layer
Within layer 3, the Packet Layer Protocol manages the exchange of data packets
between DTE and DCE. This layer establishes, maintains, and terminates user
sessions, handles addressing and carries out fault-management.

The general format of an X.25 packet header is shown below:
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8 bits

General Format Identifier Group

Channel

Type  Control

Additional Information/Data

Figure 2–7 X.25 Packet Header Format

The components are:

General Format Identifier This specifies the format of the rest of the header,
which varies according to packet-type.

Group and Channel Together, the Group and Channel fields identify
the virtual circuit to be used for a call.

Type In a control (non-data) packet, the type field
identifies the type of the packet. In a data packet,
the type field is used for setting flow control,
sequencing, and piggybacking information.

Control The Control field specifies whether this is a
control or a data packet. It is set to 1 for control
packets and 0 for data packets.

In data packets, the header is followed by data. In control packets, the header is
followed by additional information that specifies, among other things, addressing
and any special facilities that are to be used.

16 Solstice X.25 9.2 Administration Guide ♦ October 1999



CHAPTER 3

Planning Your Solstice X.25
Configuration

Before you install and configure Solstice X.25 9.2, you need to decide how it will be
used and how it will interact with other software present on your network.

Connecting to a Public Network
If you want to connect to a public network, for example one managed by a PTT, you
need to provide the network administering body with information about the kind of
connection and configuration you would like. Typically, when you contact the
administering body, you are sent a network subscription form. Use this to specify
what you want. Public networks vary in the services they offer and in the information
they require. You may need to answer some or all of the following questions:

� Do you want a dial-up line or a leased line? Consider the tariff structure of the
public network you are connecting to and how you want to use your network
connection.

� Do you want a single connection or an MLP connection? You can only use MLP
across a public network if you have subscribed to an MLP type line.

� What mix of Permanent and Switched Virtual Circuits do you need? A Permanent
Virtual Circuit (PVC) is a permanent association between two specified end-points.
A Switched Virtual Circuit (SVC) is a temporary association between two
endpoints, established for the duration of a call. Compare the tariff structures for
PVCs and SVCs before deciding how many of each you need. Some network
providers charge a flat rate per month for PVCs and a charge per minute for SVCs,
as well as a charge per unit of data on either type of virtual circuit. In general,
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SVCs tend to be cheaper unless two end-points need to be in permanent
communication, but this may not be true for all networks.

� What line speed would you like? This is worth investigating carefully, as line
speed can have a significant impact on network performance and on the price you
will pay for your connection. Consider factors such as the volume of data you
expect to transfer, the level of interactive traffic, the type of virtual circuits you
plan to have, the expected duration and frequency of connections, the types of
modems you have available, and so on.

� What is the maximum size of Information Frame (I-Frame) you need? This must
be larger than the maximum possible packet size on your network.

� How many times should a frame be retransmitted before an error is reported? A
large value increases the chance of data getting through correctly. A small value
allows fast detection of errors. The value you choose may also depend on whether
or not the public network charges for each failure.

� What is the maximum packet size you require? In most cases, use of the default
value of 128 is appropriate.

� What is the maximum window size you require? In most cases, use the default
value of 2. A larger window size increases throughput but will probably also
increase the cost.

� Which throughput class do you require? The throughput class determines the
amount of resources allocated to a virtual circuit. It is determined by the line
speed. The default value is 2.

� Do you need non-standard flow control? If you have chosen non-default packet
and window sizes, you may need to use non-standard flow control.

� Do you want local or remote packet acknowledgment? Local packet
acknowledgment is simpler, so use this, unless a particular application requires
remote packet acknowledgment.

Connecting to a Private Network
If you are connecting to or creating a private network, you need to consider all of the
issues described in “Connecting to a Public Network” on page 17, although cost is
not an issue in this case. If you are creating a new network, you may find it simpler
to use the default values provided by the Solstice X.25 9.2 software, at least in the
beginning. You can fine-tune the configuration later.
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Planning a Configuration to Run IP
Over X.25
This section gives you an idea of how to plan a configuration to run IP over X.25,
and to help you find the information you need to do so. Internetworking with TCP/
IP: Principles, Protocols, and Architecture, by Douglas Comer, is a useful source of
information on IP routing. The SunOS 5.0 manual Administering TCP/IP and UUCP
also has information on routing that will help you to plan for your own particular
system.

The following is a summary of what you need to do if you plan to use IP routing
over X.25:

� Obtain and allocate IP addresses.

Every IP network that you intend to connect with other IP networks must have a
unique IP network number.

� Decide whether to use dynamic or static IP routing. You need to weigh the cost of
running a dynamic routing protocol such as RIP across an X.25 connection, against
the cost of network downtime caused by out-of-date static routing tables. This
decision will be influenced by the size and complexity of your network, as well as
by the importance of maintaining connections.

If you decide to use dynamic routing, you need to initiate RIP, the Routing
Information Protocol. This is provided in the file in.routed . The contents of the
file are broadcast every 30 seconds. You can also use gated , if it is available on
your system.

A good compromise between using dynamic and static routing is to configure a
static route to a routing gateway that is not attached to the X.25 network. The
routing gateway can then handle the dynamic routing of traffic that does not need
to cross the X.25 network.

To look at the contents of the routing table, enter netstat ---r .

� Provide address resolution information, to allow IP addresses to be translated into
X.25 addresses, and vice versa. You do this using the IP Interface Configuration
window and the Remote Host to X.25 Address Map window. Both windows can
be accessed through the Services menu in x25tool . You do not need to provide
the address resolution information if you are connecting to the DDN. The DDN
uses an automatic address translation mechanism, defined in RFC 1236.
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CHAPTER 4

Configuring Solstice X.25 Using
x25tool

This chapter describes how to access and use x25tool to configure X.25.

x25tool Overview
x25tool provides a graphical interface to the parameters required to configure and
maintain the Solstice X.25 software. The parameters are contained in a set of
configuration files which also can be edited directly. See Chapter 5, for more
information.

Starting x25tool
To start x25tool with read and write permission, log in as root or become
superuser, and type:

hostname# /opt/SUNWconn/bin/x25tool

Note - Starting x25tool without root permission gives you read-only access.
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Using x25tool
When you start x25tool , the main window appears. The top of the window
provides menu options for configuring X.25. Directly underneath the menu is a list of
currently configured links.

The lower half of the window displays output messages. For example, when you
start or stop a link, information is displayed in the output window.

Figure 4–1 x25tool Main Window Overview

To select an item in x25tool , position the mouse cursor on the item and click the
left mouse button.

Note - If you move the mouse cursor into the output window and click on the right
mouse button, you will see a pop-up window for saving or clearing the output.

Some menu options are “yes/no” options; the menu contains a list of items. Click on
the box next to an item to select or unselect it. A shaded button indicates that the
option is currently selected.
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Figure 4–2 Selecting an Option

Some menu options are associated with pop-up windows:

Figure 4–3 A Menu Option Associated with a Pop-Up Window

There are various ways to enter information. You may need to type the information
in directly, select the information from a list, or click on a button to access additional
parameters in another window.

Updating the Configuration
Once you have made changes and are ready to exit the window, you have three
options: OK, Apply, or Cancel.

� OK updates the changes you have made and dismisses the window.

� Apply updates the changes, but does not dismiss the window.

� Cancel discards the changes you have made and dismisses the window.
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Dynamic Mode and Static Mode

Configuration
File

x25tool

Load From
Load Running

Save / Save as

Running
Configuration

Apply/OK
(dynamic mode, only)

Figure 4–4 Updating the Network Configuration

The x25tool runs in one of two modes: dynamic and static. Which mode you use
affects how modifications to the configuration are handled.

To set the mode, select Options from the x25tool menu and click next to the mode
in which you want to run x25tool .

If you run x25tool in dynamic mode, when you click on OK or Apply, all the
modifications are transmitted to the protocol stack that is currently running on the
machine, but are not permanently stored to the configuration files.

If you run x25tool in static mode, any modifications you make will not be applied
to the currently running configuration. If you want to transmit the modifications to
the currently running protocol stack, you must first save the configuration
modifications using File ⇒ Save, or File ⇒ Save As, then select Network ⇒ Stop X.25
or Network ⇒ Start X.25.

Note - In both dynamic and static modes, the configuration modifications are not
automatically saved. If you want to store the configuration to use the next time you
start the network, you must use File ⇒ Save, or File ⇒ Save As.
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x25tool Menu Items
File

Save
Save changes to the default configuration files. When you click on Save, a window
displays a list of settings (IP Configuration, Link #, PAD Host Database, etc.) and
you can choose which settings you want to save to the default configuration. By
default, all modified items are listed under Save.

Save as
Save changes to a named configuration. You might want to keep a backup, for
example, or create a template configuration suitable for your particular network.

As with the Save option, you can choose which information to save to the
configuration files.

Load from
This lets you load different configuration information into x25tool from a
previously saved configuration.

Load running
This lets you load configuration information related to links, routing, and NUI
mapping, from the X.25 session currently running into x25tool .

Exit
Exit x25tool .
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Edit

Add Link
When you select Add Link, a list of configuration templates is displayed. Choose the
template that most closely matches your configuration needs (e.g. TELENET,
TRANSPAC, or TYMNET) or choose the Default. The Link Editor window will
appear. You can then add a new link and configure it.

Modify Link
Lets you modify the link that is currently selected in the Links Configuration list by
bringing up the Link Editor window. (Alternatively, you can double-click on the link
to bring up the Link Editor window.) You can then modify the selected link.

Delete Link
Deletes the link that is currently selected in the Links Configuration list.

Note - The link must not be running when you delete it. See “Stop Link” on page
31, for more information.

Copy Link
Copies the link configuration information for the link that is currently selected in the
Links Configuration List. You can only copy configuration information for one link.

Paste Link
Pastes the most recently copied configuration information of a single link into the
Link Editor window.

Link Editor
When you choose Edit ⇒ Add to add a link, or Edit ⇒ Modify to modify an existing
link, (see “Add Link” on page 26 and “Modify Link” on page 26 for more
information), the Link Editor pop-up window will appear. The Link Editor window
contains the options you need to configure the link.

The Link Editor is divided into three rows which correspond to the three lowest
layers of the OSI seven-layer model. The top row contains the layer one physical
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parameters; the middle row contains the layer two frame parameters, and the bottom
row contains layer three packet parameters.

The Link Editor window is also arranged so that the left side contains the more basic
parameters used to configure a link. In most cases, these parameters are all you need,
but the buttons on the right side of the Link Editor will take you to the Advanced
Configuration windows. You can use the parameters in these windows to further
fine-tune the link configuration.

Figure 4–5 Link Editor Window
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Network

Start X.25
Starts the Solstice X.25 network.

Stop X.25
Stops all the daemons associated with the X.25 system software.

Statistics X.25
Gathers and displays statistics on traffic. When you select this option, a pop-up
window will appear. The options displayed in this window let you determine the
kind of statistical information to be generated:

28 Solstice X.25 9.2 Administration Guide ♦ October 1999



Figure 4–6 Network X.25 Statistics Window

Protocol Select the protocol(s) you want to generate
statistics for: WAN, LAPB, LLC, MLP, X.25, or
IXE.

VC(s) Select one of the following: Total for all VCs;
Per-VC, all VCs; Per-VC, single VC; or Per-VC,
range of VCs.

Note - Statistics for the VC (virtual circuit) are
reported only if X.25 is one of the protocols
selected.

VC or VC Range If you set VC(s) to Per-VC, you will need to
specify the VC number. If you select Per-VC,
range of VCs, you will need to enter the range of
VCs to be used for gathering the statistics.
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Link(s) Select one of the following: Total for all links;
Per-link, all links; Per-link, single link; Per-link,
range of links

Link Number or Link Range If you set Link(s) to Per-link, single link, you will
need to specify the link number. If you select
Per-link, range of links, you will need to enter
the range of links to be used for gathering the
statistics.

Interval This field is optional. If you enter a value, the
updated statistics will be continuously
re-displayed after the interval specified. Interval
values are in seconds.

Log Report If you select Yes, you will be prompted to give a
file name for storing the statistics. If you select
No, the statistics are displayed in the statistics
window, only.

To generate a report, click on the protocols you
want statistics for, specify the link(s) and VC(s) to
test, and the interval. Then click on Display.
Following is an example of how the statistics are
reported:

GLOBAL STATISTICS FOR X25
-------------------------------------
Packet type TX RX
-------------------------------------

Call 20 20
Call accept 20 20

Clear 0 0
Clear Confirm 0 0

Restart 5 5
Restart confirm 0 0

RNR 0 0
RR 2431 2430

Resets 0 0
Reset confirms 0 0

Diagnostic 0 0
Interrupts 0 0

Registration 0 0
Reg confirm 0 0

Packets(total) 4250 4212
Bytes(total) 483584 483640

-------------------------------------
Running totals
-------------------------------------
Tot no of VCs established 2

(continued)
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(Continuation)

Connections refused 0
Connections currently open 2
Max connections open 2

A separate block of statistics is reported for each
protocol selected.

Start Link
Starts the currently selected link without affecting the Solstice X.25 software as a
whole. All counters and timers associated with the link protocol are reset to their
initial values.

Stop Link
Stops an individual link without affecting the Solstice X.25 software as a whole. All
counters and timers associated with the link protocol are reset to their initial values.

Once the link has been stopped, the LAPB will not respond to any incoming frames
until the link is restarted using the Start Link option.

Reset Link
Resets an individual link to its initial state without affecting the Solstice X.25
software as a whole. All counters and timers associated with the link protocol are
reset to their initial values.

Link(s) status
Displays the status of the internal state of the LAPB for the configured links. When
the link is operating normally, i.e. the SABM/UA handshake has successfully
completed, the state for both LAPB and Packet is displayed as NORMAL.

When used on a MLP link, the highest status of the different SLPs is displayed.

For more information on link status, see Chapter 11.

Note - The link status option does not work with LLC2 links.
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Options

Start X.25 automatically when booted
The X.25 network will automatically start the next time you reboot the machine.

Don’t start X.25 automatically when booted
The X.25 network will not automatically start when you reboot the machine. If you
want to bring up the network later, then you must select Network ⇒ Start X.25.

Start SNMP Agent automatically
This starts the SNMP agent when you start X.25 or reboot the machine. The SNMP
agent allows access to the MIB through SNMP (the Simple Network Management
Protocol). For more information on the SNMP agent, see Appendix E.

Don’t start SNMP Agent Automatically
The SNMP agent will not be started when you start X.25 or reboot the machine.

Static mode
When x25tool is set to static mode, any changes you make will not be applied to
the currently running configuration. However, if you save the changes to the default
configuration files, they will come into effect the next time you stop and restart the
Solstice X.25 software.

Dynamic mode
When x25tool is set to dynamic mode, any change you make will affect existing
X.25 connections, and may disrupt users, so use caution. Changes to the dynamic
configuration are made in the kernel and are lost the next time you restart the
Solstice X.25 software, unless you save the changes.

Services
The following Service options are described in more detail in Chapter 6 and Chapter
7.
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IP
Configure X.25 to run IP above it. There are two IP windows: the IP Interface
Configuration window, and the Remote Host to X.25 Address Map window.

PAD
Configure the PAD Hosts Database with information to make it easier for users to
make PAD calls to a remote host.

The PAD Daemon Listen Database window lets you determine how incoming calls
will be handled.

The PAD Printer lets you install a printer over an X.25 network so that users logged
in from a remote terminal can still print to their local printer.

NUI Mapping
Configure the Network User Identifier parameters to create a mapping between the
Network User Identifiers and facilities.

Routing
If you have multiple links, use the parameters in this window to configure the
address information in a Call Request packet. This determines which link Solstice
X.25 will use for outgoing calls.

X.25 Call Filtering
Use X.25 Call Filtering to define which incoming calls will be authorized.

Boards

Definition
This pop-up window contains a list of physical serial port boards. Click on Add to
add a board, or click on a board already displayed in the list, then select Modify.

When you click on Apply or OK, the changes are stored in a file and the Device list
for the Link Editor is updated to reflect any additions or modifications.

The items contained in the definition window are:
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Symbolic Name
This is what you want to call the board.

Path Name

This is the path for the device driver, for example, /dev/zshdrv is the location for
the Aurora board driver.

Board type

Set to either WAN or LAN.

Number of lines

This is the number of lines that the board will support.

MRU (in bytes)
The size of the largest frame (Maximum Receive Unit) that can be received by the
board.

Comment
Type in any additional information you want to include, for example, “Onboard
Serial Port”.

Help
On-line help for x25tool is available in HTML format. It is specifically structured to
help you quickly find the answers to questions about x25tool . For example, if you
are not sure what sort of information to type in the Local X.121 Address field in the
Link Editor window, you can use on-line help to find out.

The first time you use on-line help, you need to specify which browser to use. To do
this, click on Help and select Properties. Then type in the path and name of the
browser and click on OK.

Alternatively, you can specify the browser in your .login file by adding the
following line:

setenv X25HTMLBROWSER =/pathname/browsername
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Then, to bring up the on-line help, just click on Help ⇒ Help. This starts the browser
and brings you to the main help menu. You can then follow the hyperlinks to the
information you need.

Configuring a Single WAN Link
This section describes how to use the Link Editor in x25tool to configure a single
dedicated WAN link for Solstice X.25. The configuration described in this chapter
uses the default values provided with the product. It should work in the majority of
situations, although it will not necessarily make the best possible use of the product’s
capacities.

No changes will be made to the Advanced Configuration settings in this example;
however, once you have a link that works, you can use the Advanced Configuration
options to fine-tune it. See Chapter 7 for more information.

This example uses the SPARCTM version of the product. The process is almost
identical for all versions of the product, but the device names change. Refer to
Chapter 8, for an example using the x86 version of the product.

The procedure for setting up a dial-up link is slightly different from that for setting
up a leased line, and involves some extra considerations. Refer to Chapter 8 for an
example.

This section describes setting up the following configuration:

X.25
PSDN

Figure 4–7 Configuring a Single WAN Link using x25tool

The onboard serial port of the workstation is connected to a modem using a
straight-through cable. When you subscribe to a PSDN, your supplier almost always
provides a modem. If not, contact the supplier to find out what kind of modem you
need.

To configure Solstice X.25, you need to:
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� configure some information about the link

� change the logical channel ranges used by the Solstice X.25 software to match
those used by your PSDN

Before you start, make certain that your PSDN supplier has provided the following
information:

� the version of the X.25 Recommendation used on the PSDN

� the X.121 address of the port you intend to use

� the logical channel ranges used by the PSDN

By default, there are two template links already configured, one WAN link and one
LAN link.

In this example, you will configure a single WAN link:

1. In the x25tool main window, pull down the Edit menu, select Add Link and
choose a template configuration.

If you don’t know what template configuration you need, choose Default. The
Link Editor window appears:
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Figure 4–8 The Link Editor Window

2. Set the Link Number.

This is a unique number that you assign to the link to identify it, both in
x25tool and in the configuration files.

3. Type a link description (this is optional).

In the Link Description field, type in a description of the link. For example,
Internal serial port.

4. Set the Link Type.

Pull down the Link Type menu and choose WAN.

5. Set the Device type and Port Number.
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The example uses the default zsh0 device. If you are using a different device
type, pull down the menu of available device types and select the relevant one,
then type in the port number.

6. Make sure the Interface is set as DTE.

You only need to set the Interface as DCE if you are running two machines
back-to-back, for example for testing.

7. Set the LAP Protocol to LAPB, unless you are sure your PSDN uses a different
LAP Mode.

LAP and LAPBE are used very rarely.

8. Set the Local Address.

Type the port address in this field. This is the X.121 address assigned to you by
your supplier. This address is often referred to as an X.25 address. Your service
supplier should tell you this address.

Note - The Full Address and Extended Address parameters are not used when
the product is in normal operation. You only need to enter these if you are using
an application that expects to read them. In this case, your service provider will
tell you what you need to enter here.

9. Select the Version.

Choose the version of the X.25 recommendation used by your PSDN.

10. Set the Logical Channel ranges:

Your PSDN will tell you which values to use here. If you are configuring a
private network, all machines on the network must use the same logical channel
ranges. In this case, you can choose any values you like as long as they comply
with the X.25 Recommendations.

11. Click on OK.

This confirms your changes and closes the Link Editor window.

12. Click on File, then click on Save.

This makes sure your changes will be used next time you start X.25.

Note - For a default configuration, you do not need to configure the datalink
layer parameters, the defaults should be adequate.
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13. Start X.25 by pulling down the Network menu and clicking on Start X.25.

14. Check that the configuration is valid.

First, check the link status by clicking on Network, Link Status. The link status
should be NORMAL.

15. Next, make a PAD call to yourself. To do this, enter the pad command at a
command line, followed by your own X.121 address:

hostname% pad X.121 address

Once you have created a link that works, you can fine-tune it, or configure the
application(s) you want to run over it.

Chapter 8 contains additional examples.
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CHAPTER 5

Configuring Solstice X.25 by Editing the
Configuration Files

This chapter describes how to configure Solstice X.25 by editing the configuration
files.

Configuration Files Overview
If you need to configure a machine that does not have a windowing system such as
OpenWindows or Motif, you can configure Solstice X.25 by directly editing the
configuration files.

Solstice X.25 9.2 automatically converts the configuration files of Solstice X.25 9.x as
part of the installation process. Older versions of X.25 are not supported.

Note - Whenever possible, configure X.25 links and applications using the x25tool .
Directly editing the files makes it more likely that errors will accidentally be added
to the configuration files.

Editing the Configuration Files
Chapter 7 specifies the keyword and valid arguments for each parameter used in the
configuration files. For additional information, consult the man pages (make certain
your path includes /opt/SUNWconn/man ).

The following configuration files are contained in the
/etc/opt/SUNWconn/x25/config directory:
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link_config_0000.cfg,link_config_0001.cfg

Contains the link configuration templates. See “Using the Link Configuration Files”
on page 43 for more information. To see the man page description, type
man x25_config.

The following configuration files are contained in the /etc/opt/SUNWconn/x25
directory:

ipconf

Contains the IP interface configuration information.

ixemapconf

Contains information about the mapping between the Internet addresses of the
network hosts and underlying X.25 addresses.

nuimapconf

Contains information of mapping between the Network User Identifiers and
associated facilities.

paddconf

Contains the set of called addresses from which the PAD daemon will accept connect
indications.

padmapconf , x29profile , xhosts

Contain the X.25 hosts information that the PAD host database needs.

xtpmapconf

Contains PAD printer parameters definitions.

pvcmapconf

Contains the PVC packet and window size information.

routes

Contains routing configuration information.
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x25secuconf , x25secupid

Together contain the authorized incoming calls information needed for call filtering.

Using the Link Configuration Files
File link_config_0000.cfg configures link 0. In the default configuration, this is
a WAN link. File link_config_0001.cfg configures link 1. In the default
configuration, this is a LAN link.

There is a separate configuration file for each link. The filename format is
link_config_ nnnn.cfg , where nnnn is a four digit link number. These are the
files that will be read when the Solstice X.25 is next started. Editing them is
equivalent to modifying the configuration using x25tool while in static mode. Use a
different naming convention if you want to save changes without using them on the
next restart.

Note - You cannot make changes to an active link by editing the configuration files.
If you need to make changes to an active link, use x25tool to modify the
configuration while in dynamic mode.

To create a new WAN link use file link_config_0000.cfg as a template. Copy it,
giving the new file the correct name for the link you want it to apply to. For
example, to configure link 3 as a WAN link, call the file link_config_0003.cfg .

To create a new LAN link, copy and rename the file link_config_0001.cfg . Then
edit the new file to use the values you want.

The configuration file consists of a series of keywords and values, divided into
sections according to function. The example below shows the IDENTIFICATION and
LINK sections of a file:

IDENTIFICATION
PRODUCT_NAME Solstice X.25
PRODUCT_VERSION 9.2
FILE_TYPE config
MODIFIED_BY agbell FILE_DATE Fri Sept 29 11:41:13 1999

SECTION LINK
device /dev/zsh0
local_address 0011
type WAN
version 1988
mode DTE
protocol LAPB

(continued)
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(Continuation)

description Link to switch

The IDENTIFICATION section is the top section of every file. Updating the
MODIFIED_BY field every time you make changes helps you keep track of who has
made changes. The FILE_DATE field is updated automatically when you save the
file, showing when the last changes were made.

Template Configuration Files
You can also use one of the sample templates instead of the default configuration
files. These files are also contained in the /etc/opt/SUNWconn/x25/config
directory. The template filename format is def_name_config.cfg .

To use a template file, select the template that most closely matches your
configuration needs (for example, def_transpac_config ) and copy it. You can
then edit the copy as you would any other link configuration file. See “Using the
Link Configuration Files” on page 43 for more information.

Configuring a Single WAN Link
This section describes how to configure a single dedicated WAN link for Solstice X.25
by editing the configuration files. The configuration described in this chapter uses
the default values provided with the product. It should work in the majority of
situations, although it will not necessarily make the best possible use of the product’s
capacities. However, once you have a link that works, you can fine-tune it. See
Chapter 7 for more information.

This example uses the SPARC version of the product. The process is almost identical
for all versions of the product, but the device names change. Refer to Chapter 8 for
an example using the x86 version of the product.

The procedure for setting up a dial-up link is slightly different from that for setting
up a leased line, and involves some extra considerations. Refer to Chapter 8 for an
example.

This section describes setting up the following configuration:
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X.25
PSDN

Figure 5–1 Configuring a Single WAN Link

The onboard serial port of the workstation is connected to a modem by a
straight-through cable. When you subscribe to a PSDN, your supplier almost always
provides a modem. If not, contact the supplier to find out what kind of modem you
need.

To configure Solstice X.25, you need to:

� configure some information about the link

� change the logical channel ranges used by the Solstice X.25 software to match
those used by your PSDN

Before you start, make sure your PSDN supplier has provided the following
information:

� the version of the X.25 Recommendation used on the PSDN

� the X.121 address of the port you intend to use

� the logical channel ranges used by the PSDN

Editing the Link Configuration Files
To configure a single link to a PSDN across using the onboard serial port:

1. Open the file /etc/SUNWconn/x25/config/link_config_0000.cfg for
editing.

This is the file that configures link 0.

2. Scroll down to SECTION LINK.

This is the first section below the identification section, and looks like this:

SECTION LINK
device /dev/zsh0

(continued)
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(Continuation)

local_address 0011
type WAN
version 1988
mode DTE
protocol LAPB
alias switch
description Link to switch

3. Change the local_address parameter to your local X.121 address.

This is the X.121 address of your modem. Your service supplier should tell you
what it is.

4. If necessary, change the version parameter to the year of the X.25
Recommendations used by your PSDN.

5. Optionally, set an alias and description .

6. Scroll down to SECTION X25and find the Logical Channel Range parameters.

These are called pvc_range , inc_range , out_range , and two_range and are
near the top of SECTION X25:

SECTION X25
network X25_88
plpmode Normal
pvc_range 0-0
inc_range 0-0
out_range 0-0
two_range 1-30

7. Set the appropriate Logical Channel Ranges by editing the existing entries.

Don’t leave any spaces between the values and the hyphen. Your service supplier
will tell you the appropriate values to use.

8. Save and exit the file.

9. Start X.25 by entering the following as root:

# /etc/init.d/x25.control start
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This brings up the software.

To check that the configuration is valid, make a pad call to yourself. To do this,
enter the pad command at a command line, followed by your own X.121 address:

hostname% pad X.121 address

Once you have created a link that works, you can fine-tune it, or configure the
application(s) you want to run over it. See Chapter 8 for more information.
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CHAPTER 6

Configuring Solstice X.25 Services

This chapter explains how to set up some of the basic configurations listed under
Services in the x25tool menu. For additional configurations, see Chapter 8.

Configuring Solstice X.25 to Route IP
The TCP/IP protocol suite is the de facto standard for networking. IP can be run
above X.25, creating a Wide Area Network using TCP/IP. This allows for the use of
rlogin, ftp and other useful facilities. The TCP/IP protocol suite is delivered as part
of the Solaris system software.

To route IP over Solstice X.25, you must set up a mapping between the X.121
addresses used by the X.25 software and the IP addresses used by the IP software.
The IP over X.25 Configuration window contains many parameters, but you only
need to use a few of them. You can configure information about your local system,
mapping its X.121 address to an IP address and setting any necessary parameters,
and also information about remote systems.

To access the IP Interface Configuration window, pull down the Services menu and
choose IP ⇒ IP Interface:
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Figure 6–1 Setting the Local IP Address and IP Subnet Mask

First, configure information about your local system. To do so:

1. Click on the Add button.

2. Enter the Local IP address of the interface you are configuring.

Enter either an address in IP dotted notation, or a hostname.

3. Select either Point-to-Point, or Point-to-Multipoint.

4. Enter the Remote IP Address for a Point to Point configuration, or enter the IP
Subnet Mask for a Point to Multipoint configuration.

5. Click on the Apply button.

6. Select the Local Address, and click on the Modify button.

You must do this before you can access the X.25 Parameters window.

7. Select X.25 Parameters and configure any other relevant parameters.

See “IP Interface Configuration” on page 93 for information about the available
parameters.

8. Click on OK to apply the changes and to exit the X.25 Parameters window.

9. Click on Start to start the IP interface.

10. Click on OK to apply the changes and to exit the IP Interface window.
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You also need to add information about remote hosts to the IP Mapping window.
This lets the Solstice X.25 software translate the IP addresses it receives into X.25
addresses it can use. To access the IP Mapping window, pull down the Services
menu and choose IP ⇒ IP Mapping:

Figure 6–2 Adding Information About Remote Hosts in the IP Mapping Window

1. Click on the Add button.

2. Enter the IP Address of the remote system.

3. Specify the link to be used by traffic to this destination (or use 255 for
automatic routing).

4. Set the circuit to SVC (switched virtual circuit) or PVC (permanent virtual
circuit).

5. Enter the X.25 (X.121) address of the remote system.

6. Click on the Apply button.

7. Select the Remote IP Address, and click on the Modify button.

You must apply the changes before you can access the X.25 Parameters window.
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8. Click on the X.25 Parameters button and configure any other relevant
parameters.

See “IP Interface Configuration” on page 93 for information about the available
parameters.

9. Click on OK to apply the changes and to exit the X.25 Parameters window.

10. Click on OK to apply the changes and to exit the IP Mapping Window.

Once you have carried out the configuration described above, you should be able
to use the TCP/IP protocol suite over your X.25 connection. To check that all is
working properly, make sure that you can ping and rlogin to the hosts you
added to the IP Host to X.25 Address Map.

Configuring the PAD
Once you have a working connection to a network, you can use it to make PAD calls
using the PAD software delivered with the Solstice X.25 software.

Users can make PAD calls without you carrying out any configuration. However in
order to do so, they need to know addressing and configuration information for their
destination. You can use x25tool to create a database of remote hosts containing
relevant addressing and configuration information. This lets users make calls using
aliases instead of addresses.

You can also set up a database of parameters to be applied to incoming calls. This is
particularly useful if you have a server that receives a large number of calls.

Configuring the PAD Hosts Database
To access the PAD Hosts Database, pull down the Services menu and choose PAD ⇒
PAD Hosts Database:

The PAD Hosts Database window looks like this:
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Figure 6–3 PAD Hosts Database Window

To add an entry:

1. Click on Add.

2. Specify the X.121 Remote Address.

For a WAN link, this is the DTE address of the remote host. A valid DTE address
has 15 or fewer decimal digits.

For a LAN link, this is the LSAP of the remote host. A valid LSAP (MAC plus
SAP) address is 14 hexadecimal digits in length. In most cases, the last two digits
of an LSAP address are 7e. You can use ARP-style notation, with colons
separating the bytes within an LSAP address. Within a colon-delimited byte, you
can omit a leading zero.

3. Type the name of the alias you want to use, if appropriate.

4. Add any Aliases you want to use to call this destination.
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5. Set the Link Selection parameter to Automatic.

This uses the Solstice X.25 routing link selection feature. In some instances, you
may want to specify the link number, instead (a link number of 255 indicates
automatic link selection). This allows you to bypass routing specs, or to make
certain that the specified link is always used.

6. Change any other relevant parameters.

In most cases you do not need to do this. Refer to “PAD Hosts Database” on page
98 in Chapter 7 for information on the other available parameters.

7. Click on OK to add the new entry to the database.

Configuring the PAD Daemon Listen Database
The PAD Daemon Listen Database determines how incoming PAD calls are handled.
You can set global default values that are used for all incoming calls and optional
values that apply to calls with particular characteristics. To access the PAD Hosts
Database, pull down the Services menu and choose PAD ⇒ PAD Daemon.

The PAD Daemon Listen Database window looks like this:
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Figure 6–4 PAD Daemon Listen Database

1. Configure the PAD Daemon Listen Database to log or not to log PAD calls.

When the Log PAD Calls option is set to Yes, information about each PAD call
made is logged to the file /var/opt/SUNWconn/x25/x29serverlog . This file
can become very large. If you have problems with disk space, check the
x29serverlog file size and, if necessary, delete it.

2. Configure the PAD Daemon Listen Database to accept or not to accept
incoming PAD calls.

If the Accept Incoming PAD Calls option is set to No, the system will not accept
incoming PAD calls. The system can still make outgoing calls.

3. Configure a Welcome Banner.

This is the message that someone logging in to this machine using a PAD call will
see when the connection is made. It might be useful to give the machine name or
any particular information about this machine that users need.
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There are two Welcome Banner fields in the database window. The first is under
the Global defaults. The second is displayed under the Listener Criteria. You can
specify a Welcome Banner for a particular listener, or you can leave this field
blank, in which case the default banner will be used.

If you don’t want a Welcome Banner, enter a single space in the field for the
global Welcome Banner.

4. Enter the Initial Command.

This determines what happens when a user connects to this machine using a PAD
call. The command /bin/login, which appears by default in this field, prompts
for the user’s name and password.

There are two Initial Command fields in the database window. The first is under
the Global defaults. The second is displayed under the Listener Criteria. You can
specify an Initial Command for a particular listener, or you can leave this field
blank, in which case the default will be used.

If you don’t want an Initial Command, enter a single space in the field for the
global Initial Command.

5. Change the Listener Criteria, if necessary.

You can also set the parameters described above so that they are applied
differently to certain calls. There are two ways to distinguish which calls they can
apply to—using the Called Address and using the Calling Address.

The Called Address is the address of the local machine. If you use sub-addressing,
a remote host can call the local machine using any one of these sub-addresses.
You can configure the local machine to behave differently depending on the
sub-address called—for example, on a machine with several applications, you
could use a different sub-address to call each one, using a combination of the
Called Address and Initial Command parameters to set this up.

The Calling Address is the address of the machine making the call, the remote
machine. Again, you might want to use a different Initial Command, depending
on where the call is from. You might also need to use different X.3 parameters if
the remote host has a non-default configuration. To set the X.3 parameters, select
Customize under PAD Call Parameters. For more information on X.3 parameters,
see Chapter 7.

To set parameters applying to a particular Called Address, choose Matches and
enter the exact address. To apply the parameters to a particular group of Called
Addresses, use Starts With to affect all addresses starting in the same way, or
Pattern to use wildcards such as an asterisk (*) or a question mark (?).

To set parameters applying to a particular Calling Address, choose Matches and
enter the exact address. To apply the parameters to a particular group of Calling
Addresses, use Starts With to affect all addresses starting in the same way, or
Pattern to use wildcards.
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To set parameters applying to calls using specific Call User Data, choose Starts
With to affect all calls with CUD starting the same way and Matches to affect all
calls using identical CUD. For more information on Call User Data, see Chapter 7.

Configuring PAD Printer
The PAD Printer enables a user who is logged on to a remote terminal to print to the
remote user’s local printer.

Figure 6–5 shows how the print information is routed through the network to the
server running X.25. The print information is then routed back to the local printer
through PAD.

Server

PSDN
X.25running

X.25

PAD

Remote
Terminal

Printer

Figure 6–5 Using PAD to Print to a Remote User’s Local Printer

1. Use admintool to set up the printer.

Do this as you normally would, but make certain that you set it up as a Local
Printer, and specify an X.25 printer port that also includes a unique printer
number, for example /dev/xtp7 . See User Account, Printers and Mail
Administration for more information.

2. In x25tool, access the PAD Printer window.

Pull down the Services menu and choose PAD ⇒ PAD Printer.
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Figure 6–6 The PAD Printer Window

3. Click on Add.

4. Type in the printer name.

5. Type in the device number.

This is the printer port number. For example, if you entered /dev/xtp7 for the
printer port in admintool, then the device number is 7.

6. Type in the link number.

This is the link to use for the outgoing printer connection. If you set this to 255,
the link number will be selected automatically.

7. Type in the remote X.121 address.

This enables X.25 to open a connection. The print information can then be routed
from the remote terminal, through PAD, to the local printer.

8. Set Clear Flag to Yes or No.

If set to Yes a Clear Invitation packet is sent at the end of the data transfer, and
the connection will then be cleared by the remote PAD after all of the data is
received. This ensures that all data have reached the remote PAD, but can lead to
the connection staying up if the remote does not support Clear Invitation packet.
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If Clear Flag is set to No, then a Clear Invitation packet will not be sent at the
end of the data transfer. If the remote PAD does not support Clear Invitation, you
should set Clear Flag to No and enter a value for the Timeout.

9. Set the timeout (optional).

This is the amount of time, in seconds, that the X.25 server will keep the
connection open after the last print packet has been sent. Setting a timeout value
can help prevent loss of print data, however, you will have to use your own
knowledge of the network to determine how long the connection needs to stay
open.

You only need to set a timeout if Clear Flag is set to No.

10. Enter the Call User Data.

This is the call user data used to establish the virtual connection. Before this
information is included, it should have been agreed upon by both sides of the
connection.

11. Click on OK to apply the changes and to exit the PAD Printer window.

NUI Mapping
The Network User Identifier (NUI) parameters are used to create a mapping between
Network User Identifiers and facilities. When a call is made using NUI override, the
facilities set here override any other facilities that might otherwise apply to the call.

Configuring the NUI Parameters
To access the NUI Mapping window, pull down the Services menu and choose
Routing. The NUI Mapping window looks like this:
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Figure 6–7 Network User Identifier Parameters Window

1. Click on Add.

You can now configure the NUI mapping information.

2. Enter the NUI.

The NUI, the Network User Identifier, is a string of up to 64 alphanumeric
characters. The NUI is supplied by your PSDN provider.

3. Enter the Throughput Class information.

This numeric value determines what throughput class is used for incoming
(Remote) and outgoing (Local) calls. These can be different.

4. Select the Packet Size.

These are the sizes to use for incoming (Remote) and outgoing (Local) packets.
These can be different.

5. Select the Packet Format.

Choose between Normal and Extended.

6. Enter the Window Size.

This is the window size to use for incoming (Remote) and outgoing (Local) calls.
These can be different.
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7. Select the CUG.

This determines whether Closed User Groups are in use. Choose between None,
Normal and Outgoing.

8. Select the CUG Type.

Choose Basic or Extended.

Routing
If you have multiple links, you can control which link X.25 uses by configuring the
address information contained in the Routing Parameters window.

Configuring the Routing Parameters
To access the Routing Parameters window, pull down the Services menu and choose
Routing. The Routing Parameters window looks like this:

Figure 6–8 Routing Parameters Window
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1. Click on Add and select Top from the list displayed.

When you click on Add, you will be prompted to select the position you want the
configuration to take in the list. This can be important, since X.25 starts from the
top of the list and uses the first set of parameters that match the parameters
specified by the application.

2. Select the Route Type.

The default is X.121 Host. This associates the complete X.121 address of a remote
host with a link. For a complete description of each of the available route types,
see “Routing” on page 111 in Chapter 7.

3. Type in the number of the link you want to associate with the route type.

4. Type in the X.121 host address or prefix.

Type in the complete X.121 address if the routing type is set to X.121 host, AEF
host, prefix, or default. If the routing type is X.121 prefix, enter the leading digits
(for example, the DNIC) of the X.121 address.

5. For an AEF routing type, enter the address extension.

For an AEF host routing type, enter the complete extended address, such as an
OSI NSAP address. For an AEF prefix routing type, enter the leading digits (at
least one) of an extended address.

6. Type in the Protocol ID.

Enter the protocol id as a string of consecutive digits no longer than 5 bytes (10
decimal digits). The protocol id is an optional addition to an AEF host, AEF
prefix, or AEF default entry.

7. Enter the MAC address to which the call will be routed if the link is a LAN
link.

You can include a MAC address with any of the route types.

8. For dial-up configurations, enter the telephone number of the point of
attachment to the PSDN.

In most cases, the point of attachment is the modem.

9. Add a comment (optional).
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Call Filtering
Call Filtering defines which incoming calls will be accepted. The default is that all
calls are authorized, so if you want to restrict incoming calls, you need to configure
the definitions in the Call Filtering window in x25tool , or edit the
/etc/SUNWconn/x25/x25secuconf and /etc/SUNWconn/x25/x25secupid
configuration files.

Configuring the Call Filtering Parameters
To access the Call Filtering window, pull down the Services menu and choose Call
Filtering. The Call Filtering window looks like this:

Figure 6–9 Call Filtering Window

1. Click on Add.

If you need to modify an existing set of parameters, you need to select it from the
list of call filtering parameters. To do this, click on the call filtering parameters
you want to modify, then click on the Modify button.

2. Select the Service from which to accept calls.
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The available services are PAD,TCP-IP, CLNP, OSI, None, or Other. If you select
Other, a pop-up window will prompt you to enter the service name, and call user
data.

3. Set the time period when calls will be accepted.

You can set this up so that the time period specified is repeated daily or weekly.
If you select “one time”, the time period will not be repeated.

4. Set the link number from which you will accept calls.

You can restrict which networks you will accept calls from by specifying the link
number. If the link number is set to 255, X.25 will accept calls over any link.

5. Specify the calling address of the machine from which calls will be accepted.

If you set the Calling Address to Don’t Care, X.25 will accept calls from any
address. If you set the Calling Address to Starts with, or Ends with, you must
also enter the appropriate numbers. For example, if you want to accept calls that
have an X.25 address beginning with 1234, you select Starts with, and enter 1234
in the adjoining field.

6. Click on OK to add the information to the list of Call Filtering parameters and
to dismiss the window.
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CHAPTER 7

Parameter Reference

This chapter contains reference information for all available Solstice X.25 parameters.
All of the parameters described here can be set by using x25tool , or by editing the
configuration files.

Note - Whenever possible, configure X.25 links and applications using the x25tool .
Directly editing the files makes it more likely that errors will accidentally be added
to the configuration files.

The parameters are grouped together functionally, according to the x25tool
window that they are located in. The name of the corresponding configuration file or
files is also included.

The name used to identify the parameter in x25tool is given as a header, with the
keyword used by the configuration file included in brackets. In some cases no key
word is used, but the configuration file itself will contain information on editing the
parameters.

Note - For a list of parameter values, refer to Appendix B.

Link Parameters
The parameters described in this section are located in the Link Editor window in
x25tool .

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
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four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

These parameters are used to configure a physical link.

Link Number
A number that identifies the link (which is a connection over a specific network
interface). This can be either a PSDN or LAN. Each link must have a unique number.
This number is used to identify which link is being configured in various parts of
x25tool .

Link Description (description )
This is an optional field. Enter an alphanumeric string of 80 or fewer characters.
Spaces are allowed.

Link Type (type )
Table 7–1 lists the available values:

TABLE 7–1 Link Type values

Value Meaning

WAN (1988) A connection to a WAN conforming to the 1988 version of the X.25
Recommendations.

WAN (1984) A connection to a WAN conforming to the 1984 version of the X.25
Recommendations.

WAN (1980) A connection to a WAN conforming to the 1980 version of the X.25
Recommendations.

LAN A connection to a LAN.

MLP n - links A multi-link protocol connection using n physical links.

Device (device )
The name of the link level device. Table 7–2 lists the available types:
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TABLE 7–2 Device Types

Value Meaning

ZSH One of the onboard serial ports.

HSI High Speed Interface. A serial port on the Solstice HSI/S SBus card.

EXPX A serial port on the SCiiExpress-X card.

WLOOP The loopback driver.

LE An Ethernet interface on a SPARCstation.

IE An Ethernet interface on a SPARCstation.

BE A fast Ethernet interface.

QE The SBus Quad Ethernet card.

SMC A PC Ethernet interface.

EL A PC Ethernet interface.

ELX An Ethernet interface on the 3Com Etherlink III card. The default
Ethernet interface type for a PC.

SMCE A PC Ethernet interface.

SMCEU A PC Ethernet interface.

IEE A PC Ethernet interface.

HEE A PC Ethernet interface.

IEEF A PC Ethernet interface.

EEPRO A PC Ethernet interface.

NEI A PC Ethernet interface.

RI A PC Ethernet interface.

XP A PC Ethernet interface.

PCN A PC Ethernet interface.
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TABLE 7–2 Device Types (continued)

Value Meaning

FDDI An FDDI interface.

TR A Token Ring interface.

For the x86 version of the product, the device type depends on the type of Ethernet
card used by your PC. The default ELX-0 applies to the 3Com Etherlink III card. If
IP is running, you can find out what device type your PC uses by entering the
following command: Included in the information returned by this command is the
name of the device that IP is running over. Use this same device type for X.25.

hostname% ifconfig -a

Note - The list of device types available for the x86 version of the product is
constantly being updated. Therefore, your PC may use a device that is not shown in
Table 7–2. If this is the case, you can add the new device to the device types list in
the Boards Definition window. See “Definition” on page 33 for more information.

Port Number (device )
The port number of the LAN or WAN device used beneath X.25. The Device Type
plus the Port Number must form a unique identifier for each link.

Tx Clock (line_speed )
Set this to either External, or specify the appropriate bit rate (in x25tool , you select
the bit rate from the drop down menu). If you choose External, both the transmit
clock and receive clock are set to external This means that the clocking speed is
provided by a synchronous modem or modem eliminator.

If you specify a bit rate, this means that the local machine supplies the clocking, so
make certain that the bit rate you select matches the transmission rate of the local
machine.

Frame Window Sizes (locmaxwinsize , remmaxwinsize ,
locdefwinsize , remdefwindsize )
Window sizes can be in the range 1 to 7 for modulo 8 networks, or 1 to 127 for
modulo 128 networks. The default must be less than or equal to the maximum.
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Interface (mode)

This applies to WAN connections only. Choose between DTE and DCE. If you are
connecting to a PSDN via a modem, the machine running the Solstice X.25 software
is the DTE and the modem acts as the DCE. If you are connecting two machines
back-to-back, make one the DTE and the other the DCE.

LAP Protocol (protocol )

This applies to WAN connections only. Choose between LAP, LAPB and LAPBE.
Almost all PSDNs use LAPB.

Local X.121 Address (local_address )

For WAN interfaces this is your DTE or DCE address, normally an X.121 address,
consisting of a DNIC, NTN, and, optionally, a subaddress. Your service provider
should notify you of what this address is. A small number of public networks
require that the calling address in an outgoing packet not contain the full X.121
address (for example, Transpac only requires the sub-address). In such a case, enter
the “short” version of your X.121 address (as specified by your service provider) in
this field. Your service provider will inform you if you need to do this.

For LAN interfaces, this is a six-byte (12 hexadecimal) digit address. The default of
twelve zeroes tells Solstice X.25 to use your machine’s default MAC address. To use
the MAC address stored on an interface controller card (such as the address on the
FDDI/S SBus card) enter the address as twelve consecutive hexadecimal digits or as
pairs of hexadecimal digits, with colons between each pair and leading zeroes within
pairs omitted.

Version (network )

The version of the X.25 Recommendation that your PSDN conforms to—1980, 1984,
or 1988.

Packet Size (locmaxpktsize , locdefpktsize , remmaxpktsize ,
remdefpktsize )

Sets the packet size for all priority call requests and incoming calls. Possible values
are: Default, 16, 32, 64, 128, 256, 512, 1024, 2048 and 4096.

Note - In the configuration file, packet sizes are expressed as powers of 2. For
example, to specify 128, enter 7.
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Logical Channel Ranges (pvc_range , inc_range , out_range ,
two_range )

Consult your service provider to find out the correct logical channel ranges to use.
For each type of virtual circuit you use, you must set the channel ranges so that they
match the range of numbers specified by your PSDN. For back-to-back or LAN
connections, you must match the logical channel numbers used by the remote hosts
with which you intend to communicate. Mismatches between logical channel number
ranges are frequently the cause of inability to establish connections. A common
symptom of an LCR mismatch is that connections operate in one direction only.

LAPB and WAN Parameters
You can access the LAPB and WAN Parameters window from the Link Editor.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

Use the LAPB and WAN Parameters screen to configure the datalink and physical
layer parameters used by a LAPB link.

LAPB Parameters
The LAPB layer parameters are:

Ack Timer (T1) (t1_timer )

The period, in tenths of a second, during which the LAPB software expects to receive
an acknowledgment to an outstanding I-frame or during which LAPB expects a
response to a sent unnumbered frame. The valid range for values of this parameter is
between 1 and 3000.

P-bit Timer (pf_timer )

The period, in tenths of a second, during which the LAPB software expects to receive
a frame with the F-bit set to 1 in response to a command with the P-bit set to 1. This
value should be less than that specified for the Ack Timer. The valid range for values
of this parameter is between 1 and 3000.
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Reject Timer (reject_timer )
The period, in tenths of a second, during which the LAPB software expects to receive
a reply to a sent Reject frame. The valid range for values of this parameter is
between 1 and 10000.

Busy-state Timer (busy_timer )
The period, in tenths of a second, during which the LAPB software waits for an
indication of the clearance of a busy condition at the other end of the link. The valid
range for values of this parameter is between 1 and 30000.

Link Idle Timer (idle_timer )
The period, in tenths of a second, during which the LAPB software expects to receive
a frame from the other end of the link. If this timer expires, the Poll/Final
cycle—which might result in link disconnection—is initiated. A zero value disables
this function. The valid range for values of this parameter is between 0 and 32000.

Max. RR Delay (rr_ack_delay )
The maximum delay, in tenths of a second, before transmitting a delayed Receiver
Ready. The value for this parameter must be significantly lower than the Ack Timer
value. The valid range for values of this parameter is 0 to 3000.

Max Tries (N2) (n2_count )
The maximum number of times that an I-frame (information frame) is sent following
the expiration of the Ack Timer, the P-bit Timer, or the Reject Timer. It also limits the
number of times Receive Ready with P-bit set is sent when the remote side is busy
and the Busy Timer expires. The valid range for values of this parameter is 1 to 255.

Max UnACKed IPDUs (unack_max )
The maximum number of unacknowledged I-frames that can be received before the
Receive Ready acknowledging those I-frames must be sent. The valid range for
values of this parameter is 0 to 127 for modulo 128, and 0 to 7 for modulo 8.

Transmit Probe (local_probe )
The position within a window at which the LAPB software sends an I-frame with the
P-bit set, to ask for an acknowledgment from the receiver. The valid range for values
of this parameter is 0 to 127.
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MLP Priority (mlp_priority )

Note - This parameter appears in the LAPB and WAN Parameters window when the
Link Type is set to MLP in the Link Editor Window. In this instance, to access the
LAPB and WAN Parameters window, you must call up the MLP Parameters window,
then double click on the SLP you want to configure. For more information, see “MLP
Parameters” on page 76.

This parameter defines how many unacknowledged frames can be sent on one line
before the next line is used. Setting this correctly forces traffic to be distributed
between the lines in an MLP link. The values you set depend on the absolute speed
of each line, and on the relative speeds of your lines. In general, don’t set an MLP
Priority of less than 3. If your lines operate at 64kbps, or more, you should increase
the MLP Priority.

The following combinations of values provide efficient (90%) line use in two-line
MLP configurations:

� For two 64Kbps lines, set the MLP Priority for each line to 10. In the MLP
Parameters window, set the MLP Window and MLP Guard to 25. See “MLP
Parameters” on page 76 for more information.

� For one 512Kbps line and one 128Kbps line, set the MLP Priorities to 30 and 5,
respectively. In the MLP Parameters window, set the MLP Window to 40. See
“MLP Parameters” on page 76 for more information.

Link Conformance

Ignore UA if in ERROR state I (ign_ua_error )
When the connection is in an Error state, ignore any Unnumbered acknowledgment
frames received.

FR on receipt of FR if in ERROR (frmr_frmr_error )
When the connection is in an Error state, retransmit a Frame Reject if one is received.

FR on Inv. Resp. if in ERROR (frmr_invrsp_error )
When the connection is in an Error state, transmit a Frame Reject if an invalid Frame
Response is received.
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Send FR if S-Frame & no P-bit (sframe_pbit )
If an S-frame is received without the P-bit set, send a Frame Reject.

No DM on entry to ADM state (no_dm_adm)
Do not transmit a DM on entry to the ADM state.

Abandon X.32 registration on SABM(sabm_in_x32 )
Abandon X.32 registration if a SABM is received.

ISO8882 Conformance (iso8882 )
Run the link so that it is conforms exactly to the specifications in the ISO 8882
standard.

Initial state of link is “Off” (initial_down )
When the Solstice X.25 software comes up, the link is off. To switch it on
subsequently, use the linkstart command.

Enable X.32 Authentication
(x25_x32_enable_authen )
When this is set to Yes, an X.32 identity and signature can be configured for a
subnetwork. X.32 authentication procedures are used with dial-up configurations to
prevent people from dialing in without permission This is a client-only
implementation of X.32.

Signature (x25_x32_sign )
An X.32 signature of up to 32 hexadecimal characters. Do not use whitespace.

Identity (x25_x32_identity )
An X.32 identity of up to 32 hexadecimal characters. Do not use whitespace.
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WAN Parameters (V25bis)
The physical layer parameters for a single LAPB link are:

Calling Procedures (connect_proc )
The type of calling procedure to use: None or V25bis.

V.25bis Call Request Timer (v25_callreq )
Set this if you are using the V.25 Calling Procedures. This timeout is only needed if
the network does not support call fail indications. The valid range for values for this
parameter, in tenths of a second, is between 60 and 300.

LLC2 Parameters
You can access the LLC2 Parameters window from the Link Editor.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

The parameters described in this section configure the datalink and physical layers of
a LAN link.

Ack Timer (T1) (t1_timer )
The period, in tenths of a second, during which the LLC2 software expects to receive
an acknowledgment to an outstanding I-frame. The valid range for values of this
parameter is between 1 and 3000.

Max Tries (N2) (n2_count )
Maximum number of times the LLC2 software sends a PDU following the expiration
of the Ack Timer, the P-bit Timer, or the Reject Timer. The value of this parameter
also limits the number of times Receive Ready with P-bit set is sent when the remote
side is busy and the Busy Timer expires. The valid range for values of this parameter
is between 1 and 255.
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P-bit Timer (pf_timer )
The period, in tenths of a second, during which the LLC2 software expects to receive
a frame with the F-bit set to 1 in response to a command with the P-bit set to 1. This
value should be less than that specified for the Ack Timer. The valid range for values
of this parameter is 1 to 3000.

Max UnACKed IPDUs (unack_max )
The maximum number of unacknowledged I-frames that can be received before the
Receive Ready acknowledging those I-frames must be sent. The valid range for
values of this parameter is 0 to 127.

Reject Timer (reject_timer )
The period, in tenths of a second, during which the LLC2 software expects to receive
a reply to a sent Reject frame. The valid range for values of this parameter is 1 to
10000.

Transmit Probe (local_probe )
The position within a window at which the LLC2 software sends an I-frame with the
P-bit set, to ask for an acknowledgment from the receiver. The valid range for values
of this parameter is 0 to 127.

Busy-state Timer (busy_timer )
The period, in tenths of a second, during which the LLC2 software waits for an
indication of the clearance of a busy condition at the other end of the link. The valid
range for values of this parameter is 1 to 3000.

Link Idle Timer (idle_timer )
The period, in tenths of a second, during which the LLC2 software expects to receive
a frame from the other end of the link. If this timer expires, the Poll/Final cycle is
initiated. A zero value disables this function. The valid range for values of this
parameter is 0 to 32000.

Max RR Delay (rr_ack_delay )
The maximum delay, in tenths of a second, before transmitting a delayed Reset
Request. The value for this parameter must be significantly lower than the Ack Timer
value. The valid range for values of this parameter is between 0 and 3000.
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XID Parameters

XID Window Size (xid_window )
This determines the receive window size. That is, the maximum number of
unacknowledged I-frames that the remote end of the link can send. The valid range
for values of this parameter is 1 to 127.

Duplicate MAC XID Count (xid_ndup )
This indicates the number of times the LLC2 software tries to find stations with
duplicate MAC addresses. A value of 0 means no attempt is made. The valid range
for values of this parameter is 0 to 255.

Duplicate MAC XID Timer (xid_tdup )
The period, in tenths of a second, during which incoming XID response frames are
checked for a duplicate response to the station LSAP. A value of 0 tells the LLC2
software not to perform the duplicate address check. The valid range for values of
this parameter is 0 to 3000.

MLP Parameters
You can access the MLP Parameters window from the Link Editor. The MLP
Parameters window is divided into two sections. The first section contains
parameters that apply to the multiple link in general. The second section contains a
list of the physical ports that are associated with each link.

Note - You can access the MLP Parameters window only when the Link Type is set
to MLP in the Link Editor window.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

The parameters described in this section configure the additional datalink parameters
for an MLP link.
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MLP Window (mlp_window )
The maximum number of outstanding unacknowledged frames allowable. This
should be larger than the total of the MLP Priority values. The valid range for this
parameter is 0 to 4095.

Note - All of the machines connected to the same network must use the same MLP
Window size. If you are connecting to a PSDN, check with your service provider to
find out the appropriate MLP Window size to use. This may restrict the MLP Priority
values that you can set, as the total of the MLP Priority values must not be greater
than the MLP Window size.

N1 Count (mn1_val )
The maximum number of times that MLP attempts to send a frame to an SLP
without receiving an acknowledgment. The valid range for this parameter is 1 to 255.

Lost Frame Timer [MT1] (mt1_val )
The time, in tenths of a second, during which MLP expects to receive an
acknowledgment to an outstanding frame. The valid range for this parameter is 1 to
3000.

Group Busy Timer [MT2] (mt2_val )
The time, in tenths of a second, during which MLP waits for system resources, for
example buffer space, to become available before declaring a frame as blocked and
dropping it. The valid range for this parameter is 1 to 3000.

Reset Confirm Timer [MT3] (mt3_val )
The length of the timer, in tenths of a second, that determines how long the DTE
waits for confirmation from the DCE that it has reset. The valid range for this
parameter is 1 to 3000.

Physical Ports Associated with this Link
In x25tool , the physical ports associated with the link are displayed in the bottom
half of the MLP Parameters window. Double clicking on a port here brings up the
LAPB and WAN Parameters window described in “LAPB and WAN Parameters” on
page 70. You need to configure the parameters for each SLP that is associated with
the link.
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Addressing
To access the Addressing parameters window from x25tool , click on the Addressing
button in the Link Editor window. The parameter values are stored in the link
configuration files /etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg ,
where nnnn is the four-digit number that indicates the link number (for example, the
file link_config_0004.cfg contains the parameters for link number 4).

Extended Address (full_address )
Choose None (the default), OSI, or non-OSI. This is the type of extended address you
use in the network to which the link you are configuring is attached. Not available
for WAN (1980) link types.

Extension (for non-OSI) or OSI NSAP (for OSI extended addresses)
Enter a hexadecimal address of 40 digits or fewer. Not available for WAN (1980) link
types.

LAN Addresses
The following parameters apply to LAN addresses, only.

Local SAP
This applies to LAN connections, only. It is a one-byte (two-hexadecimal-digit)
address. The default of 7e is the standard SAP for LLC2 under X.25.

Loopback SAP
This applies to LAN connections only. It is a one-byte (two-hexadecimal-digit)
address. The default of 70 is the standard loopback SAP for LLC2.

Max Conns (max_lan_conns )
It is the maximum number of simultaneous connections to be made over this link.
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Closed User Groups and Facilities
You can access the Closed User Groups and Facilities window from the Link Editor.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

Closed User Groups (sub_cug , sub_pref_cug , sub_cugoa ,
sun_cugia , bar_cug_in )
Choose any of the settings, listed below, that correspond to the CUG options to
which you subscribe.

� CUG, no other access

� Preferential CUG

� CUG, with outgoing access

� CUG, with incoming access

� Reject incoming CUG calls

CUG Format (cug_format )
Choose either Basic or Extended.

Facilities (accept_revchg , prev_chg , bar_incall ,
bar_outcall , sub_toa_npi_fmt , bar_toa_npi_fmt ,
sub_nui_override , bar_call_x32_reg )
Choose any of the settings, listed below, that correspond to PSDN facilities to which
you subscribe.

� Incoming Reverse Charging

� Local Charging Prevention

� Bar Incoming calls

� Bar Outgoing calls

� Allow TOA/NPI Addressing

� Bar TOA/NPI Addressing

� Allow NUI Override
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� Bar Outgoing during X.32 registration

Size Negotiation (use_negotiation )
Choose Request size negotiation or Disallow size negotiation or neither.

If you select Request size negotiation, outgoing calls automatically contain packet
and window size negotiation. Incoming calls are negotiated if they contain packet
and window size negotiation.

If you select Disallow size negotiation, incoming calls containing packet and window
and size negotiation are rejected.

If you select neither option, outgoing calls will not contain any packet or size
negotiation information. However, incoming calls with packet and size negotiation
information will still be accepted.

Fast Select (fast_select )
The options for Fast Select are With no restriction on response and With restriction on
response. You can select one or both options. With no restrictions allows incoming fast
select calls with no restriction on response. With restrictions allows incoming fast
select calls with restriction on response. When these options are selected together, all
incoming fast select calls are allowed.

Link Modes
You can access the Link Modes parameters window from the Link Editor window.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

These parameters deal with options and requirements of the PSDN to which you are
connecting.

Allow omission of diagnostic packets (acc_nodiag )
Allow the omission of the diagnostic byte in incoming Restart, Clear and Reset
Indications.
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Use diagnostic packets (use_diag )
Force the use of the diagnostic byte in incoming Restart, Clear and Reset Indications.

Restrict Clear Lengths (ccitt_clear_len )
Restrict the length of a Clear Indication to 5 bytes and Clear Confirm to 3 bytes. This
parameter only applies to 1980 networks.

Disallow diagnostic packets (bar_diag )
Disallow the use of the diagnostic byte in incoming Restart, Clear, and Reset
Indications.

Discard diagnostics on non-Zero LCN (disc_nz_diag )
Some PSDNs use channels other than zero to transmit diagnostic information. This
parameter lets you discard this information, should you need to.

Allow hex digits in DTE addresses (acc_hex_add )
Use this parameter if you want to be able to use addresses that do not conform with
the X.121 specification.

Bar nonprivileged listeners (bar_nonpriv_listen )
Only the superuser can start a process, like the PAD daemon, that “listens”.

Strict ISO8882 Conformance (iso_8882_mode )
This parameter is for test purposes only.

Keep X.121 address in Call Request to LAN(send_x121_to_lan )
Includes X.121 address in X.25 packet.

Insert X.121 address in Call Indications from LAN
(insert_x121_from_lan )
Inserts the X.121 address into Call Indications.
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Process Priority According the DATAPAC (1976) rules
(datapac_priority )
Apply the rules used by the 1976 Datapac recommendations to calls.

Prioritize International Calls (intl_prioritised )
Some networks let you give priority to international calls. If you set this parameter,
you need to set Priority Encoding. See Table 7–3 for information.

Priority Encoding (prty_encode_control )
The value of this parameter determines Solstice X.25’s action with respect to
prioritizing international calls.

Table 7–3 lists the available choices:

TABLE 7–3 Priority Encoding

Priority Encoding Parameter
Parameter
Value Meaning

No special action 0 Solstice X.25 performs no special encoding.

DATAPAC Priority Bit 1 The software encodes the priority request using
the DATAPAC Priority Bit (1976 version).

DATAPAC Traffic Class 2 Priority request encoded using the DATAPAC
Traffic Class (1980 version using the Calling
Network facility marker).

Outgoing International calls (intl_addr_recogn )
The value of this parameter determines how outgoing international calls are handled.

Table 7–4 lists the available choices:
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TABLE 7–4 Outgoing International Call Parameters

Outgoing
International Call
Parameter

Parameter
Value Meaning

Not distinguished: 0 No special action taken for international calls.

Check National
DNIC:

1 Solstice X.25 compares the DNIC in the called address to
the local DNIC. The software assumes that a mismatch
indicates an international call.

Prefix digit of 1 2 The software assumes a called address with a prefix of 1
indicates an international call.

Prefix digit of 0 3 The software assumes a called address with a prefix of 0
indicates an international call.

National DNIC (dnic )
Enter your national DNIC number. You must enter this code if you choose Check
National DNIC in the Outgoing International calls menu.

Forced Packet Size (prty_pkt_forced_value )
This sets the packet size for all priority call requests and incoming calls. The possible
values are: Default, 16, 32, 64, 128, 256, 512, 1024, 2048, and 4096.

In the configuration file, the packet sizes are expressed as powers of 2. For example,
to specify 128, enter 7.

Source Address Control (src_addr_control )
Determines the value inserted in the calling address field of outgoing call requests
over a WAN link. It does not apply to LAN links.

The choices as shown in Table 7–5 are:
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TABLE 7–5 Source Address Control Parameters

Source Address
Control
Parameter

Parameter
Value Meaning

No special
action

0 Solstice X.25 puts the calling address in the outgoing
call request exactly as it receives it from an application
making the call.

Omit calling
address

1 Solstice X.25 sets the calling address to null in the
outgoing call request, regardless of what was specified
by the calling application.

Default to local
address

2 Solstice X.25 uses the local address as the calling
address if no calling address is supplied by the
application.

Force use of
local address

3 Solstice X.25 uses the local address as the calling
address, even if a calling address is supplied by the
application.

The term local address refers to the value of the Local Address parameter in the
Interface Configuration window.

PVC Options
If you plan to use one or more permanent virtual circuits (PVCs) you can specify
different local and remote packet and window sizes for each PVC.

The PVC options are only available for LAPB links. You only need to use them if you
plan to use one or more permanent virtual circuits (PVCs) to connect to your X.25
network and you require different packet and window sizes for the PVCs than those
used for switched virtual circuits on the same link.

You can access the PVC Options window from the Link Editor.

The PVC parameter values are stored in the configuration file
/etc/opt/SUNWconn/x25/pvcmapconf .
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Using x25tool to Set PVC Options
In x25tool , to access the PVC window you must first enter values for PVC
minimum and maximum in the Logical Channel Range section of the Link Editor,
and then click on Apply.

The PVC Options window displays a list of PVC numbers for the currently selected
link. To add a PVC, click on Add, then edit the options. Once you have configured
the options to meet your requirements, click on Apply. The parameters for the PVC
will be added to the displayed list.

To modify an existing PVC, click on the appropriate PVC number in the displayed
list of PVC parameters. Edit the options as required and click on Apply.

PVC Number
The number of the PVC you want to configure.

Local Packet
The local packet size. Choose from 16, 32, 64, 128, 256, 512, 1024, 2048, and 4096. In
the configuration file, the packet sizes are expressed as powers of 2. For example, to
specify 128, enter 7.

Remote Packet
The remote packet size. Choose from 16, 32, 64, 128, 256, 512, 1024, 2048, and 4096. In
the configuration file, the packet sizes are expressed as powers of 2. For example, to
specify 128, enter 7.

Local Window
The local window size. Enter a number in the range 1 to 7 for modulo 8 networks, or
1 to 127 for modulo 128 networks.

Remote Window
The remote window size. Enter a number in the range 1 to 7 for modulo 8 networks,
or 1 to 127 for modulo 128 networks.
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Throughput Class and Packet Sizes
You can access the Throughput Class and Packet Sizes window from the Link Editor.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

The Throughput Class and Packet Sizes window allows you to set values for
throughput class parameters and to set Layer 3 (network layer) window and packet
sizes.

Throughput Class (thclass_type )
The standard range for throughput class, as specified in ISO 8208, is 3 through 12,
corresponding to a range of 75 to 48000 bps. However, Solstice X.25 supports 0
through 15, allowing for non-standard X.25 network implementations. If you connect
to a non-standard network, use the throughput class options in the Special
Parameters window (see “Special Parameters” on page 90) to specify values for that
network. If you need to use non-standard values, your service provider should tell
you what they are.

Negotiate Toward Defaults (thclass_neg_to_def )
Allows for configuration for non-standard X.25 networks, such as TELENET (a US
network). The default (No) is the appropriate choice for the vast majority of network
connections. When set to No, negotiation is towards mutually acceptable minima,
rather than the default values.

Packet Size - Maximum NSDU Length (maxnsdulength )
This determines the maximum size (in bytes) to which packets with the M (more
data) bit set can be concatenated. This parameter has a range of values from 1 to
32000. The default maximum size is 256.

Network Profile (modulo )
Set to modulo 8 or modulo 128 according to whether your network uses packet
sequence numbers ranging from 1 to 7 or 1 to 127.
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Window Size (locmaxwinsize , remmaxwinsize ,
locdefwinsize , remdefwindsize )
You need to specify the Default and Maximum packet sizes for the local and remote
networks. Window sizes can be in the range 1 to 7 for modulo 8 networks or 1 to 127
for modulo 128 networks. The default must be less than or equal to the maximum.

Timers and Counters
You can access the Timers and Counters window from the Link Editor.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

These parameters set CCITT-defined timers. The values are:

X.25 Timers

Restart Response [T20] (t20value )
This timer starts when the DTE issues a Restart Request. It terminates when the DTE
receives a Restart Confirmation or a Restart Indication. If neither is received in the
time allowed, the DTE retransmits the Restart Request. The valid range for values of
this parameter, in tenths of a second, is 0 to 32000. The recommended value is 1800.

Call Req Response [T21] (t21value )
This timer starts when the DTE issues a Call Request. It terminates when the DTE
receives a Call Connected, Clear Indication or Incoming Call. If none of these are
received in the time allowed, the DTE issues a Call Request. The valid range for
values of this parameter, in tenths of a second, is 0 to 32000. The recommended value
is 2000.

Reset Response [T22] (t22value )
This timer starts when the DTE issues a Reset Request. It terminates when the DTE
receives a Reset Confirmation or a Reset Indication. If neither is received in the time
allowed, the DTE retransmits the Reset Request or sends a Clear Request. The valid
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range for values of this parameter, in tenths of a second, is 0 to 32000. The
recommended value is 1800.

Clear Req Response [T23] (t23value )

This timer starts when the DTE issues a Clear Request. It terminates when the DTE
receives a Clear Confirmation or Clear Indication. If neither is received in the time
allowed, the DTE retransmits the Clear Request. The valid range for values of this
parameter, in tenths of a second, is 0 to 32000. The recommended value is 1800.

DTE Window Status [T24] (t24value )

This timer does not exactly match the DTE Window Status Transmission Timer, T24.
Instead, it specifies the maximum time for which data received from the remote side
can remain unacknowledged due to a flow control condition. After expiration of this
timer, any outstanding acknowledgments are carried by an X.25 Receive Not Ready
packet. This timer makes sure that the remote side not receiving an acknowledgment
does not cause resets within the virtual circuit. This timer should be about half the
value of Window Rotation (see next section). The valid range for values of this
parameter, in tenths of a second, is 0 to 32000. The default value is 600.

Window Rotation [T25] (t25value )

This timer starts when the DTE transmits a data packet, or the DTE’s window is
rotated, but there are still outstanding data packets. It terminates when there are no
outstanding data packets in the window. If this does not happen within the allowed
time, the DTE initiates an error procedure by transmitting a Reset Request with
diagnostic 0x92 . The valid range for values of this parameter, in tenths of a second,
is 0 to 32000. The default value is 2000.

Interrupt Response [T26] (t26value )

This timer start when the DTE sends an Interrupt packet. It terminates when the
DTE receives an Interrupt Confirmation. It this is not received in the time allowed,
the DTE transmits a Reset Request. The valid range for values of this parameter, in
tenths of a second, is 0 to 32000. The default value is 1800.

Registration Request [T28] (t28value )

The ISO Registration Request timer. The valid range for values of this parameter, in
tenths of a second, is 0 to 32000.
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Pending Ack Delay (ackdelay )
Specifies the maximum time during which a pending acknowledgment is withheld.
Solstice X.25 tries to suppress the generation of Layer 3 Receiver Ready control
packets. Acknowledgment carried by data or multiple acknowledgments is preferred
to each data packet being explicitly and separately acknowledged. The valid range
for values of this parameter, in tenths of a second, is 1 to 32000.

DTE/DCE Resolution (connectvalue )
The period in which the DTE/DCE resolution should be completed. This prevents
two packet-level entities failing to resolve their DTE/DCE roles. When this timer
expires, the link connection is disconnected and all pending connections aborted. The
valid range for values of this parameter, in tenths of a second, is 0 to 32000.

Idle Disconnect (LAN or Dialup) (idlevalue )
The period, in tenths of a second, over which Solstice X.25 maintains an idle
link-level connection. For a WAN dial-up, the idle disconnect period should not be
set to zero. For LANs, the default is 600.

X.25 Retransmission Counters

DTE Restart Request[R20] (r20value )
The number of Restart Requests that will be sent before the link is assumed to be
down. The allowable range is 1 to 255. The default is 1. Make sure you set a value
that is high enough to cope with lost traffic and network delays, but low enough to
resolve problems with little disruption to users.

DTE Clear Request[R22] (r22value )
The number of Clear Requests that will be sent before the link is assumed to be
down. The allowable range is 1 to 255. The default is 1. Make sure you set a value
that is high enough to cope with lost traffic and network delays, but low enough to
resolve problems with little disruption to users.

DTE Reset Request[R23] (r23value )
The number of Reset Requests that will be sent before the link is assumed to be
down. The allowable range is 1 to 255. The default is 1. Make sure you set a value
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that is high enough to cope with lost traffic and network delays, but low enough to
resolve problems with little disruption to users.

DTE Registration Request[R28] (r28value )

The number of Registration Requests that can be sent without acknowledgment. The
allowable range 1 to 255. The default is 1.

X.25 Transit Delays

Internal Delay (local_delay )

The maximum period in milliseconds by which transmission can be delayed due to
internal processing. The allowable range is 0 to 32000 milliseconds. The default is 5.

Line Delay (access_delay )

The maximum period in milliseconds by which transmission can delayed due to the
effects of line transmission rate. The allowable range is 0 to 32000 milliseconds. The
default is 5.

Special Parameters
You can access the Special Parameters window from the Link Editor.

The parameter values are stored in the link configuration files
/etc/opt/SUNWconn/x25/config/link_config_ nnnn.cfg , where nnnn is the
four-digit number that indicates the link number (for example, the file
link_config_0004.cfg contains the parameters for link number 4).

Use these parameters to set values for D-bit options and throughput class. The
throughput class parameters are only for those X.25 networks that do not use
standard X.25 packet and window size negotiation.

D-bit Control
The following parameters are available:
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Call Accept In (dbit_accept_in )
Determines Solstice X.25’s response when it receives a Call Accept packet with the
D-bit set and end-to-end acknowledgment was not requested. The options are:

� Leave D-bit set

� Clear call

� Zero D-bit

Call Accept Out (dbit_accept_out )
Determines Solstice X.25’s response when it sends a Call Accept packet with the
D-bit set and receives a packet from the remote side with the D-bit turned off. The
options are:

� Leave D-bit set

� Clear call

� Zero D-bit

Data In (dbit_data_in )
Determines Solstice X.25’s response when it receives a Data packet with the D-bit set.
The options are:

� Leave D-bit set

� Reset call

� Zero D-bit

Data Out (dbit_data_out )
Determines Solstice X.25’s response when an application tries to send a data packet
with the D-bit set. The options are:

� Leave D-bit set

� Reset call

� Zero D-bit

Throughput Class Packet/Window Mapping

Throughput Class Type (thclass_type )
The values are:

Parameter Reference 91



� Normal Negotiation

� Use Low Nibble of Map

� Use High Nibble of Map

� Use Both Nibbles of Map

Throughput maps entry number
If you are connecting to a non-standard X.25 network and the map entry of 0 is not
appropriate for your X.25 network, choose a value between 1 and 15.

Packet Map (thclass_pmap )
The range for valid packet sizes is 16 to 4096.

Note - In the configuration file, packet sizes are expressed as powers of 2. For
example, to specify 128, enter 7.

Window Map (thclass_wmap )
A number in the range from 1 to 127.

Identity (x25_x32_identity )
An X.32 identity of up to 32 hexadecimal characters. Do not use whitespace.

IP over X.25
Solstice X.25 can route IP if you set up a mapping between IP and X.25 (X.121)
addresses. In x25tool , the parameters for IP over X.25 configuration are divided
into two windows: the IP Interface Configuration window and the Remote IP Host to
X.25 Address Map. To access one of these windows, from the Services menu, click on
IP and select either IP Interface or IP Mapping.

The parameter values are stored in the configuration files
/etc/opt/SUNWconn/x25/ipconf and
/etc/opt/SUNWconn/x25/ixemapconf .
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IP Interface Configuration

Local IP address
Enter an IP address in either name or numeric form.

Point to
Choose between point-to-multipoint, or point-to-point.

IP Subnet Mask/Remote IP Address
For point to multipoint networks, this is “IP Subnet Mask”; for point-to-point
networks, the item is “Remote IP Address”.

For IP Subnet Mask: The mask number used in the specified IP network, expressed in
IP dot notation. For example: 255.255.255.0, indicates a Class C subnetwork mask.
Enter + to use the local default.

For Remote IP Address: The IP address, in name or numeric form, for the host at the
remote end of the point-to-point connection.

MTU
This sets the maximum transmission unit size for the network service access point
that the IP protocol will use to transmit data over X.25.

Note - The MTU value you set here must be smaller than the NSDU value specified
under Packet Size in the Throughput window.

X.25 Parameters
The following X.25 parameters are related to the IP interface. In most cases you will
not need to modify the default values.
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Listen Information

Called Address
Specifies the pattern of digits Solstice X.25 uses to match the called address on
incoming calls for IP. The options are:

� Starts with: Solstice X.25 accepts calls from callers that have called addresses that
have leading digits that match the string of hexadecimal digits you enter here.

� Matches: Solstice X.25 accepts calls from callers that have called addresses that
exactly match the string of hexadecimal digits you enter here.

� Don’t care: Solstice X.25 accepts calls from any caller, regardless of its called
address.

If you choose Starts with or Matches, enter a string of digits to be matched.

Address Mapping
Choose between CCITT, DDN Basic and DDN Standard. These options are
alternative ways of mapping between IP and X.25 addresses.

Call User Data
Specifies the pattern of digits Solstice X.25 uses to match the Call User Data on
incoming calls for IP. X.25 software uses the first 2 digits of the call user data (CUD)
field to distinguish between PAD and IP calls. The CUD field of a PAD call always
begins with 01 . The CUD field of an IP call always begins CC. If you want to add
any further CUD to be used in outgoing PAD calls, make sure you append it to the
01 . Do not delete the 01—if you do, the X.25 software receiving the call will not
know which application to pass it to and the call will fail.

The options are:

� Starts with: Solstice X.25 accepts calls from callers that have CUD fields that have
leading digits that match the string of hexadeciaml digits you enter here. The
default of “Starts with” CC is the standard Call User Data value for IP over X.25
as specified in RFC 877.

� Matches: Solstice X.25 accepts calls from callers that have CUD fields that exactly
match the string of hexadeciaml digits you enter here.

� Don’t care: Solstice X.25 accepts calls from any caller, regardless of its CUD field.

If you choose Starts with or Matches, enter a string of hexadecimal digits to be
matched.
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Timers

Pre-emption Timer
This is the time in seconds that a connection must have been open before it can be
closed (pre-empted). If all X.25 virtual circuits available to IP are in use and an IP
packet arrives for transmission to a new destination, Solstice X.25 closes one of the
existing connections—the one that has been idle the longest. The pre-emption timer
determines the minimum time a connection must be open before it can be
pre-empted in this way.

When setting this timer, take into account the amount of traffic on your link and the
speed your link runs at. The default is suitable for links running at 9600 bps.

Hold Down Timer
The minimum amount of time, in seconds, to wait before re-trying a call to a host
after an unsuccessful call.

Disconnection Timer
This is the time, in tenths of a second, that a connection to a given network can
remain idle before being closed. This timer is configurable for each X.25 network to
which you connect. When the disconnection timer expires, if there is no data on a
connection, the virtual circuit to the X.25 network is closed. If data arrives from IP
after this, the circuit is reopened.

When setting this timer, take into account the amount of traffic on your link and the
speed your link runs at. The default is suitable for links running at 9600 bps.

Actions

Reset Action
The options are:

� Acknowledge and discard: Acknowledge Reset Request packet and discard it.

� Disconnect: Causes a Clear Request packet to be sent to remote host.

Expedited Data Action
For expedited data, the menu options are defined as follows:
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� Acknowledge and discard: Acknowledge expedited data and discard it.

� Disconnect: Disconnect connection in response to expedited data.

� Reset connection: Reset connection in response to expedited data.

Accept Unknown Hosts
To restrict access, adding a measure of security, you can choose not to accept calls
from unknown hosts, that is hosts who addresses are not in the Remote Host to X.25
Address Map.

Remote IP Host to X.25 Address Map

Link Number
Enter a link number specifying the link over which you reach the IP network
specified in the IP Subnet Mask/Remote IP Address.

Remote IP Address
The IP address of the remote IP host, in either hostname or numeric form.

Circuit is
Set to either SVC (switched virtual circuit) or PVC (permanent virtual circuit). If this
parameter is set to SVC, you will need to include the remote X.25 address. If this
parameter is set to PVC, you will need to set the PVC number.

Remote X.25 Address
The X.25 (X.121) address of the specified remote host. If you are attached to the
DDN, the X.25 address is generated using the IP address. You do not need to enter it
here, although if you do other information you enter can be taken into account. If
you do want to enter the X.25 address, you need to calculate it in the same way as
the DDN software.

Extended Address
If you are using extended addressing, choose either OSI or non-OSI. Otherwise,
choose None.
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Extension
If you are using extended addressing, enter the OSI NSAP address or non-OSI
address extension. An OSI NSAP address is 40 or fewer hexadecimal digits.

X.25 Parameters for IP Mapping

Packet Size
The size of the X.25 packet that will carry IP datagrams. In accordance with RFC 877,
when IP datagrams are longer than the X.25 packet size, Solstice X.25 uses the M-bit
to transmit the datagrams as complete packet sequences. Fragmentation of IP
datagrams occurs only if the size of an IP packet exceeds the maximum transmission
unit (MTU) size for a given subnetwork.

Window Size
This parameter applies to calls in both directions and should not be larger than the
window size value you specified for X.25.

Reverse Charge
Determines whether the software will request reverse charging when proposing calls
to the remote host.

RPOA Numbers
A four-digit number that provides networks between you and the remote host with
additional routing information. You can have up to four RPOA numbers. If you have
multiple RPOA numbers, enter them together in the same sequence of digits, with no
spaces between.

Closed User Group

CUG Type
Possible values are none, multi-user and bilateral CUG.
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CUG Number
If your host is a member of a multi-user or bilateral CUG, enter the CUG number.

PAD Hosts Database
In x25tool , the parameters for the PAD Hosts Database can be accessed through the
Services menu.

The parameter values are stored in the configuration files:
/etc/opt/SUNWconn/x25/padmapconf ,
/etc/opt/SUNWconn/x25/x29profile,
and /etc/opt/SUNWconn/x25/xhosts .

The PAD Hosts Database contains information about remote hosts that makes it
easier for users to make PAD calls to them.

Default values for these parameters can be configured on a per-call basis. See Solstice
X.25 9.2 PAD User’s Guide. The parameters are:

Remote X.121 Address
The DTE or LSAP address of the remote host. A DTE address is of 15 or fewer
decimal digits. An LSAP is 14 hexadecimal digits in length. In most cases, the last
two digits of an LSAP (the SAP) are 7e . The x25tool program accepts ARP-style
notation, with colons separating the bytes within an LSAP address. Within a
colon-delimited byte, you can omit a leading zero.

Extended Address
Choose None (the default), OSI, or non-OSI. This is the type of extended address you
use in the network to which the link you are configuring is attached. Extended
Addressing is not available if your call is traversing a 1980-type WAN.

Extension (for non-OSI) or OSI NSAP (for OSI extended addresses)
Enter a hexadecimal address of 40 digits or fewer. This feature is not available if
your call is traversing a 1980-type WAN.
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Alias(es)

A PAD user can substitute any aliases entered here for the host name of a remote
host when making a PAD call.

Link Selection

Choose Automatic or Specified. Automatic uses the Solstice X.25 routing (link
selection) feature. If you choose Specified you must specify the link number yourself.

Link Number

The link over which PAD makes calls to the specified remote host. This parameter
only applies if you have multiple links.

PAD Profile

Profile names refer to specific sets of PAD (X.3) parameter settings. If the Simple
profile (the default) is not appropriate for the specified remote host, choose one of
the other named profiles. Your network provider should tell you which profile you
need to use.

If none of the seven profiles provided with the product suits your needs, you can
modify some or all of the 22 parameters defined in the 1988 CCITT X.3
recommendation. See “X.3 Parameters” on page 104 for more information.

Call User Data

A string of up to 124 ASCII characters that the PAD software will include in Call
Request packets.

Packet Size (local and remote)

This is a number determined by the requirements of your remote host and PSDN. If
your packet sizes are different from the default of 512, press MENU in the Local (or
Remote) Packet Size button and select the packet size appropriate for your remote
host.

Window Size (local and remote)

This is determined by the requirements of your PSDN and your remote host.
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CUG Type
If your host is a member of a Closed User Group, choose the appropriate CUG type.

CUG Number
If your host is a member of a multi-user or bilateral CUG, type the CUG number here.

X.29 Type
Specifies the year of the X.29 recommendation supported by the remote host. Default
means that you use the X.25 type specified for a given link.

Fast Select
Determines whether Fast Select is in effect for the calls to the specified host. If you
enter more than 12 characters of Call User Data, the PAD software automatically uses
Fast Select, regardless of the setting here. For more information on Call User Data,
see “Call User Data” on page 94.

8-bit Mode
In 7-bit mode (the default), characters are seven bits long and parity is filtered. In
8-bit mode, characters are eight bits long with no parity.

Reverse Charge
Determines whether the PAD software can make reverse charge calls.

RPOA Numbers
A four-digit number that provides networks between you and the remote host with
additional routing information. You can have up to four RPOA numbers. If you have
multiple RPOA numbers, enter them together in the same sequence of digits, with no
spaces between.
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PAD Daemon Listen Database
In x25tool , the parameters for the PAD Data Listen Database can be accessed
through the Services menu.

The parameter values are stored in the configuration file:
/etc/opt/SUNWconn/x25/paddconf .

The PAD daemon handles incoming PAD calls. Some parameters are available on a
per-host basis as well as globally. The per-host parameters override any global
settings.

Global Defaults

Log PAD calls

When set to Yes, information about each PAD call made is logged to the file
/var/opt/SUNWconn/x25/x29serverlog . This file can become very large. If you
have problems with disk space, check the size of x29serverlog and, if necessary,
delete it.

Accept Incoming PAD calls

Setting this to No prevents this system from accepting incoming PAD calls. The
system can still make outgoing calls.

Initial Command

The command that the PAD daemon invokes automatically when a connection is
established with an incoming PAD caller. By default, the initial command is
/bin/login .

Welcome Banner

A string that the PAD daemon displays to incoming PAD callers. Enter 80 or fewer
alphanumeric (including whitespace) characters. If you do not set a string, the
default is Solstice X.29 Terminal Services . The new Welcome Banner comes
into effect the next time you restart the PAD Daemon.
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PAD Parameters

Native
In native mode the default parameter settings are: echoing disabled, data forwarding
timeout enabled, no line folding, and local editing disabled. If you set this to
Customize in PAD Daemon Listen Database, the X.3 Parameters window is activated.
See “X.3 Parameters” on page 104 for more information.

Non-native
In non-native mode the default parameter settings are: echoing on, data forwarding
disabled, no line folding, and editing disabled. If you set this to Customize in PAD
Daemon Listen Database, the X.3 Parameters window is activated. See “X.3
Parameters” on page 104 for more information.

Listener Criteria

Called Address
Specifies the pattern of digits the PAD daemon uses to match the called address on
incoming PAD calls. The options as shown in Table 7–6 are:

TABLE 7–6 Called and Calling Address Parameters

Parameter Meaning

Starts with The PAD daemon accepts calls from PAD callers that have called addresses
that have leading digits that match the string of digits you enter here.

Matches The PAD daemon accepts calls from PAD callers that have called addresses
that exactly match the string of digits you enter here.
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TABLE 7–6 Called and Calling Address Parameters (continued)

Parameter Meaning

Don’t care This is the default parameter. The PAD daemon accepts calls from any PAD
caller, regardless of its called address. You do not enter a string of digits with
this parameter.

Pattern Allows the use of standard wildcard characters in order to match on part of an
address. Select this option to use the style of addressing used by SunNet X.25
7.0.

If the Called Address is not set to Don’t Care, you also need to use the Address is
parameter to specify the type of called address.

Address is:

Specify the type of the called address. If the called address is not a DTE address (the
default), click on NSAP.

Calling Address

Specifies the pattern of digits the PAD daemon uses to match the calling address on
incoming PAD calls. The options are explained under Called Address, above. You
also need to use the Address is: parameter to specify the type of the calling address.
If the Called Address is not set to Don’t Care, you also need to set the Address is:
parameter to DTE or NSAP extension.

Call User Data

Specifies the pattern of digits the PAD daemon uses to match the Call User Data on
incoming PAD calls. By convention this is 01. Do not delete the 01 that appears in
this field unless you are sure that your network uses a different value to distinguish
incoming PAD calls. If this field is blank, or if the value entered is invalid, your
machine will not be able to receive PAD calls.

Initial Command

The command that the PAD daemon invokes automatically when a connection is
established with an incoming PAD caller. By default, the initial command is
/bin/login .
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Welcome Banner

A string that the PAD daemon displays to incoming PAD callers. Enter 80 or fewer
alphanumeric (including whitespace) characters. If you do not set a string, the
default is Solstice X.29 Terminal Services . The new Welcome Banner comes
into effect the next time you restart the PAD Daemon.

X.3 Parameters
The X.3 Parameters window is accessed when you select User-Defined from the PAD
Profile window in the PAD Hosts Database, or when you select Customize under
PAD Parameters in the PAD Daemon Listen Database.

If none of the seven profiles provided with the product suit your needs, you can
modify some or all of the 22 parameters defined in the 1988 CCITT X.3
recommendation. Your network provider should tell you which values you need to
set. The parameter numbering is in accordance with the X.3 Parameter standard.

1: Recall Character

Setting this parameter lets you configure a character to use to switch from the data
transfer state to recall the PAD. Table 7–7 lists the possible values.

TABLE 7–7 Recall character values

Decimal Value Character Used

0 none

1 DLE (Ctrl-P)

32 - 126 user defined character

Note - Decimal values 2 to 31 (inclusive) have no effect.

2: Echo

If this is set to On, the PAD echoes characters back to the terminal, in addition to
processing them.
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3: Dataforwarding

The Dataforwarding characters tell the PAD that it has received a complete packet
sequence, which it should assemble and forward. Possible values are:

� A-Z, a-z, 0-9

� CR

� ESC, BEL, ENQ, ACK

� DEL, CAN, DC2

� ETX, EOT

� HT, LF, VT, FF

� Control characters not listed above

If your PSDN has supplied you with a numerical value, you need to find out which
character sequence it defines.

4: Forwarding Delay

Determines the interval PAD waits for after receiving at character. If no character is
received by the end of this interval, the PAD assumes it has received a whole packet,
and forwards it.

5: Flow Control by PAD

Determines the type of flow control used by the PAD on incoming data from the
terminal. Make sure that this is the same type as is used by the terminal.

6: Service Signals

Set the decimal value according to the way you want PAD service signals to be
handled. Table 7–8 lists the values and possible actions.

TABLE 7–8 PAD service signals

Decimal Value Action

0 no service signals transmitted to start-stop mode DTE

1 service signals, other than the Prompt PAD service signal, are
transmitted in standard format
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TABLE 7–8 PAD service signals (continued)

Decimal Value Action

4 prompt PAD service signal transmitted in standard format

8 - 15 PAD service signals transmitted in a network-dependent format

7: Action on BREAK
Determines the action taken when the PAD receives a break signal. Choose from the
list of available options. If your PSDN has supplied you with a numerical value, you
need to find out which break action it represents.

8: Data Delivery
Choose the value you want.

9: Padding after <CR>
This lets you set the PAD to insert padding characters in the character stream after
the occurrence of a carriage return. This lets the terminal process the carriage return
correctly.

10: Line Folding
Determines how often the PAD inserts a Line Feed followed by a Carriage Return. In
effect, this sets the line length for your terminal.

11: Binary Speed
This displays the speed of the line connecting the PAD and the terminal. You cannot
change this parameter.

12: Flow Control by Terminal
Defines the type of flow control used by the terminal on incoming data from the PAD.
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13: <LF> Insertion
Determines when the PAD will insert a Line Feed character. This is only relevant
when the PAD is in data transfer state. If your PSDN has supplied you with a
numerical value, you need to find out which action it represents.

14: Padding after <LF>
This lets you set the PAD to insert padding characters in the character stream after the
occurrence of a line feed. This lets the terminal process the carriage returns correctly.

15: Editing
This provides for local editing during the data transfer state as well as during the
command state.

16:Character Delete
This determines the ASCII character used as the Character Delete key. Enter the
appropriate ASCII number.

17: Line Delete
This determines the ASCII character used as the Line Delete key. Enter the
appropriate ASCII number.

18: Line Display
This determines the ASCII character used to redisplay a line. Enter the appropriate
ASCII number.

19: Terminal Type
Specify whether you are using a video or hardcopy terminal. This affects how the
PAD handles deletions.

20: Echo Mask
Choose the appropriate echo mask. Possible values are:

� All

� Not CR
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� Not LF

� Not VT, HF, FF

� Not BEL, BS

� Not ESC, ENQ

� Not ACK, NAK, STX, SOH, EOT, ETB, ETX

� Not chars from P16, P17, P18

� Not <DEL> or other Ctrl chars

If your PSDN has supplied you with a numerical value, you need to find out which
mask it represents.

21: Parity
Set the parity to None, Checked, Generated, or Checked and generated.

22: Page Wait
The PAD halts the display after the number of lines you specify here. Pressing the
space bar displays the next page of data.

PAD Printer
In x25tool , the parameters for the PAD Printer can be accessed through the
Services menu.

The parameter values are stored in the configuration file:
/etc/opt/SUNWconn/x25/xtpmapconf.

You can install a printer over an X.25 network so that users logged in remotely can
print to their local printer.

Note - Before you can print through PAD, you must use admintool to set up the
printer. Do this as you normally would, but make certain that you set it up as a
Local Printer, and specify an X25 printer port that also includes a unique printer
number, for example /dev/xtp7 . See User Account, Printers and Mail Administration
for more information about using admintool .

Printer Name
Enter the name of the printer.
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Device Number
This is the printer port number. For example, if you entered /dev/xtp7 for the
printer port in admintool, then the device number is 7.

Link Number
Specify the link to use for the outgoing printer connection. If you set this to 255, the
link number will be selected automatically.

Remote X.121 Address
Enter the destination X.121 address to use for establishing the virtual connection.

Clear Flag
If Clear Flag is set to Yes, then a Clear Invitation packet will be sent at the end of the
data transfer, and the connection will then be cleared by the remote PAD after all of
the data is received. This ensures that all data have reached the remote PAD, but can
lead to connection staying up if the remote does not support this feature.

If Clear Flag is set to No, then a Clear Invitation packet will not be sent at the end of
the data transfer. If the remote PAD does not support Clear Invitation, you should
set Clear Flag to No and enter a value for the Timeout.

Timeout
This is the amount of time, in seconds, that the X.25 server will keep the connection
open after the last print packet has been sent. Setting a timeout value can help
prevent loss of print data, however, you will have to use your own knowledge of the
network to determine how long the connection needs to stay open.

You only need to set a timeout if Clear Flag is set to No.

Call User Data
This is the call user data used to establish the virtual connection. Before this
information is included, it should have been agreed upon by both sides of the
connection.
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Network User Identifier Parameters
In x25tool , the parameters for the NUI Mapping can be accessed through the
Services menu.

The parameter values are stored in the configuration file:
/etc/opt/SUNWconn/x25/nuimapconf.

The Network User Identifier parameters are used to create a mapping between
Network User Identifiers and facilities. When a call is made using NUI override, the
facilities set here override any other facilities that might otherwise apply to the call.

NUI

The Network User Identifier, a string of up to 64 alphanumeric characters.

Throughput Class

Enter a number value for the throughput class to use for incoming (Remote) and
outgoing (Local) calls. These can be different.

Packet Size

The sizes to use for incoming (Remote) and outgoing (Local) packets. These can be
different.

Packet Format

Choose between Normal and Extended.

Window Size

The window size to use for incoming (Remote) and outgoing (Local) calls. These can
be different.

CUG

Whether Closed User Groups are in use. Choose between None, Normal and
Outgoing.
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CUG Type
Choose Basic or Extended.

Routing
In x25tool , you can configure the routing parameters in the Routing window,
which can be accessed through the Services menu.

The parameter values are stored in the configuration file:
/etc/opt/SUNWconn/x25/routes.

If you have multiple links, Solstice X.25 automatically selects a link for outgoing calls
based on address information in a Call Request packet. The parameters for
configuring this are:

Route Type
Table 7–9 lists the available route types:

TABLE 7–9 Route Types

Type Meaning

X.121 Host Associates the complete X.121 address of a remote host with a link. This
type of entry can include a MAC address.

X.121 Prefix Associates the leading digits (one or more) of an X.121 address with a
link. This type of entry can include a MAC address.

X.121 Default Contains a link and an optional MAC address. This entry (there can be
only one) is used if no match is found between a called address and any
X.121 host or prefix entries.

AEF Host Associates the complete extended address (such as an OSI NSAP address)
of a remote host with a link. This type of entry can include an X.121
address or a MAC address, and a protocol id.
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TABLE 7–9 Route Types (continued)

Type Meaning

AEF Prefix Associates the leading digits (one or more) of an extended address with a
link. This type of entry can include an X.121 address or a MAC address,
and a protocol id.

AEF Default Contains a link and, optionally, an X.121 or a MAC address, and a
protocol id. This entry (there can be only one) is used if no match is
found between a called address and any AEF host or prefix entries.

Link Number
The link number to be associated with a host address, an address prefix, or a default
entry. This is the same number as you specified it in the Link Number item in the
Link Editor window in x25tool .

X.121 Address
For an X.121 host-type entry, enter a complete X.121 host address, as it would be
specified in the called address portion of a Call Request packet. For an X.121
prefix-type entry, enter the leading digits (for example, the DNIC) of an X.121
address. For the optional portion of an AEF routing entry, enter a complete X.121
address.

Address Extension
For an AEF host-type entry, enter a complete extended address, such as an OSI
NSAP address. For an AEF prefix-type entry, enter the leading digits (at least one) of
an extended address.

Protocol ID
A protocol id of no more than five bytes (10 decimal digits). A protocol id is an
optional addition to an AEF host, prefix, or default entry. Enter a protocol id as a
string of consecutive digits.

MAC Address
The MAC address to which the call will be routed if the link is a LAN link.
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Enter a six-byte (twelve-digit) hexadecimal value, such as an Ethernet or FDDI
address. You can enter the address as consecutive digits or with colons separating
bytes. For example, both 080020110233 and 08:0:20:11:2:33 are valid entries.
When you save a routing entry with a colon-delimited MAC address, x25tool
removes and subsequently displays the address without colons and with leading
zeroes within bytes.

Telephone Number
Used for dial-up configurations, this is the telephone number of the point of
attachment to the PSDN. In most cases, this is a modem.

Comment
You can add an optional comment.

Call Filtering
In x25tool , the parameters for Call Filtering can be accessed through the Services
menu.

The parameter values are stored in the configuration files:
/etc/opt/SUNWconn/x25/x25secuconf and
/etc/opt/SUNWconn/x25/x25secupid .

Use X.25 Call Filtering to define which incoming calls will be authorized.

Service Name
Select PAD, TCP-IP, CLNP, OSI, Other, or None to indicate from which service you
want to accept incoming calls.

Call User Data
Select Matches, Starts with, or Don’t Care to indicate which callers to accept calls
from. If you select Matches, or Starts with, you will also need to type in the data.
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Accept Calls
Specify a time period when calls will be accepted. You can set this up so it is
repeated Weekly, Daily, or One Time only.

Link Number

You can restrict which networks you will accept calls from by specifying the Link
Number you will accept calls from. If the link number is set to 255, then X.25 will
accept calls over any link.

Calling Address
This is the address of the machine that initiated the call. Set this to Starts with,
Matches, Ends with, or Don’t Care.
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CHAPTER 8

Example Configurations

This chapter contains additional example configurations that you may find useful.
The first two are configurations that can be useful for test purposes: a loopback
configuration and a back-to-back configuration.

Note - In each example, you must first log in as root or become superuser before
starting x25tool .

Setting up a Loopback Configuration
A loopback configuration is useful for testing and troubleshooting your local
configuration down to, and including, the link layer. Completing a call over a
loopback interface is a useful check of your local X.25 and link layer configuration. If
you have problems bringing up the X.25 network, a loopback test should be one of
the first tests you perform.

Follow the instructions in “Loopback over a WAN (LAPB)” on page 115 to configure
a loopback over LAPB and in “Loopback over LLC2 (LAN Links)” on page 119 to
configure a loopback over LLC2.

Loopback over a WAN (LAPB)
For a loopback configuration over LAPB, you must have two links. Configure these
as follows:

1. Display the Link Editor window.

In the x25tool base window, click on Add and select the default template.
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2. Create the first loopback link by assigning the values shown below:

� A unique link number

� WAN as the link type

� WLOOP as the device type

� 0 as the port number

� Interface type as DTE

� LAP protocol to LAPB

� Any string of digits as the address

Keep the default Packet sizes and LCRs.

Figure 8–1 Creating the First Link in the Loopback Configuration

3. Click on OK to apply the changes and to dismiss the window.

4. Create a second link.
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Configure the values as shown below:

� A unique link number

� WAN as the link type

� WLOOP as the device type

� 1 as the port number

� Interface type as DCE

� LAP protocol to LAPB

� Any string of digits as the address

Ensure that the packet sizes and LCRs match those used by the first link.

Figure 8–2 Creating the Second Link in the Loopback Configuration

5. Click on OK to apply the changes and to dismiss the Link Editor.
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6. Save the changes to the configuration.

From the x25tool menu, select File ⇒ Save.

7. Stop and restart your X.25 network.

From the Network menu in x25tool , select Stop X.25 Network and Start X.25
Network.

At this point, you have a usable loopback interface for LAPB. You can test it with
a command such as the one below. In this example, you have a loopback interface
on link 2 with a Remote Address of 1111:

% pad 2.1111 Break-in sequence is ‘^Pa’

Connecting...
Connected
Solstice X.29 Terminal Service
login:

You can connect to the other member of the link pair by specifying its link
number and its Local Address. For example:

% pad 3.1234 Break-in sequence is ‘^Pa’

Connecting...
Connected
Solstice X.29 Terminal Service
login:

It is convenient to set up entries for your loopback interfaces in your PAD hosts
database. See “Configuring the PAD Hosts Database” on page 52 for instructions.
In the PAD Hosts Database window, you need enter values only for the Host
Name, Remote Address, and Link Number parameters.

You can run x25trace in another window and observe LAPB and X.25 Packet
Layer activity over the loopback interface. To do this, open another window, log
on as root and type:

# /opt/SUNWconn/bin/x25trace -i /dev/lapb

See “Obtaining Packet and Link-Level Traces” on page 163 for instructions on the
use of x25trace .
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Loopback over LLC2 (LAN Links)
The LLC2 layer supports loopback by default, using the loopback SAP of 70. To test
a loopback connection over LLC2, simply specify your LLC2 link number, MAC
address, and SAP address of 70 as arguments to the pad program. For example, if
your LLC2 link number is 1 and your MAC (Ethernet) address is 8:0:20:ab:21:6 ,
enter:

% pad 1.080020ab210670 Break-in sequence is ‘^Pa’

Connecting...
Connected
Solstice X.29 Terminal Service
login:

You can also set up entries for your LLC2 loopback interface in your PAD hosts
database. See “Configuring the PAD Hosts Database” on page 52 for instructions. In
the PAD Hosts Database window, you need enter values only for the Host Name,
Remote Address (your MAC address plus 70), and Link Number parameters.

To observe LLC2 protocol activity over the loopback interface, you can, as root ,
enter an x25trace command such as:

# /opt/SUNWconn/bin/x25trace -i /dev/llc2

See “Obtaining Packet and Link-Level Traces” on page 163 for instructions on the use
of x25trace .

Setting up a Back-to-Back Test
Configuration
If you are using Solstice X.25 to connect to a PSDN, you need to make a call over the
PSDN in order to check that your configuration works with it. However, you can test
user-developed applications, and certain aspects of your X.25, LAPB, and WAN
configuration, by using a null modem cable or modem emulator to set up a
“back-to-back” connection to another machine.

Note - See “Building the Null Modem Cable” on page 176, for instructions on
building a null modem cable.
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Follow the instructions in “Back-to-Back WAN Links” on page 120 to set up a
back-to-back WAN connection, and in “Back-to-Back LAN Links” on page 122 to set
up a back-to-back LAN connection.

Back-to-Back WAN Links
This example will work for Solstice X.25 9.x and SunLink X.25 8.x. You can also
configure a back-to-back WAN link for SunNet X.25 7.0, but the instructions are
slightly different. They have been included in the example.

1. Connect your communications equipment.

If you are using a modem eliminator, connect the cables from the modem
eliminator to the two machines. If you are using a null modem cable, connect the
cable to the two machines.

2. Create a link on the local machine.

Follow the instructions in “Configuring a Single WAN Link” on page 35.

In the x25tool windows use the following values:

� In the Link Editor window, accept ZSH (the default), or specify HSI for the
Device item.

� Choose a speed that is supported by the remote machine for the Tx Clock
parameter. If the remote machine is a SunNet X.25 7.0 machine, on that
machine enter a command such as:

% grep syncinit /etc/sunlink/x25/rc
/usr/sunlink/sync/syncinit zss0 speed=19200 txc=baud rxc=rxc > /dev/console 2>&1

In the example output above, the remote machine is running at 19200 bps. In
such a case, specify 19200 for Tx Clock for the local machine.

� In the Link Editor window, set the Interface parameter to DTE (the default) or
DCE. The local machine Interface parameter must be the opposite of the
remote end. For example, if the remote machine is a SunNet X.25 7.0 machine,
on that machine enter a command such as:

remote_host x25config -d /etc/solstice/x25/x25params0 | grep 198
x25 1984 normal dte

In the example output above, the remote machine is a DTE. In this case, you
would, specify DCE for the local machine.

� Still in the Link Editor window, specify a Local Address. Make a note of this
address.

� Under Logical Channel range in the Link Editor window, specify a two-way
range that corresponds to the range used by the remote machine. If the remote
machine is a SunNet X.25 7.0 machine, on that machine enter a command such
as:
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remote_host% x25config -d /etc/sunlink/x25/x25params0 | grep way
lcn_two_way 512-575

In the example output above, the remote machine has a logical channel range
of 512-575, the default for SunNet X.25 7.0. In this case, you would specify the
same range for the local machine.

� Choose an X.25 configuration file that is appropriate for your local DTE/DCE
role and for the X.25 recommendation year supported by the remote machine.
For example, if the remote machine is a DTE that supports 1984 X.25, select
def.dce84.x25 .

3. Display the PAD Hosts Database widow.

In the x25tool base window, select Services ⇒ PAD ⇒ PAD Host database.

In the PAD Hosts Database window, click on Add and enter the name of the
remote machine in the Host Name field and the DTE or DCE X.121 address of the
remote machine in the Remote Address field. If the remote machine is a SunNet
X.25 7.0 machine, on that machine enter a command such as:

remote_host% x25config -d /etc/sunlink/x25/x25params0 | grep ^add
address 1000-5555-22

In the example output above, the remote machine has an address of 1000555522 .
Enter this value (without the hyphens) in the Remote Address field.

After entering the name and address of the remote machine, click on Apply in the
PAD Hosts Database Window. Click on OK to dismiss the window.

4. Start the X.25 network.

5. Repeat Steps 2, 3 and 4 of this procedure on the remote machine to bring up
the X.25 software on that machine.

If this machine is running Solstice 9.x or SunLink 8.x, perform the steps exactly as
described above. If the remote machine is running SunNet X.25 7.0 or another
vendor’s X.25, create an equivalent configuration.

6. In a terminal window, enter a command such as:

local_host% /opt/SUNWconn/bin/pad remote host

where remote host is the name you entered for the remote host. You should receive
a message indicating that your call is connected. If you do not, it indicates a
configuration problem on the local or remote end.
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Back-to-Back LAN Links
1. Ensure that both machines are connected to the same Ethernet segment or

FDDI dual ring or concentrator (or back-to-back with FDDI/S).

2. Create a link on the local machine.

Follow the procedure specified in “Setting up a Workstation Attached to a LAN”
on page 141.

In the x25tool windows use the following values:

� In the Interface Configuration window, specify LE (Ethernet), FDDI/S, or
FDDI/DX for the Device item.

� Under Logical Channel ranges, specify a two-way range that corresponds to
the range used by the remote machine. If the remote machine is a SunNet X.25
7.0 machine, on that machine enter a command such as:

% x25config -d /etc/sunlink/x25/x25params link number llc2 | grep way lcn_two_way 512-575

In the example output above, the remote machine has a logical channel range of
512-575, the default for SunNet X.25 7.0. Specify the same range for the local
machine.

3. Display the PAD Hosts Database window.

In the x25too l base window, click on Service ⇒ PAD ⇒ PAD Hosts Database.

4. Enter information about the remote machine.

In the PAD Hosts Database window, click on Add and enter the name of the
remote machine in the Remote Host Name field and the MAC address of the
remote machine in the Remote X.121 Address field. Append the value 7e (the
LSAP address that designates LLC2) to the MAC address.

If the remote machine is on the same Ethernet segment or FDDI ring, you can
obtain its MAC address by entering the commands shown below on the local
machine:

local_host% arp remote-hostname remote-hostname (129.144.41.29) at 8:0:20:10:b5:a2

In the example output above, the last field on the second output line,
8:0:20:10:b5:a2 , is the MAC address. You can copy-and-paste arp output
into the Remote Address field and append :7e to form a full LSAP address.

After entering the name and address of the remote machine, click on Apply in the
PAD Hosts Database Window. Click on OK to dismiss the window.

5. Start the X.25 network.

You do not need to do this if your X.25 network is already up, and you made no
changes in the Link Editor window.
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6. Repeat Steps 2, 3 and 4 of this procedure on the remote machine to bring up
the X.25 software on that machine.

If this machine is running the current release of Solstice X.25, perform the steps
exactly as described above. If the remote machine is running SunNet X.25 7.0 or
another vendor’s X.25, create an equivalent configuration.

7. In a terminal window, enter a command such as:

hostname% /opt/SUNWconn/bin/pad remote host

where remote host is the name of the remote host.

You should receive a message indicating that your call is connected. If you do
not, there is a configuration problem on the local or remote end.

Setting up a Server to Receive PAD Calls
In this example, a server is attached to a PSDN. It needs to be configured so that
remote machines can access it using the PAD.

X.25
PSDN

server

workstation 1

workstation 2

(Transpac)

hih0

2080381234

2080691234

2080691235

(Adminstrator ’s
workstation)

workstation 3
2080691236 workstation 4

2080691237 workstation 5
2080691238

Figure 8–3 Setting up a Server to Receive PAD Calls

In the example:
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� All remote workstations are running Solstice X.25 and can access the server. The
server must be configured to use Solstice X.25 and to receive PAD calls from the
other workstations.

� Workstation 1 is used by the system administrator when at the remote site. It
needs full terminal-type access to the server.

� The other machines are used by employees at the remote site. The system
administrator has written an application to drop calls to the server straight into a
menu system that gives them access only to the information they need.

To create this kind of configuration you need to:

� Create a link between the server and the PSDN.

� Configure the logical channel ranges, and any other optional parameters, used by
each PSDN.

� Configure the PAD Listen Database.

Note - The workstations must also be configured so that they can access the server.
Refer to “Configuring the PAD Hosts Database” on page 52 in Chapter 6 for
instructions.

Configuring the WAN Link
First, create a link between the server and the PSDN:

1. From the x25tool menu, select Edit ⇒ Add. The list of templates will appear.
Select TRANSPAC.

2. Create a link to the PSDN.

Edit the default values to match those required by the PSDN:

3. Adjust the logical channel ranges to match those used by the PSDN.

Enter the values assigned by your PSDN. If there are no values assigned to a
particular LCR, leave both minimum and maximum as 0.

Configuring Parameters

Once you have created the link, you may also need to configure other packet
layer and LAPB layer parameters. To access them from the Link Editor window,
select LAPB, WAN. Which values you need to change depends on the PSDN you
are attaching to, and on your own configuration.

For more information, see Chapter 7.

4. Click on OK to apply the changes and dismiss the window.
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Configuring the PAD Daemon Listen Database
Next, configure the PAD Daemon Listen Database. This determines how the server
will handle incoming PAD calls.

1. In the x25tool main window, click on Services, then select PAD ⇒ PAD
Daemon.

This brings up the PAD Daemon Listen Database window.

Figure 8–4 Configuring the PAD Daemon Listen Database

2. Configure the Global default values.

These will be used for incoming calls from all machines except the one reserved
for the administrator’s use. In the top part of the screen, specify that all incoming
calls are to start the menu application immediately. The Solstice X.25 9.2 system
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software does not include a menu driven application program. You need to write
the application, then use the Initial Command parameter to call it.

3. Add a new “perhost” entry for the system administrator’s workstation.

In the middle part of the window, add an entry to the list for the machine used
by the system administrator. Click on Add, then set Calling Address to Matches.
Next to Calling Address Matches, type in the name of the remote machine.
Finally, specify the Welcome Banner, and the Initial Command parameters to
determine what should happen when a call is received from that address. If you
leave the Initial command line blank, /bin/login is launched by default.

4. Click on OK to apply the changes and to dismiss the window.

Once you have finished configuring the PAD Daemon Listen Database, you are
ready to start Solstice X.25 by pulling down the Network menu and choosing
Start X.25.

You can check that your configuration is working correctly by trying to make a
PAD call from a remote machine.

Setting Up a Server to Operate as an IP
Router
In this example, Server A has Solstice X.25 installed. This lets it route TCP/IP traffic
and provide a connection to the X.25 PSDN for any machine attached to the same
LAN. The other machines on the LAN do not need to run X.25 themselves in order
to connect to remote devices across the WAN.

LAN

LAN

X.25 PSDN
(Tymnet) 192.1.0.1

192.2.0.1

192.3.0.1

192.0.0.0

192.0.0.3

192.0.0.2

192.0.0.1
Server A

Figure 8–5 Setting Up a Server to Operate as an IP Router
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Note - A machine does not need to have X.25 configured on its LAN interface in
order to be able to act as a router between a LAN and a WAN. IP will handle sending
traffic to the router. X.25 is needed to provide the logical connection to the WAN.

To make a configuration like this, you need to:

� Configure the link between the server and the WAN.

� Configure the logical channel ranges, and any other optional parameters, used by
the PSDN.

� Configure the values used for routing IP.

Configuring the WAN Link
First, configure the link between the server and the WAN. This example uses a High
Speed Interface.

1. Bring up the Link Editor window.

From the Edit menu, select Add. Select Tymnet from the template list.

2. Change the other values as shown in the snapshot below.

Refer to “x25tool Overview” on page 21 for help if you do not know how to
change the values.
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Figure 8–6 Configuring a Link Between the Server and the WAN

3. Adjust the logical channel ranges to match those used by the PSDN.

Enter the values assigned by your PSDN. In the example, there are 63 two way
SVCs, numbered from 512 to 575, inclusively. Since there are no PVCs, or one
way SVCs, these fields are left as 0.

4. Click on OK to apply the changes and dismiss the window.

Configuring Parameters
Once you have created the link, you may also need to configure other packet layer
and LAPB layer parameters. To access them, from the Link Editor window, select
LAPB, ⇒ WAN. Which values you need to change depends on the PSDN you are
attaching to, and on your own configuration. For more information, see Chapter 7.
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Configuring IP Routing
Now you are ready to set up the values that will be used for routing IP.

1. Pull down the Services menu and choose IP ⇒ IP Interface. The IP Interface
Configuration window appears.

2. Enter the information about the IP network that this router will attach to.

Click on the Add button. The snapshot below summarizes the changes you need
to make for this example configuration:

Figure 8–7 Configuring the IP Routing

You always need to specify the local IP address. You should also specify the IP
subnet mask. To use the network default, leave the subnet mask field blank.

Once you have made the changes, click on Apply. In most instances, the default
settings are sufficient, but if you need to change the default X.25 parameters, click
on Modify, then click on the X.25 Parameters button to access the X.25
Configuration for IP Interface window.

The snapshot below summarizes the changes you need to make for this example
configuration:
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Figure 8–8 Configuring the X.25 Parameters for the IP Interface

Unless you are connecting to the Defense Data Network (DDN), specify CCITT
address mapping.

To restrict access and so add a measure of security, you can choose not to accept
calls from unknown hosts. A host is unknown if its address is not included in the
Remote Host to X.25 Address Map. Refer to “IP Interface Configuration” on page
93.

The Listen Information is useful if the machine you are configuring has more
than one address. You can use it to restrict which address(es) will respond.

You can also filter incoming calls based on their Call User Data. Take care not to
delete the initial CCif you are using this parameter—this specifies that calls are
for IP. Without the initial CC, calls will fail. Refer to “IP Interface Configuration”
on page 93 for more detail.

3. Configure information mapping remote IP addresses to remote X.25 addresses.

Pull down the Services menu and choose IP ⇒ IP Mapping. The Remote IP Host
to X.25 Address Map window appears. The snapshot below summarizes the
information you need to add. Again, you can keep most of the default values:
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Figure 8–9 Information Mapping of Remote IP Addresses to Remote X.25 Address.

You can enter a host name which has been defined in /etc/hosts in place of
the remote IP address.

4. Click on OK to save the changes and to dismiss the window.

5. Start X.25 by pulling down the Network menu and clicking on Start X.25.

To check that the configuration works, try to ping the remote machine or to
rlogin .

Setting up a Server with Multiple WAN
Links
In this example configuration, the server is connected to three different PSDNs. It
will be used primarily by users who want to make PAD calls to machines on the
remote network.
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Transpac

GNS

Datex-P

Figure 8–10 Setting up a Server with Multiple WAN Links

To set up a configuration like this, you need to:

� Create a link to each PSDN.

� Configure the logical channel ranges, and any other optional parameters, used by
each PSDN.

� Set up X.25 routing, so that traffic can automatically be sent out on the correct link.

Configuring Three WAN Links
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Figure 8–11 Configuring the WAN Links

The first step in creating this configuration is to create the three WAN links. Start
x25tool , click on Add Link and select the template configuration (Transpac, GNS or
Datex-P) to bring up the Link Editor window. Create three links, using the
appropriate values for each. In the snapshot, the link parameter values apply to
Datex-P, and will be added to the Links Configuration list in x25tool when the
administrator clicks on the template entry.

When configuring the WAN links, pay particular attention to the logical channel
ranges. Different PSDNs allocate different values. Make sure you set the correct
values for each link.

In the same way, change any relevant LAPB and WAN values. Which values you
need to change depends on the PSDN you are attaching to and on your own
configuration.

Note - This example uses three HSI interfaces. You can also mix links that use the
onboard serial port (zsh ) and links that use high speed interfaces. However, you
cannot run Solstice X.25 on more than two onboard serial ports on the same machine.
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Configuring Parameters
Once you have created the three WAN links, you may need to configure other packet
layer and LAPB layer parameters.

1. Change any other X.25 Parameters for this link.

Different PSDNs may require you to change different packet layer parameters.

2. Save your changes.

Configure X.25 Routing
When you have multiple links, you must tell your machine which traffic should go
out on which link. There are several ways of doing this. Which one you use depends
on which applications you are running over your X.25 links. The advice given below
applies to the PAD program supplied with Solstice X.25 and to IP routing. You can
determine the link to use as follows:

� When making PAD calls, the user can specify the link to use as part of the address.
For example, to call the address 2080381111 using link 0, the user could enter:

% pad 0.2080381111

If your users are calling only a small number of remote machines this may be the
easiest option, as it does not require any special configuration. Other applications
may also allow you to specify a link when making a call.

� For PAD calls, you can make entries in the PAD Daemon Listen Database that
specify the address and link number of a remote machine, and provide an alias
that users can use when making calls. Refer to “Configuring the PAD Hosts
Database” on page 52 for more information. Using this option saves users from
having to remember remote addresses and link numbers.

� For IP, when you make an entry in the Remote IP Host to X.25 Address Map, you
can specify the link to use to reach each remote IP address. See “Configuring
Solstice X.25 to Route IP” on page 49 in Chapter 6. Or, you can use automatic
routing, if you have multiple links. See “Routing” on page 111” in Chapter 7.

� You can use automatic routing. For PAD calls and other applications, you can use
the X.25 Routing table. This is the most practical option where there are a large
number of remote machines. Making a PAD Hosts Database entry for each one
could quickly become unwieldy. The rest of this section looks at how to configure
X.25 routing.

Note - The X.25 Routing table is also used in dial-up configurations. Refer to
“Configuring the X.25 Routing Table” on page 140.

To display the X.25 Routing window, select Routing, under Services Configuration in
the X25tool window. The Routing Parameters window appears. When the window
first appears, the parameters are all grayed out. To fill in the parameters:

134 Solstice X.25 9.2 Administration Guide ♦ October 1999



1. Click on Add, then select Top, Bottom, Before, or After to determine where in
the list to add the new entry.

The Routing Parameters window looks like this:

Figure 8–12 Configuring the Routing Parameters Window

2. Enter the number of the link that reaches this destination.

This is the number you assigned to the link when you created it.

3. Configure the Route Type.

� For an individual remote host, choose X.121 Host or AEF Host.

� For a to a group of similar addresses, choose X.121 Prefix or AEF Prefix.

� For all calls unless otherwise specified, choose X.121 Default or AEF Default.

In the example, calls are being routed to three different remote networks. Each
remote network address starts with a unique 4 digit sequence, so X.121 Prefix is
the appropriate Route Type to choose in all three cases.

Note - AEF addresses are used on OSI networks. Use AEF addresses instead of
X.121 addresses if your network uses the OSI protocol stack instead of the TCP/
IP protocol stack.
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4. Enter the X.121 address prefix.

You need to enter enough digits here to distinguish the remote network clearly,
without adding so many that you limit which destinations can be reached on the
remote network. The 4 digits shown in the example clearly identify each network
without restricting calls to part of the network.

Note - When making international calls, some PSDNs require you to precede the
X.121 address with a code indicating that this is an international call. For example,
to make an international call from Germany, you must add a 0 to the front of the
X.121 address. If you are configuring international calls and this applies to your
PSDN, make sure you include this as part of the X.121 address prefix.

5. Enter a comment (optional).

You could identify the destination that this link reaches, for example.

6. Save your changes and dismiss the window.

Click on Apply, then click on OK to dismiss the Routing Parameters window.

Once you have finished adding routes, you are ready to start the Solstice X.25
software. Start X.25 by pulling down the Network menu and choosing Start X.25.

You can check that your configuration is working correctly by trying to make a
PAD call to a machine on one of the remote networks.

Setting up a Dial-up Link Configuration
In this example, the workstation is running Solstice X.25 so that it can dial into the
PSDN. A modem provides the connection to the PSDN.

Corporate
Network

PSDN
(Telenet)

Machine at home

server

modem

Figure 8–13 Setting up a Dial-up Link Configuration

As there is a server on the corporate network that is attached to the same PSDN, the
workstation can access the server, for example, by making a PAD call. From there, it
can rlogin to other machines on the corporate network. Alternatively, the server
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could be configured to act as an IP router, giving direct access to the whole network.
To configure a machine to use a dial-up connection:

� Create a link to the PSDN.

� Configure the logical channel ranges.

� Specify that V25bis calling procedures are to be used.

� Set the idle disconnect timer to a reasonable value.

� Configure X.32 authentication procedures.

� Add the telephone number of the point of connection to the network (in this case
a modem) to the X.25 Routing table.

Note - Before configuring Solstice X.25 9.2, you must configure your modem to
operate in V.25bis mode—refer to your modem manufacturer’s documentation for
instructions that apply to your particular modem.

Configuring the WAN Link to the PSDN
First configure the link between the server and the PSDN. In the example this is the
onboard serial port connected to the modem.

1. Edit Link 0 , the default WAN link.

Click on the entry for Link 0 in the scrolling list, then click on Modify Link.

2. Change the other values as shown in the snapshot below.

Refer to “x25tool Overview” on page 21 for help if you do not know how to
change values:
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Figure 8–14 Modifying a WAN Link Configuration

3. Click on Apply to update the configuration.

Configuring the Idle Disconnect
You will need to set the Idle Disconnect. This is the period of time, in tenths of a
second, that the link will remain idle before closing down.

1. From the Link Editor, select Timers and Counters.

The Timers and Counters button is located under Advanced Parameters.

2. Set the Idle Disconnect.

Set a value (in tenths of a second) that is high enough to allow for lost traffic and
retries, but low enough that you are not constantly paying for an idle link.
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3. Click on OK to update the configuration and return to the Link Editor.

4. Click on OK to update the configuration and exit the Link Editor.

Configuring Parameters
Once you have created the link, you need to specify that V25 calling procedures are
to be used, and set the idle disconnect to a reasonable value.

Configuring V.25bis Calling Procedures
V.25bis calling procedures are used to control the modem for a dial-up link. You must
specify that V.25bis calling procedures are to be used. The parameters you need are
located in the LAPB and WAN Parameters window. To configure the parameters:

1. Display the LAPB and WAN Parameters window.

In the Link Editor, click on the LAPB,WAN button, which is located under
Advanced Configuration. The LAPB and WAN Parameters window appears.

2. Choose V25 Calling procedures.

Pull down the Calling Procedure menu and choose V25.

3. Set the V25 Call Request Timer.

This determines the length of time, in tenths of a second, that your machine will
continue trying to connect to the remote network before timing out. If your
modem supports call fail indications, set the V25 Call request timer to 0. Check
with your modem supplier to find out if this is the case.

Configuring X.32 Authentication Procedures
Next you need to configure the X.32 authentication procedures. These are used on
dial-up links by most PSDNs, to prevent people without permission from dialing in.
To configure X.32 authentication:

1. Set Enable X.32 Authentication to Yes.

You can choose to carry out X.32 authentication at link level or a packet level.
When connecting to a PSDN, use link level as this means the authentication is
carried out by the network. Packet level is appropriate when connecting with
another machine (back to back, for example) when you want the machine and not
the network to do the authentication. Both the Identity and the Signature can be
any hexadecimal string, up to 32 characters long, not containing whitespace.

2. Click on OK to exit the LAPB and WAN parameters window.
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3. Save the configuration.

This makes sure your changes will be used when you start X.25. From the
x25tool main menu select File ⇒ Save, and save the changes to the current
configuration. Or you can select File ⇒ Save As, to save the changes in a different
configuration.

Configuring the X.25 Routing Table
The final step in configuring a dial-up machine is to add the telephone number for
the network point of connection to the X.25 routing parameters table so that it is
mapped to the X.121 address of the machine you want to be able to access. In the
example, this is a host on the remote network that is configured to act as an IP
router, providing access to the remainder of the network.

To display the X.25 Routing table, in the x25tool window, pull down the Services
menu and click on Routing. The X.25 Routing parameters table applies across all
links. To configure:

1. Click on Add, then select Top.

When the window first appears, the parameters are all grayed out. Clicking on
Add, Top creates a new template entry and specifies that the entry will go at the
top of the list.

2. Select the Route Type.

The example uses a route to an individual host, so choose X.121 Host.

3. Enter the number of the link that reaches this destination.

This is the number you assigned to the link when you created it. In the example
this is link 0.

4. Enter the X.121 address.

Enter the address of the server on the corporate network that also has a
connection to the X.25 PSDN.

5. Enter the Telephone Number used to reach this destination.

In a dial-up configuration, this is the address of your point of attachment to the
X.25 PSDN, in most cases a modem.

6. Enter a comment (optional).

You could identify the destination that this link reaches, for example.

7. Save your changes.

Pull down the File menu and choose the Save option.

The completed Routing window for this example looks like this:
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Figure 8–15 Routing Parameters Window

This configuration creates a mapping between the telephone number and the
X.121 address of the remote host. When the machine has traffic for the remote
host, it knows to dial into the X.25 PSDN. The traffic will then be routed to the
remote machine.

Setting up a Workstation Attached to a
LAN

LAN

workstation

Figure 8–16 Setting up a Workstation Attached to a LAN
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In this example, a new workstation is being added to the Local Area Network
(LAN). When installed on a machine attached to a LAN, X.25 is configured over
LLC2 instead of over LAPB.

This kind of configuration is straightforward. You only need to configure the link to
the LAN. The default parameters used at both the Packet layer and the LLC2 layer
should work in almost all LAN configurations.

To configure a LAN link:

1. Start x25tool.

2. In the Links Configuration list, select Link 1, then click on Modify to bring up
the Link Editor window.

You can use Link 1 as a template.

3. Configure the values for your LAN link, as shown below:

Figure 8–17 Configuring LAN Link Values
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You can keep almost all of the default values. The Local Address is the MAC
address of your machine. You can find it out by entering the following command:

hostname% arp machinename

4. Click on Apply.

Should you need to change the Local SAP or Loopback SAP, you can now do this
by selecting Addressing, under Advanced Configurations. However, in most
instances the default settings should work. Make sure that you do not change or
delete the Local SAP or the Loopback SAP, unless you are certain that your
network uses different values.

Once you have added the LAN link like this, you can start the X.25 software. You
should now be able to run your applications over the LAN.

For example, you can make PAD calls to machines on the same LAN by specifying
the link number and the MAC address, followed by the SAP, as shown below:

hostname% pad 1.0800207111117e

where 1 is the link number, 080020711111 is the MAC address, and 7e is the
SAP.

See “Configuring the PAD” on page 52 for information on adding entries to the
PAD Hosts Database.

Note - Even if the LAN link is the only link on your machine, you need to specify
the link number when using applications such as the PAD. This is because Solstice
X.25 defaults to use the lowest numbered WAN link. If there is no WAN link,
there is no default link. Another way to deal with this situation is by using the
X.25 Routing table. Map the MAC address plus link number to an X.121 address,
then make calls to the X.121 address rather than the MAC address. See “Configure
X.25 Routing” on page 134 for an example of configuring the X.25 Routing table.
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Setting up a WAN and a LAN Link on a
PC Running X.25
This section describes how to configure a WAN and a LAN link on a PC running
Solstice X.25. The configuration described in this chapter uses the default values
provided with the product.

X.25
PSDN

PC

LAN

Figure 8–18 Setting up a WAN and a LAN Link on a PC Running X.25

The configuration process is identical to that used for the SPARC version of the
product, but the device names change.

To configure Solstice X.25 to be used over the WAN, you need to:

� Install your selected WAN card

� Configure some information about the link

� Change the logical channel ranges used by the Solstice X.25 software to match
those used by your PSDN

Before you start, make sure you know the following information:

� The version of the X.25 Recommendation used on the PSDN

� The X.121 address of the port you intend to use

� The logical channel ranges used by the PSDN

To configure the LAN link, you only need to configure the link to the LAN. The
default parameters used at both the Packet layer and the LLC2 layer should work in
almost all LAN configurations.

Installing Your WAN Card
In order to run Solstice X.25 9.2 over the WAN, the PC must have an appropriate
WAN card installed. Install this as described in the manufacturers instructions. You
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must use a different interrupt setting for each card that you install—consult your PC
manufacturer’s documentation for instructions on finding out which interrupts and
i/o addresses are available.

Creating the LAN and WAN links.
By default, there are two template links already configured, one WAN link and one
LAN link.

First, you will configure a single WAN link by editing the WAN template.

1. In the x25tool window, make sure the entry for Link 0 in the scrolling list is
highlighted. Select Modify.

The Link Editor window appears.

2. Set the Device type and Port Number.

The example uses the default expx device, which is the device type for the
SCiiExpress-X card. Currently, this is the only available device for WAN links:

3. Make sure the Interface is set as DTE.

The only time you will need to set the Interface as DCE is if you are running two
machines back-to-back, for example for testing.

4. Set the LAP Mode to LAPB, unless you are sure your PSDN uses a different
LAP Mode.

LAP and LAPBE are used very rarely.

5. Set the Local Address.

Type in the address of port 0 in this field. This is the X.121 address assigned to
you by your supplier. This address is often referred to as an X.25 address. Your
service supplier should tell you this address.

Note - The Full Address and Extended Address parameters are not used when
the product is in normal operation. You only need to enter these if you are using
an application that expects to read them. If this is the case with your PSDN, your
service provider will tell you what you need to enter here.

6. Select the Version.

Pull down the Version menu and choose the version of the X.25 recommendation
used by your PSDN.

7. Set the Logical Channel Range.
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Your PSDN will tell you which values to use here. Contact them if you require
this information. If you are configuring a private network, all machines on the
network must use the same logical channel ranges. In this case, you can choose
any values that comply with the X.25 Recommendations.

8. Click on Apply to confirm your changes.

Next create the LAN link.

Using link 1 as a template, configure the values for your LAN link. You can keep
almost all of the default values. The device type depends on the type of Ethernet
card used by your PC. The default ELX-0 applies to the 3Com® Etherlink® III
card. If you are not sure of the device type used by your PC, enter the following
command:

hostname% ifconfig -a

Included in the information returned by this command is the name of the device
that IP is running over. Use this same device type for X.25.

The Local Address is the MAC address of your machine. You can find it out by
entering the following command:

hostname% arp machinename

9. Click on Apply.

10. In the x25tool main window, pull down the File menu and select Save.

This makes sure your changes will be used next time you start X.25.

Note - For a default configuration, you do not need to configure the Datalink
layer parameters; the defaults should be adequate.

11. Start X.25 by pulling down the Network menu and clicking on Start X.25.

To check that the configuration is valid, make a PAD call to yourself. To do this,
enter the pad command at a command line, followed by your own X.121 address:

hostname% pad X.121 address

Once you have created a link that works, you can fine-tune it, or configure the
application(s) you want to run over it. The procedure for doing so is the same as
for the SPARC version of the product.
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CHAPTER 9

Solstice X.25 Utilities

Table 9–1 summarizes the command line utilities that are delivered with Solstice
X.25. Consult the man pages for more detailed descriptions of each of the utilities.

TABLE 9–1 Solstice X.25 Command Line Utilities

Name Description

linkadd Dynamically adds a link while X.25 is running.

linkdel Dynamically removes a link while X.25 is running.

linklist Lists the X.25 links that are currently active.

ixetune Configure IXE driver. The ixetune utility reads registration and
configuration information from the file ixetuneconf and sends this
information to the IXE driver. It determines which called addresses a IXE
driver is willing to receive connect indications on (listen information). It
also specifies the configuration for each IP network, as well as the host’s
calling/responding address for this network.

The options are:

-d specify a device for the information to be sent to. The default is /dev/
ixe .

-l specify the IP interface to tune. If this option is not specified, all the
interfaces will be tuned.

-D specify the pathname of the configuration file to use. The default is /
etc/opt/SUNWconn/x25/ . The filename used is the default,
ixetuneconf .
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TABLE 9–1 Solstice X.25 Command Line Utilities (continued)

Name Description

linkreset Resets the state machine for a LAPB link. This utility cycles the link into
disconnected state, and then back to the running state (assuming that the
remote end of the link responds correctly).

All counters and timers associated with the protocol on that link are reset
to their initial values.

This command operates on an individual link, so the link identifier must
be specified.

linkstart Puts a LAPB link into running state. This command causes the specified
link to enter the ADM state, which resets the internal state machine,
causing LAPB to attempt to bring up the link. All counters and timers
associated with the protocol on that link are reset to their initial values.

This command operates on an individual link, so you must specify the
link identifier.

Note - The linkstart utility is intended to reverse the effect of the
linkstop command, and is not the appropriate way to define or create a
LAPB link.

linkstate Displays state of a LAPB link. This command displays the internal state
of the L:APB for a specified link. When the link is operating normally (i.e.
the SABM/UA handshake has been successfully completed) the state
displayed is NORMAL.

Option is:

-e causes the linkstate command to exit with a status value of 0 if the link
is in NORMAL mode, 254 if the X.25 software has not been started, 255 if
the link does not exist or 1 otherwise (the link exist but is not in NORMAL
mode). This may be useful when using the command in shell scripts.

This command operates on an individual link, so you must specify the
link identifier.
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TABLE 9–1 Solstice X.25 Command Line Utilities (continued)

Name Description

linkstop Puts a LAPB link into non-running state. This command forces the
internal state machine of the LAPB to assume that it has received a
disconnect request. This puts the specified link into the disconnected
state. The utility also prevents LAPB from responding to any incoming
frames on the specified link, until the link has been restarted with
linkstart or linkreset . All counters and timers associated with the
link protocol are reset to their initial values.

This command operates on an individual link, so you must specify the
link identifier.

Note - When used on a MLP link, linkstop returns the highest status
of the different SLP.

This command does not work with LLC2 links (because there is no status
available on such links).

vcstat Checks the virtual circuit status. This command lets you monitor the link
and virtual circuit statistic on a cumulative or periodic basis. Options are:

-L display per-link statistics instead of virtual circuit statistics.

-n display cumulative (since the last reboot) statistics instead of
periodically updating the display.

-l interface specify an interface.

-i interval specify the sampling interval to use for displaying cumulative
statistics. If you omit both this and the -n option, vcstat will display
cumulative statistics at 30 second intervals.

-s display X.25 addresses in symbolic form, if possible, using the
information in the file /etc/opt/SUNWconn/x25/xhosts . If a partial
match with an entry in that file is found, then the address will be
displayed as the name followed by the unmatched digits. interface
corresponds to the number specified for the interface parameter in your
link configuration file.

-p period specify the period of time in minutes that vcstat will display
the current statistics. By default, vcstat displays statistics for 1440 minutes
(24 hours).

-v range specify a virtual circuit, or a range of virtual circuits to be
monitored. When specifying a range of virtual circuits, separate the
numbers with a hyphen.

Example: -v 11-34 .

Solstice X.25 Utilities 149



TABLE 9–1 Solstice X.25 Command Line Utilities (continued)

Name Description

x25diags Converts a hexadecimal diagnostic into a short textual description as
defined in the X.25 standard This utility can typically be used when a
cause and diagnostic code are returned by the PAD program or when
such a diagnostic is detected in x25trace output. The parameter value
must be given in hexadecimal without including the error code.

x25file Generates the configuration file of a running link and echoes it on
stdout . Option is:

-l Generates the configuration file for the link number link_id.

x25info Generates a complete configuration report for an X.25 link. Options are:

-h display help information (this is the default option)

-ln specify the link number at the command line level

x25stat Displays per protocol statistics. Options are:

-p show statistics for a specified protocol or list of protocols. Protocol
may be one of ixe , lapb , llc , mlp , wan, x25 or all . all is used to get
statistics for all protocols.

-g Display statistics global to the specified protocols. No global statistics
are displayed for ’wan’ level.

-l link display statistics on a per-link basis.

-L Display statistics relating to all links.

-v When x25 protocol is used, display statistics on a per-VC basis. The
VC can be an actual VC number or a list of VCs separated by commas, or
a range of VCs: VC1-VC2

-V When x25 protocol is used, display statistics relating to all VCs.

-s Display addresses symbolically whenever possible.

-a When used with -v or -V options, print abbreviated statistics for active
VCs.

-F Display all statistics currently available.

-z Resets the statistics. The options g, p, l, L, v, V, apply as for displaying
the statistics. Note: This option is only available to the super-user.
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TABLE 9–1 Solstice X.25 Command Line Utilities (continued)

Name Description

x25trace Run a trace at X.25 packet level. If you are experiencing communication
problems, use this command and redirect its output to a file. Options are:

-a displays total bytes of user data instead of data itself.

-u buffers output line by line.

-x decodes packet and displays in hexadecimal.

-D decodes and displays DLPI messages exchanged between X.25 PLP
and LAPB/LLC2.

—i specify interface to trace: /dev/llc2 the LLC interface for X.25 over
LLC type 2.

/dev/lapb the LAPB interface for X.25 over synchronous point-to-point
lines.

/dev/x25 the X.25 Packet Layer interface (the default).

-l specify single link to trace.

-t use absolute, not relative, time stamps.

filter_expression specifies one of the following filter expressions:

betweenmac trace packets between these.

dstmac trace only packets with this destination MAC address.

mac trace packets to or from this MAC address.

multicast trace only LLC2 packets with a multicast address.

pdu_in trace only incoming PDUs.

pdu_out trace only outgoing PDUs.

srcmac trace only packets or frames with this source address.

x25lcn + trace only packets on the next logical channel set up.

x25lcn n trace only packets on logical channel n.

Note - You can use the logical operators (and, or, and not) with the
expressions defined above.
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CHAPTER 10

Configuring uucp and tip to Run Over
Solstice X.25

The configurations described in this chapter are not part of the Solstice X.25
configuration, but they are provided here for your convenience.

An xty device emulates a tty device, and is required to make outgoing calls using
uucp or tip .

By default, Solstice X.25 provides 16 xty devices. This is sufficient for most purposes.
If you require more than 16 xty devices, add them by editing the /etc/system file.
For example, if you need 20 xty devices, you would add the following line:

set xty:xty_cnt = 20

Incoming calls are handled directly by the PAD daemon which executes the login
process.

Configuring uucp
You need to modify a number of files before uucp/cu calls can be made over the xty
driver. All of the files are in the directory /etc/uucp . For more detail, refer to the
SunOS 5.x Administering TCP/IP and PPP guide. The files you need to modify are:

� Devices Specifies which xty devices are available for outgoing calls.

� Dialcodes Specifies a number of host to X.25 address mappings.

� Permissions Specifies permissions that remote users have when sending files,
whether local users can request files, and which commands users are allowed to
use. Read the section in the SunOS 5.x Administering TCP/IP and PPP guide that
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tells you how to configure the permissions. Incorrectly configuring the permissions
can compromise system security.

� Dialers Specifies the command that uucp issues to the PAD to make a uucp call.

� Systems Specifies the hosts that uucp knows about. It includes the login names
and character sequences that uucp sends and expects to receive.

Editing the Devices File
The xty device numbers should match those generated by kernelcreate , and
should number from one upwards. Add lines like the following to the file:

Pad xty1 - Any pad
Pad xty2 - Any pad

Editing the Dialcodes File
Add entries to the Dialcodes file to specify name to X.25 address mapping. The
names you specify here are used in the Permissions and Systems files. Add lines
like the following to the file:

hostname1 x.25-address
hostname2 x.25-address

Enter the X.25 address in one of the following formats:

� link number.x121 address (for example 0.23433140831 )

� link number.MAC address (for example 1.1234567890AB7E )

Editing the Permissions File
Add lines like the following to this file:

MACHINE=hostname1:hostname2 \
REQUEST=yes \
SENDFILES=yes \
READ=/ WRITE=/ \
COMMANDS=ALL
LOGNAME=nuucp \
REQUEST=yes \
SENDFILES=yes \
READ=/ WRITE=/ \
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(Continuation)

COMMANDS=ALL

It is standard practice to use nuucp as the LOGNAME, but this is not mandatory.

Note - You may want to set more restrictive permissions than those shown above.
For more detail, refer to the SunOS 5.x Administering TCP/IP and PPP.

Editing the Dialers File
You need to tell uucp the command to issue to the PAD to allow outgoing calls. Add
the following line to this file:

pad ‘‘‘‘ ‘‘‘‘ P_ZERO ‘‘‘‘ CALL\040\T

Editing the Systems File
You need to add lines like this to the Systems file:

systemname Any Pad Any hostname in:--in: logname word: password

The hostname is the hostname you mapped to an address in the Dialcodes file.
Alternatively, enter the X.25 address here.

Use the LOGNAMEthat you set in the Permissions file. In most cases this is nuucp .

Configuring tip
To configure tip , add the name of the remote node you want to reach to your
/etc/remote file. The entry must include the device type and also specify the pad
command needed to reach the remote device. If the remote destination is in the hosts
database, you can give the hostname you entered there. The entry looks like this:
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hostname:\
:dv=/dev/ xtydevice:cm=CALL x25.address:

Use the xty device you set using x25tool .
Enter the X.25 address in one of the following formats:

� link number.x121 address (for example 0.23433140831 )

� link number.MAC address (for example 1.1234567890AB7E )
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CHAPTER 11

Troubleshooting

This chapter contains information for troubleshooting possible problems with Solstice
X.25. Problems are generally related to one of the following areas:

� Cabling

� Modem problems

� Logical Channel Ranges

� Other Configuration problems

“Resolving Common Problems” on page 158 offers suggestions for dealing with
these problems. Check this section first to see if the procedures solve the problem.

Otherwise, follow the complete troubleshooting procedure. In general it is best to
take a “bottom up” approach to troubleshooting. The tests in this chapter are
described in that order.

In summary, check:

� The Physical layer:

� Hardware
� Line status

� The Datalink layer

� Packet and link-level traces
� Protocol statistics
� Trace information
� Streams error messages

� The Network Layer:

� Protocol status
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� Connectivity
� Network addresses
� Local routing tables
� Permissions
� Remote operations
� NIS operations (if applicable)

Resolving Common Problems
This section provides information for resolving common problems. These problems
are most likely to appear when you bring up Solstice X.25 for the first time. If you
cannot resolve the problem using the procedures given here, carry out the full set of
tests described in the remainder of this chapter.

Cabling Problems
The following may be symptoms of cabling problems:

� Network does not come up

� X.25 link layer does not come up, or does not stay up

� The message xmit hung appears in the console

� No data is being sent or received

Check the following:

1. Make sure you are using the correct type of cable. Refer to Appendix A for
cabling diagrams.

2. Make sure all cables are properly seated.

3. If you are operating over an LAPB link, make sure that you are using a cable that
is designed for synchronous use. If you have a spare cable, replace your existing
cable and retry the connection.

Modem Problems
The following may be symptoms of modem problems:

� Network does not come up

� X.25 link layer does not come up, or does not stay up

� The message xmit hung appears in the console

� No data is being sent and or received
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Check the following:

1. Make sure your modem is correctly configured. Check your modem’s
documentation.

2. If you still have a connection, check the Transmit and Receive Data lights on your
modem: with LAPB transmission, these should always be on.

3. If you have a connection, use a breakout box at the Sun (not the modem) end of
the connection to check that RS-232-C pins 2, 3, 4, 5, 6, 7, 8, 15, 17, and 20 are
functioning. Pay particular attention to the Transmit Clocking and Receive
Clocking pins, 15 and 17. If the lights corresponding to these pins are not lit, it
indicates that the local and/or remote modems are not supplying clocking. Notify
the remote end and use your modem’s documentation to perform troubleshooting.

4. If you are using a null modem connection, one side should be a DTE, the other a
DCE and one or both sides must supply clocking. See “Building the Null Modem
Cable” on page 176 for instructions on setting up a null modem connection.

Logical Channel Ranges
Logical channel number mismatches can be difficult to diagnose, especially if you are
viewing output from x25trace . You see a Call Request packet going out, but no
response at the X.25 Packet Layer. In a facilities mismatch, for example, you receive a
Clear Indication from the remote end. The Clear Indication contains an error code
that is occasionally helpful in pinpointing the problem. The following symptoms
may mean that the logical channel ranges are incorrectly configured:

� Inability to establish a packet level connection—for example PAD calls fail

� Traffic can be sent in one direction only

� PAD calls are cleared with the error Call Cleared - Out of Order (0900)

� Calls are cleared with an error code of 0x00 24

Check that the logical channel ranges you configured match those used on the X.25
network. If this is a PSDN, contact your service provider to find out what these
should be. Refer to “Configuring a Single WAN Link” on page 35 for information on
how to use x25tool to set the logical channel ranges.

Other Configuration Problems
The following symptoms may indicate that there may be a mistake in the
configuration:

� Network does not come up

� X.25 link layer does not come up, or does not stay up

� Inability to establish a packet level connection—for example PAD calls fail

� Link is up but not responding correctly

� Repeated Resets are being received
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Check the following:

1. Make sure you specified the correct serial port when you ran x25tool or edited the
configuration file. Refer to “Configuring a Single WAN Link” on page 35 for how
to configure this using x25tool .

2. For LAPB links, check that the link is configured as a DTE if communicating over
a PSDN.

3. Facilities and other parameter mismatches, between your machine and the PSDN,
can prevent the establishment of virtual circuits. Check the Negotiate Toward
Defaults item in the Link Editor, Throughput window. For the majority of PSDNs
this should be set to No.

4. Check where calls are being cleared from. If you receive an error code of the form
00 nn, the leading zeroes indicate the call-clearing request originated with the
remote host. If the first two digits are not 00,the call-clearing request originated in
the PSDN.

5. If you receive an error code of 0x00 43, check that your X.121 address is specified
correctly. If it is, check to see whether there is a process listening for an incoming
call.

6. If you receive error code 0x00 42, it is likely that your maximum I-frame size, an
LAPB-layer parameter, is set incorrectly for your link. The maximum I-frame size
is a subscription option to the PSDN. When LAPB is in extended mode, set this
parameter eight bytes larger than the default packet size parameter at the packet
level.When LAPB is in normal mode, set it five bytes larger. If Solstice X.25
receives a Call Request with a packet size that is within eight bytes (or five bytes)
of the maximum I-frame size parameter, the X.25 software clears the call with the
0x00 42 diagnostic. Modify your LAPB parameters as necessary.

7. If you receive error code 0x00 70, check your console to see if you have a licensing
problem.

8. If you can find out about the remote host, check that it is still up.

9. If you are running IP over X.25, run ifconfig commands to check on your ixe
device (for example, zsh0 ). Use of ifconfig is described in “Checking the Protocol
Status ” on page 169. If the response from ifconfig is UP, POINTOPOINT, and
RUNNING, check with your PSDN to see if there is a problem at the network end.

10. Run x25trace to trace the exchange of X.25 packets across the link. People who are
familiar with the X.25 Packet Layer Protocol can interpret the output from
x25trace to determine where errors are occurring. The x25trace command is
described in “Obtaining Packet and Link-Level Traces” on page 163.

11. If you receive a message from PAD such
as, i/o error, open /dev/x25 failed , it might indicate that the X.25
network daemon is down. Check the status of the daemon in x25tool . This
message may also indicate that there are two many simultaneous PAD calls for
the software to cope with. Wait a moment, then try again.
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12. If you experience intermittent disconnections or resets, check for configuration
errors in your link configuration file. At the packet level, make sure that the
window and packet size parameters agree, between your machine and the PSDN.

13. If you receive repeated RESETS with error code 0x0092 , there may be a window
size mismatch.

14. Perform a loopback test, to check your local configuration down to the link layer.

15. Perform a back-to-back test, to test your configuration against that of another
machine.

Note - For error code descriptions, refer to Appendix C.

Checking the Physical Layer
First of all make sure that all of your modem and power cables are in good working
order, and that they are all plugged-in, switched on, and tightly seated. Then carry
out loopback tests. Finally, check the line status.

If you are using the onboard serial port of a SPARCstation, the most thorough
hardware test you can do is to use syncloop . If you are using the SUN HSI card,
the most thorough hardware test you can do is to use hsi_loop . If you are using
another manufacturer’s card, refer to their documentation.

To check the line status, use the syncstat or hsi_stat command to observe the
line over periods of ten seconds.

Checking a High Speed Interface
If you are using a high speed interface, use the hsi_loop command to perform a
loopback test to check the following components of your communications link:

� Software configuration

� CPU-to-card communication

� Correct operation of the serial port

� EIA-449 or EIA-232 ports and cables

� Local and remote modems

� Transmission line

If you see errors in the output, contact your local technical support for help in
interpreting them.
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Checking the Serial Port Line Status
The syncstat command monitors traffic that uses the onboard serial port or the
serial port on the SCiiExpress-X card.

If you see output packets but no input packets, then either the remote system is not
initialized or the line is not properly connected to the remote system. If you see
input packets with CRC errors, the transmission medium is causing errors. If you see
neither input nor output packets, then the Solstice X.25 protocol module was not
successfully initialized. Try restarting the device.

Checking High Speed Interface Line Status
The hsi_stat command monitors traffic over a high speed interface. You must log
in as root , or become superuser , to run hsi_stat .

If you see output packets but no input packets, then either the remote system is not
initialized or the line is not properly connected to the remote system. If you see
input packets with CRC errors, the transmission medium is causing errors. If you see
neither input nor output packets, then the Solstice X.25 protocol module was not
successfully initialized. Try restarting the device.

Checking the Datalink Layer
If the problem is not at the physical layer, the next thing to check is the Solstice X.25
software and configuration. The most important thing is to try and work out in
which layer—X.25, LAPB, LLC2, or WAN—the problem originates. In general, you
should check the following:

� Check the link and packet layers are up—use x25stat.

� Observe connection attempts and obtain clearing causes and diagnostic
codes—use x25trace.

� Log protocol activity—use the strace command and the strerr daemon.

� Obtain an ASCII record of the values of the parameters for all of the layers in your
X.25 configuration— use the x25info utility, in /opt/SUNWconn/bin . This is
particularly useful when you need to send a description of your configuration to
your support provider.

Using one or more of these diagnostic tools, you can usually obtain sufficient
information to diagnose and correct your communications problem.
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Obtaining Packet and Link-Level Traces
Use /opt/SUNWconn/bin/x25trace command to capture information about each
packet and/or frame sent and received by Solstice X.25.

You can specify the layer you want to trace, the interface you want to trace, and the
destination you want to trace. This lets you narrow down the information you
receive.

The x25trace command takes the form shown below:

# /opt/SUNWconn/bin/x25trace [ options] [-i interface] filter_expression

You must run it as root , in the foreground. If you want to capture its output in a file,
use standard Unix redirection to do so. (This is useful if you intend to contact your
local technical support representative for help.) x25trace runs until you enter a Ctrl-C.

You can use specific MAC addresses as filters. For example, you can enter a
command that has the effect of saying, “Trace all packets that travel over interface A
between address 1 and address 2.” Such commands can extend beyond the width of
a command line. In this case, use the backslash (\) continuation character to go
beyond a single line.

Table 11–1 lists the devices x25trace supports:

TABLE 11–1 Devices Supported by x25trace

Device Name Description

/dev/llc2 Supports LLC2 interfaces.

/dev/lapb Supports synchronous point-to-point interfaces.

/dev/x25 Supports the X.25 Packet Layer interface

The following options are available. They are supported by all of the devices.

-a By default, x25trace displays the user data in hexadecimal
for the highest protocol specified. This option tells
x25trace to only display the number of bytes of user data
and not display the data in hexadecimal. For example, if
you enter:

hostname# x25trace -a -i /dev/llc2 x25
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x25trace displays only the number of bytes in X.25
packets sent and received over the llc0 interface.

-l number Specifies the link on which x25trace is to trace packets.
By default, x25trace traces on all links and prints the
link number in the traced information. (This option is
useful only in the situation in which you have multiple
links.)

-u This option causes x25trace to buffer display output
line-by-line, instead of the default operation of
packet-by-packet.

-x This option causes x25trace to display entire packets in
hexadecimal, in addition to its default operation of
decoding the packet. This option is useful in
troubleshooting malformed packets. With such packets,
you often see an error message starting with two asterisks
(**).

You can use the following filter expressions in an x25trace command line:

betweenmac Trace only the packets or frames passing between
the 802.x MAC addresses you specify.

dstmac Trace only the packets or frames that have a
destination address that is the MAC address you
specify.

lapb (or hdlc ) Trace only LAPB frames.

mac Trace packets and frames to/from the MAC
address you specify. Use only when tracing on a
LAN interface.

multicast Trace only LLC2 packets that have multicast
addresses.

pdu_in Trace only incoming Protocol Data Units (PDUs).

pdu_out Trace only outgoing Protocol Data Units (PDUs).

srcmac Trace only the packets or frames that have a
source address that is the MAC address you
specify.

x25 Trace only X.25 Packet Layer Protocol packets.
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x25lcn [+| num>] Used with a plus sign (+), this expression means
trace only the packets that travel on the next
logical channel set up. Used with a number, it
means trace only the packets that travel on the
logical channel identified by num.

x25trace Examples
Below are some examples of using x25trace for tracing incoming and outgoing
packets.

Tracing LAPB and X.25 on /dev/lapb :
To trace LAPB frames and X.25 packets as they are sent or received by LAPB, enter:

hostname# x25trace -i /dev/lapb

To trace X.25 packets as they are seen by the X25 driver, type one of the two
following commands:

hostname# x25trace -i /dev/x25 x25
hostname# x25trace

Tracing LLC2 and X.25 on /dev/llc2 :

hostname# x25trace -i /dev/llc2

The command above captures all LLC frames, including Unnumbered Information
frames used to carry CLNP and ES-IS PDUs. When tracing at the X.25 level on an
LLC2 link, MAC addresses are displayed as 0:0:0:0:0:0 . Tracing at the LLC2 level
on the same link returns the correct MAC addresses.

Tracing a single X.25 connection (logical channel number):

hostname# x25trace -i /dev/lapb x25lcn lcn_num x25

Tracing only the next X.25 connection being set up:

hostname# x25trace -i /dev/lapb x25lcn + x25
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Tracing LLC2 frames on /dev/llc2 :

hostname# x25trace -i /dev/llc2 llc

Tracing X.25 packets to/from specific MAC addresses on /dev/llc2 :

hostname# x25trace -i /dev/llc2 srcmac 8:20:0:1:2:3 x25
hostname# x25trace -i /dev/llc2 dstmac 8:20:0:1:2:3 x25
hostname# x25trace -i /dev/llc2 betweenmac 8:20:0:1:2:3 9:0:2b:18:21:5 x25

Trace outgoing LLC2 frames that are not multicast:

hostname# x25trace -i /dev/llc2 pdu_out not multicast

Redirecting trace of X.25 packets over an LAPB link to a file:

hostname# x25trace -a -i /dev/lapb x25 > /var/adm/x25/packets.record

Displaying Protocol Statistics
Displaying protocol statistics lets you track what is going on a link or links. You can
display statistics on a per-protocol basis, or display statistics for all protocols.

To display statistics, start x25tool , then pull down the Network menu. Choose the
Statistics X.25 menu item. The Network Statistics window appears. Choose the
protocol you would like statistics for by clicking on the box to the left of the protocol
name. You can select more than one protocol; for example, you can select X.25 and
MLP.

Once you have select a protocol or protocols, specify a Link Number or All. Specify
the Interval (in seconds) that Statistics should be collected for, and the level of detail
you require. For example, you may want to isolate the statistics for a particular VC,
if you suspect that is where the problem is. Click on Display to display the
statistics—Clear resets them to zero. Once you are happy with your settings, click on
Apply.

To collect and display statistics, click on the Display button in the Network Statistics
window. Statistics appear in the window and are updated every time the Interval
elapses. If you do not have x25tool running on your system, you can access the
same information by running the command x25stat .
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Logging Trace Information
The SunOS 5.x streams strace (1M) command lets you log trace information. See
the strace man page for details on the command’s use.

The strace command must be followed by three arguments:

module id

Table 11–2 lists the possible values:

TABLE 11–2 strace module id values

Value Meaning

200 PLP driver

201 LAPB driver

202 LLC2 driver

203 XXX

208 IXE (IP over X.25)

210 WAN

218 X25SECU (call filtering)

219 XTP (PAD printer)

link number

The number of the link over which the driver you are tracing is running, or all to
specify all links.

level

The tracing level that allows you to receive more or fewer packets or frames. Table
11–3 lists the available strace tracing levels for the X.25, LAPB, and LLC2 drivers.
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TABLE 11–3 strace Tracing Levels

Level

X.25 driver

module ID 200

LAPB driver

module ID 201

LLC2 driver

module ID 202

1 call setup link up/down link up/down

2 call clearing link reset link reset

3 call reset error activity error activity

4 restart activity link busy link busy

5 interrupt packets not available Type 1 activity

6 data packets not available not available

Specify all to trace all available levels. For example, to trace X.25 PLP packets on all
links at all tracing levels, type:

# /usr/sbin/strace 200 all all

Note that strace is owned by root and is executable only by root.

The tracing of an incoming event does not mean that the packet or frame has been
accepted by the driver at the layer you are tracing. This is because, for a given layer,
the tracing of incoming events is triggered on receiving data from the layer below. At
this point, the packet or frame is not yet verified. If the packet or frame is
subsequently found to be in error, it might be discarded or cause some further
protocol action.

The successful completion of a trace of an outgoing event at the X.25 layer does not
necessarily mean that the packet has been sent to the link layer. Following tracing,
various consistency checks are performed on the link-level database. If these checks
fail, the packet will be discarded. At the LAPB and LLC2 layers, successful tracing
does mean that the frame was sent to the WAN or LAN driver. However, it does not
mean that the frame will be transmitted on the line.

Capturing Streams Error Messages
In Solstice X.25, the X.25, LAPB, and LLC2 drivers can generate streams error
messages. The SunOS 5.x streams strerr (1M) daemon captures streams error
messages. This daemon receives error messages and appends them to log files in
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/var/adm/streams . Log file names take the form error. mm- dd, where mm and
dd indicate the month and day the messages were written to the file.

If you are experiencing problems with Solstice X.25 and are uncertain of the source,
run strerr . If you receive a streams error message, contact your local Sun customer
service representative.

You must be root to run the strerr daemon. Start it like this:

hostname# /usr/sbin/strerr &

The daemon runs until you kill it.

See the strerr man page for a description of the syntax of the messages in the
streams error message file.

Checking the Network Layer
Once you are sure that the physical and datalink layers are both working correctly,
check to see whether the problem is at the network layer. Check the following:

� the state of the line, using ifconfig

� connectivity, using ping

� the network address, using netstat -i

� the routing tables, using netstat -r

� permissions in the /etc/hosts.equiv file

� remote operation, using rlogin

� NIS operation, using ypmatch

Checking the Protocol Status
When Solstice X.25 is running, you can use ifconfig to monitor the current state of
the line. Give the X.25 interface name as an argument. For example,

hostname# ifconfig ixe
ixe: 192.9.200.2 flags=51<UP,RUNNING,PRIVATE>

If the words UPand RUNNINGare displayed, then the connection is potentially intact.

If ifconfig does not display UP and RUNNING, then either you did not configure
the X.25 module correctly or the remote system cannot be contacted.
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The PRIVATE flag, shown in the display above, is associated with Solstice X.25 and
SunLink X.25 devices. The flag means that the routing daemon does not broadcast
the host route for the X.25 device to the local network.

Note - Wait 30 seconds after bringing the X.25 link up to check these statistics, as
these flags can be up to 30 seconds out of date.

Checking Connectivity
Use ping to check that the connection is up:

hostname# ping -r gateway_a
gateway_a is alive

The -r option tells ping that the remote host is on a directly-connected interface,
such as a X.25 link. If the remote host does not respond, a routing problem exists at
some point between the local and remote hosts.

Checking the Network Addresses
Use the netstat -i command to check that the correct local and remote addresses
are assigned to the Solstice X.25 interface:

hostname# netstat -i

Make sure that the IP addresses for the local and remote X.25 interfaces are the same
in the /etc/hosts files or NIS host maps for the machines on both ends of the X.25
link.

Checking the Local Routing Tables
Use the netstat -r command to display the local routing tables:

hostname# netstat -r

The routing table looks like this:
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Routing tables
Destination Gateway Flags Refcnt Use Interface

host_a sun-bb UGH 0 0 ie1
host_b sun-bb UGH 0 0 ie1
gateway_b gateway_a UGH 1 12897 ixe0

route7 route7 UGH 0 0 ie0
eastgate route71 UGH 0 158 ie0
backbone alpha-bb U 1 16087 ie1
dresdenpc route1 UG 0 0 ie1
loopback localhost U 2 113436 lo0
beta-bb alpha U 4063 146044 ie0
dallas2 route7 UG 0 0 ie0
trainingpc route62 UG 0 0 ie1

Make sure there is a routing table entry for each possible destination network. In
particular, Solstice X.25 devices, listed under Interface , should be matched with
the appropriate host names listed under Gateway. The Gateway entry should, in
turn, be matched with the correct entry under Destination.

If there is not a routing table entry for each possible destination network, and you
are using static routing, add the appropriate static routes. If you are using dynamic
routing with in.routed , do the following:

1. Check that in.routed is running by typing:

# ps -ef | grep route
root process_id 1 80 Feb 22 1:55 /usr/sbin/in.routed -q

If the routing tables still are not correct, become superuser, and continue with the
next steps.

2. Kill in.routed and flush the routing tables:

#kill -9 process_id
#/usr/sbin route -f

where process_ID is the process ID displayed by the ps -ef command.

3. Restart in.routed as follows:

#/usr/sbin/in.routed
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Checking Permissions
If you attempt to use rsh or rlogin and receive the message
Permission denied , it is because the remote system’s /etc/hosts.equiv or
/.rhosts does not contain the sending system’s host name or does not contain the
line ‘+’. For example, if gateway_a is to have permissions for gateway_b , then
gateway_a should appear in the /etc/hosts.equiv file of gateway_b .

Checking Remote Operations
Check that remote operations are working correctly by using rlogin or rsh to
reach the remote host over the X.25 link. If this fails, it probably indicates that the
machines on each end of the link have different MTU sizes.

Checking NIS Operations
If your network or the network at the opposite side of the X.25 link run NIS, you
should ensure that NIS operation is working correctly. Type ypwhich at the
command line. You should receive the name of an NIS server on the internetwork as
a response. If you don’t, this indicates problems with NIS over the X.25 link.

On devices where the interface running Solstice X.25 is the only network interface,
you need to perform a few extra steps if you want to get NIS service from across the
link. You can do either of the following:

1. Make the remote machine the NIS server.

2. Assign an NIS server for the local machine.

If you choose the second option, do the following:

1. Become superuser.

2. Run ypbind as follows:

# ypbind -ypsetme

3. Assign a known NIS server to the local X.25 routing gateway, as follows:

# /usr/sbin/ypset server_addr

where server_addr is the IP address of an NIS server on the local network.
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Licensing Problems
Solstice X.25 only runs when a license is available. If you are using Solstice X.25, and
its license ceases to be available, the following message is printed to the console:

Solstice X.25, waiting to get license

If, after three attempts, the license is still unavailable, Solstice X.25 prints the
following message to the console and closes down:

Unable to regain license, X.25 closing down

The most likely cause is a network problem between the device running Solstice X.25
and the license server.
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APPENDIX A

Cabling

This appendix explains how to build:

� a synchronous null modem cable, for both RS-232-C and RS-449 interfaces

� an X.21-to-RS-449 converter

� an X.25 adapter cable that allows you to run Solstice X.25 over a serial interface on
a SPARCstation IPC or IPX

� a cable that lets you use the X.25 port on the SCiiExpress-X card as if it were an
HSI port

Note - The CPU serial port on a SPARCstation IPC or IPX can be jumpered for
RS-423. References here to RS-232-C apply to IPC/IPX RS-423 ports as well.

Null Modem Requirements
A synchronous null modem is a specially configured cable that simulates two
back-to-back modems. When the distance between two hosts is not great, you might
be able to use a null modem cable instead of more expensive synchronous modems
or synchronous modem eliminators. The use of the null modem cable described here
allows you to connect your Sun machine to another Sun or non-Sun machine, for
synchronous communication over a short distance.

The maximum distance at which a null modem cable can work is determined by the
specification for your serial port interface and depends greatly on the quality of the
cable you use.

You must perform the following steps to use a null modem cable for
machine-supplied clocking:
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� Build the null modem cable, according to the pin-outs provided here.

� In the x25tool Link Editor, set the Interface parameter so that one side is DTE
and the other side is DCE.

� In the x25tool Link Editor, set the Tx Clock parameter to the bit rate you want.

You can use a null modem cable with any of the Sun RS-232-C or RS-449 serial port
options, except the EXPX device, which cannot supply a clock.

Configuring Internal or External
Clocking
Solstice X.25 supports the following clocking alternatives:

� Transmit clock and receive clock are both external. This is the situation in which
clocking is provided by a synchronous modem or modem eliminator.

� Transmit clock is internal; receive clock is external. On the machine that is to
supply clocking, set the Tx Clock parameter to the bit rate you want in the Link
Editor in x25tool .

Note - You can only use an IPC/IPX in situations where clocking is external, that is,
where the remote (non-IPC/IPX side) supplies both the transmit and receive clocks.

Building the Null Modem Cable
The following subsections provide four null-modem-cable schematic diagrams. The
first pair of diagrams are RS-232-C null modems; the second pair are RS-449 null
modems. Within each pair, one diagram illustrates a null modem cable to connect
two Sun machines in which both Sun machines supply the clocking. The other
diagram illustrates a null modem cable to connect a Sun machine to another Sun or
non-Sun machine, in which only one Sun machine supplies clocking for both sides.

To build a null modem cable, you can configure your own cable or use a standard
cable with an adapter box. If you decide to use an adapter box, be sure to obtain an
adapter that allows you to change pin configurations. Pre-configured adapters
generally do not work with synchronous protocols because they do not handle clock
signals correctly.

For an RS-232-C cable, use a good quality, shielded wire. For an RS-449 cable, it is
best to use shielded, twisted-pair wire.
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RS-232-C Null Modem Cables
The following diagram illustrates a synchronous null modem that allows you to
connect two Sun machines that each supply clocking, using the RS-232-C interface.
Each Sun machine supplies clocking on pin 24. The null modem routes this clocking
to pin 17 on the opposite side to provide receive clocking.

In x25tool Link Editor window, set the Tx Clock parameter to the bit rate you want
(not External) on both machines.

TD (2)

RD (3)

RTS (4)

CTS (5)

DSR (6)

GND (7)

CD (8)

RXC (17)

DTR (20)

TC (24)

(2) TD

(3) RD

(4) RTS

(5) CTS

(6) DSR

(7) GND

(8) CD

(17) RXC

(20) DTR

(24) TC

Sun Machine Sun Machine

Figure A–1 RS-232-C Null Modem: Both Sun Machines Supply Clocking

The following diagram illustrates a synchronous null modem that allows you to
connect a Sun machine to another Sun or non-Sun machine, using the RS-232-C
interface. The Sun machine supplies both the transmit and receive clocks for the
other machine. Note that this null modem is not symmetrical.

In x25tool Link Editor, set the Tx Clock parameter to the bit rate you want (not
External) on the Sun machine that is to supply clocking.
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TD (2)
RD (3)

RTS (4)
CTS (5)

DSR (6)

GND (7)
CD (8)

RXC (17)

DTR (20)

TC (24)

(2) TD
(3) RD
(4) RTS
(5) CTS

(6) DSR

(7) GND
(8) CD

(17) RXC

(20) DTR

Sun Machine Sun or non-Sun Machine

(15) TXC

Figure A–2 RS-232-C Null Modem: Sun Machine Supplies Clocking for Both Sides

RS-449 Null Modem Cables
The following diagram illustrates a synchronous null modem cable that allows you
to connect two Sun machines that each supply clocking, using the RS-449 interface.
Each Sun machine supplies clocking on pins 17 and 35. The null modem cable routes
this clocking to pins 8 and 26 on the opposite side to provide receive clocking.

Because the RS-449 interface is balanced, there are two pins for each signal. For
example, in the diagram below, Send Data (SD), pins 4 and 22, is connected to
Receive Data (RD), pins 6 and 24. This means that pin 4 is connected to pin 6 and
pin 22 is connected to pin 24.

In x25tool Link Editor window, set the Tx Clock parameter to the bit rate you want
(not External) on both machines.
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SD (4,22)

RD 6,24)
RS (7,25)

CS (9,27)

DM (11,29)

SG (19)
RR (13,31)

RT (8,26)

TR (12,30)

TT (17,35)

(4,22) SD

(6,24) RD

(7,25) RS
(9,27) CS

(11,29) DM
(19) SG

(13,31) RR

(8,26) RT

(12,30) TR
(17,35) TT

Sun Machine Sun or non-Sun Machine

Figure A–3 RS-449 Null Modem Cable: Both Machines Supply Clocking

The following diagram illustrates a synchronous null modem cable that allows you
to connect a Sun machine to another Sun or non-Sun machine, using the RS-449
interface. The Sun machine supplies both the transmit and receive clocks for the
other machine. Note that this null modem cable is not symmetrical.

Because the RS-449 interface is balanced, there are two pins for each signal. For
example, in the diagram below, Send Data (SD), pins 4 and 22, is connected to
Receive Data (RD), pins 6 and 24. This means that pin 4 is connected to pin 6 and
pin 22 is connected to pin 24.

In x25tool Link Editor, set the Tx Clock parameter to the bit rate you want (not
External) on the Sun machine that is to supply clocking.
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SD (4,22)

RD (6,24)
RS (7,25)

CS (9,27)

DM (11,29)
SG (19)

RR (13,31)
RT (8,26)

TR (12,30)
TT (17,35)

(4,22) SD

(6,24) RD

(7,25) RS
(9,27) CS

(11,29) DM
(19) SG

(13,31) RR
(8,26) RT

(5,23) ST
(12,30) TR

Sun Machine Sun or non-Sun Machi n

Figure A–4 RS-449 Null Modem Cable: Sun Machine Supplies Clocking

X.21-to-RS-449 Converter
Tables A-1 and A-2 list the signals and names for RS-449 and X.21 circuits.

TABLE A–1 RS-449 Signals

Circuit Name Direction

SD Send Data To DCE

RD Receive Data From DCE

TT Terminal Timing To DCE

ST Send Timing From DCE

RT Receive Timing From DCE

RS Request to Send To DCE

CS Clear to Send From DCE

RR Receiver Ready From DCE

TR Terminal Ready To DCE
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TABLE A–1 RS-449 Signals (continued)

Circuit Name Direction

DM Data Mode From DCE

SG Signal Ground

TABLE A–2 X.21 Signals

Circuit Name Direction

G Signal Ground

T Transmit To DCE

R Receive From DCE

C Control To DCE

I Indication From DCE

S Signal Element Timing From DCE

B Byte Timing From DCE

The diagram below illustrates the pin connections required for an X.21-to-RS-449
converter.

S (6,13)

C (3,10)

R (4,11)

I (5,12)

G (8)

(4,22) SD

(8,26) RT

(7,25) RS

(9,27) CS
(6,24) RD
(13,31) RR
(19) SG

(5,23) ST

T (2,9)

Figure A–5 X.21-to-RS-449 Converter
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Using the X.21 interface as an HSI
Note - The information in this section applies only to the x86 version of the product.

If you want to use the X.21 interface provided by the SCii Express-X card in the same
way as an HSI interface, make up a cable as below:

Port A

T (18,17)
R (24,3)
S (10,9)

C (11,20)

I (19,8)

T (1,25)
R (2,14)

S (15,16)

C (12,13)

(4,22) SD
(6,24) RD
(8,26) RT
(12,30) TT
(7,25) RS

(13,31) RR

(4,22) SD
(6,24) RD
(8,26) RT
(12,30) TR

I (5,4)
(7,25) RS
(13,31) RR

Port B

EXPX HSI

Figure A–6 X.21 Interface Configured as an HSI

IPC/IPX X.25 Adapter Cable
You can build an adapter cable to run Solstice X.25 over the 8-pin serial port on a
SPARCstation IPC or IPX.

Table A–3 lists the pin-outs in the X.25 Adapter Cable.
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TABLE A–3 Pin-outs for IPC/IPX Adapter Cable

Signal Name Female DB-25 Pin Number DIN-8 Pin Number

TD 2 3

RD 3 5

RTS 4 6

TC 15 2

GND 7 4

DCD 8 7

RC 17 8

DTR 20 1

Note - Pin-15-to-pin-2 is the only difference from the asynchronous DIN-8-to-DB-25
cable, which has DB-25 pin 5 pinned to DIN-8 pin 2.
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APPENDIX B

Parameter Values Quick Reference

This appendix summarizes the parameters stored in the X.25 configuration files, their
format and valid parameter values. The configuration files are contained in the
/etc/opt/SUNWconn/x25/config directory.

File link_config_0000.cfg configures link 0. In the default configuration, this is
a WAN link. File link_config_0001.cfg configures link 1. In the default
configuration, this is a LAN link.

There is a separate configuration file for each link. The filename is of the format
link_config_ n.cfg , where n is the link number. These are the files that will be
read when the Solstice X.25 is next started. Editing them is equivalent to editing the
configuration while using x25tool in static mode. Use a different naming
convention if you want to save changes without using them on the next restart.

To create a new non-MLP WAN link use file link_config_0000.cfg as a
template. Copy it and giving the new file the correct name for the link you want it to
apply to. For example, to configure port 3 as a WAN link, call the file
link_config_0003.cfg .

To create a new MLP WAN link, use the sample file
/etc/opt/SUNWconn/x25/Samples/def_mlp_config.cfg as a template.

To create a new LAN link, copy and rename the file link_config_0001.cfg . Then
edit the new file to use the values you want.

Each configuration file is composed of a series of sections, one for each part of the
configuration. In the case of an MLP configuration file, the LAPB and WAN sections
become sub-sections of the MLP section. Refer to the
/etc/opt/SUNWconn/x25/Samples/def_mlp_config.cfg file to see how this
works.

Table B–1 summarizes the available sections, keywords and parameters. Refer to
Chapter 7 for a discussion of the meaning and use of the available parameters.
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Note - All timer values are given in seconds.

TABLE B–1 Configuration File Content

Section Keyword Valid Parameter Values

Parameter
Value
Default

IDENTIFICATION PRODUCT_NAME Solstice X.25

PRODUCT VERSION 9.2

FILE_TYPE x25link

MODIFIED_BY user_id

FILE_DATE date

LINK device /dev/ devicenamen

local_address A valid X.121 or MAC address

full_address linkno. address

type WAN, LAN

version 1980, 1984, 1988

mode DTE, DCE

protocol LAP, LAPB, LLC2, MLAPB

description 32 character string

MLP mlp_window Numerical value between 0 and 4095 10

mlp_guard Numerical value between 1 and 4095 10

mt1_val Timer value in seconds, between 1.0 and
300.0

2.0
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TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

mt2_val Timer value in seconds, between 1.0 and
300.0

2.0

mt3_val Timer value in seconds, between 1.0 and
300.0

2.0

mn1_val Numerical value between 1 and 255 10

LAPB n2_count Numerical value between 1 and 255 10

t1_timer Numerical value between 1 and 300 9.0

pf_timer Numerical value between 1.0 and 300 0.7

reject_timer Numerical value between 1.0 and 1000 2.5

busy_timer Numerical value between 1.0 and 3000 10.0

idle_timer Numerical value between 0 and 3200 25.0

rr_ack_delay Numerical value between 0 and 300 0.4

unack_max Numerical value between 0 and 127 3

local_win For modulo 8 networks, a numerical value
between 1 and 7. For modulo 128 networks,
a numerical value between 1 and 127.

local_probe For modulo 8 networks, a numerical value
between 1 and 7. For modulo 128 networks,
a numerical value between 1 and 127.

ign_ua_error Y( es) or N(o)

frmr_frmr_error Y( es) or N(o)

frmr_invrsp_error Y( es) or N(o)
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TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

sframe_pbit Y( es) or N(o)

no_dm_adm Y( es) or N(o)

iso8882 Y( es) or N(o)

sabm_in_x32 Y( es) or N(o)

initial_down Y( es) or N(o)

mlp_priority Numerical value between 1 and 12 1

WAN line_speed EXTERNAL, 110, 300, 600, 1200,
2400, 4800, 9600, 19200, 38400,
48000, 56000, 64000, 128000,
256000, 512000, 1.024M, 1.536M,
2.048M

max_frame max_iframe_len plus 1

connect_proc NONE or V25

v25_callreq Numerical value between 6.0 and 30

LLC2 n2_count Timer value between 1 and 255 10

t1_timer Timer value between 1.0 and 300.0 9.0

pf_timer Timer value between 1 and 300.0 0.7

reject_timer Timer value between 1 and 1000.0 2.5

busy_timer Timer value between 1 and 3000.0 10.0

idle_timer Timer value between 0 and 3200.0 25.0

rr_ack_delay Timer value between 0 and 300 0.4
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TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

unack_max Numerical value between 0 and 127 3

local_probe Numerical value between 0 and 127 0

xid_window Numerical value between 1 and 127 7

xid_ndup Numerical value between 0 and 255 2

xid_tdup Numerical value between 0 and 300 5

X25 network X25_80, X25_84, X25_88, X25_LLC,
X25_CIRCUIT

plpmode Normal or Auto

pvc_range Pair of numerical values 0-0

inc_range Pair of numerical values 0-0

out_range Pair of numerical values 0-0

two_range Pair of numerical values 512-575

modulo 8 or 128 8

use_negotiation Y(es) or N(o)

bar_negotiation Y(es) or N(o)

src_addr_control 0

accept_revchg Y(es) or N(o)

prev_chg Y(es) or N(o)

fast_select Y( es) or N(o)
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TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

fs_r_response Y(es) or N(o)

bar_nonpriv_listen Y(es) or N(o)

locmaxpktsize 7,8,9,10,11,12

remmaxpktsize 7,8,9,10,11,12

locdefpktsize 7,8,9,10,11,12

remdefpktsize 7,8,9,10,11,12

locmaxwinsize Numerical value between 1 and 127 7

remmaxwinsize Numerical value between 1 and 127 7

locdefwinsize Numerical value between 1 and 127 2

remdefwinsize Numerical value between 1 and 127 2

maxnsdulength Numerical value between 1 and 32000 256

ackdelay Numerical value between 1 and 3200.0 5

t20value Timer value between 0 and 3200.0 180.0

t21value Timer value between 0 and 3200.0 200.0

t22value Timer value between 0 and 3200.0 180.0

t23value Timer value between 0 and 3200.0 180.0

t24value Timer value between 0 and 3200.0 75.0

t25value Timer value between 0 and 3200.0 180.0
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TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

t26value Timer value between 0 and 3200.0 180.0

t28value Timer value between 0 and 3200.0 0.0

idlevalue Timer value between 0 and 3200.0 0.0

connectvalue Numerical value between 0 and 3200.0 200.0

ack_delay Numerical value between 0 and 3200

r20value Numerical value between 1 and 255 1

r22value Numerical value between 1 and 255 1

r23value Numerical value between 1 and 255 1

r28value Numerical value between 1 and 255 1

localdelay Numerical value between 0 and 32 0.005

access_delay Numerical value between 0 and 32 0.005

locmaxthclass Numerical value between 0 and 15 12

remmaxthclass Numerical value between 0 and 15 12

locdefthclass Numerical value between 0 and 15 12

remdefthclass Numerical value between 0 and 15 12

locminthclass Numerical value between 0 and 15 4

remminthclass Numerical value between 0 and 15 4

sub_cug Y(es) or N(o)
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TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

sub_pref_cug Y(es) or N(o)

sub_cugia Y(es) or N(o)

cug_format Basic or Extended

bar_cug_in Y(es) or N(o)

bar_incall Y(es) or N(o)

bar_outcall Y(es) or N(o)

sub_toa_npi_fmt Y(es) or N(o)

bar_toa_npi_fmt Y(es) or N(o)

sub_nui_override Y(es) or N(o)

bar_call_x32_reg Y(es) or N(o)

acc_nodiag Y(es) or N(o)

use_diag Y(es) or N(o)

ccitt_clear_len Y(es) or N(o)

bar_diag Y(es) or N(o)

disc_nz_diag Y(es) or N(o)

acc_hex_add Y(es) or N(o)

intl_prioritised Y(es) or N(o)

iso_8882_mode Y(es) or N(o)

192 Solstice X.25 9.2 Administration Guide ♦ October 1999



TABLE B–1 Configuration File Content (continued)

Section Keyword Valid Parameter Values

Parameter
Value
Default

send_x121_to_lan Y(es) or N(o)

insert_x121_from_lan Y(es) or N(o)

datapac_priority Y( es) or N(o)

dnic Any legal DNIC 0000

intl_addr_recogn 0, 1, 2, 3

prty_encode_control 0, 1, 2

prty_pkt_forced_val 0,4,5,6,7,8,9,10,11,12

dbit_accept_in clear, leave or zero

dbit_accept_out clear, leave or zero

dbit_data_in clear, leave or zero

dbit_data_out clear, leave or zero

thclass_neg_to_def Y(es) or N(o)

thclass_type Array of 16 integers

thclass_wmap Array of 16 integers

thclass_pmap 4,5,6,7,8,9,10,11,12
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APPENDIX C

Error Messages and Error Codes

Error Messages are generated by the Solstice X.25 software, and tell you that there
may be a mistake in the configuration. Error Codes are generated by your
communication service and may indicate a problem with the remote host.

Note - The information given below does not contain an exhaustive list of all the
messages that can appear while using Solstice X.25, since many of the messages are
self-explanatory. If you receive a message which is not listed here and is not
self-explanatory, contact your authorized service provider for assistance.

Error Messages
Invalid Address Extension

Check and re-enter the extension.

Invalid Characters or Invalid Length in Address Extension

Check and re-enter the extension.

Missing Address Extension

Enter the address extension.

Invalid Character in Called Address or in Calling Address

Check and re-enter the address.

Invalid Character in Calling Address
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Check and re-enter the address.

Invalid Address Local SAP

Check and re-enter the local SAP.

Invalid Address Loop SAP

Check and re-enter the loop SAP.

Invalid Character in Call User Data

Check and re-enter the Call User Data.

Specify the HTML browser before starting Help

To use on-line help with x25tool , you must first specify the browser you want to
use (Netscape, Hot Java, Mosaic).

Invalid DNIC

Check and re-enter the DNIC

Cannot allocate memory

Free up memory and try again.

Cannot load file <file_name> : <cause>

The cause displayed with this message should give you some indication of the
problem. Correct the problem and try again.

The file does not exist, or is in the wrong format

Check that the file exists and is in the right format.

Error loading file for link# <link id>

The file may be in the wrong format.

Cannot open lapb device

The X.25 network must be up before the lapb device can be opened.

Cannot open x25 device

The X.25 network must be up before the x25 device can be opened.

NO IXE file

The file is missing.
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Error opening directory %s

The directory may not exist.

Error opening file %s

The file may not exist.

Error Messages Related to Read and Write
Permission
The following error messages can occur if you do not have read and write
permission. If you receive one of the messages listed below, log in as root or
become superuser , and try again.

Cannot add dynamically this IP interface

Cannot add dynamically this link

Cannot load dynamic parameters for link <link>

Cannot load dynamic parameters for NUI

Cannot load dynamic parameters for Route

Cannot remove dynamically this IP interface

Cannot remove dynamically this link

Cannot reset this link

Cannot save dynamically IP Interface Parameters

Cannot save dynamically IP Map Parameters

Cannot save dynamically LAPB Parameters

Cannot save dynamically LLC2 Parameters

Cannot save dynamically MLP Parameters

Cannot save dynamically NUI Parameters

Cannot save dynamically Pad Daemon Parameters

Cannot save dynamically PAD Printer Parameters

Cannot save dynamically PVC
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Cannot save dynamically Routing Parameters

Cannot save dynamically X25 Security Parameters

Cannot save dynamically WAN Parameters

Cannot save dynamically this Link

Cannot get running links list

Error creating backup of boardconf file

Error creating backup of ipconf file

Error creating backup of ixemapconf file

Error creating backup of pvcmapconf file

Error creating backup of nuimapconf file

Error creating backup of paddconf file

Error creating backup of padmapconf file

Error creating backup of routes file

Error creating backup of x25secuconf file

Error creating backup of x25secupid file

Cannot create a symbolic link from <source file> to <destination
file> <causes>

Error creating backup of x29profile file

Error creating backup of xhosts file

Error creating backup of xtpmapconf file

Unable to Execute Command

Unable to Execute Command <command name>

File <filename> is read-only Change the permissions and re-do

Cannot remove symbolic link <symbolic_link>

Error writing boardconf file

Cannot write in Directory <directory_name>
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Error writing ipconf file

Error writing ixemapconf file

Error writing pvcmapconf file

Error writing nuimapconf file

Error writing paddconf file

Error writing padmapconf file

Error writing routes file

Error writing x25secuconf file

Error writing x25secupid file

Error writing x29profile file

Error writing xhosts file

Error writing xtpmapconf file

Error Messages Relating to File Format Problems
The following messages indicate a problem with the format of the file. This type of
problem can be avoided by using x25tool whenever possible, instead of directly
editing files.

nuimapconf: Bad facility: non-digit locdefpktsize

nuimapconf: Bad facility: overlong locdefpktsize

nuimapconf: Bad facility: non-digit locdefthclass

nuimapconf: Bad facility: overlong locdefthclass

nuimapconf: Bad facility: non-digit locdefwsize

nuimapconf: Bad facility: overlong locdefwsize

nuimapconf: Bad facility: non-digit remdefpktsize

nuimapconf: Bad facility: overlong remdefpktsize

nuimapconf: Bad facility: non-digit remdefthclass
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nuimapconf: Bad facility: overlong remdefthclass

nuimapconf: Bad facility: non-digit remdefwsize

nuimapconf: Bad facility: overlong remdefwsize

nuimapconf: Unexpected character in facility string

xtpmapconf: invalid address <address> for device xtp<device>

xtpmapconf: invalid cud <cud> for device xtp<device>

xtpmapconf: incorrect device

xtpmapconf: incomplete line in config file

xtpmapconf: invalid link number : <link_number> for device
xtp<device>

xtpmapconf: invalid opt <opt> for device xtp<number>

xtpmapconf: invalid printer name <printername> for device
xtp<number>

route file: AEF already set: <aef>

route file: bad type of AEF: <aef>

route file: AEF must be in Hexa : <aef>

route file: source_aef not supported, skipped

route file: too long AEF: <aef>

route file: bad source_aef entry

route file: bad link number

route file: bad right-hand part of aef entry

route file: bad tag <tag> at line <line_number>

route file: Mac address already set <mac_address>

route file: bad 802 address <address>

route file: mismatched quotes at line <line_number>

route file: unknown keyword on line <line_number>
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route file: parse error at line <line_number>, truncated file?

route file: Pid already set <pid>

route file: bad Pid <pid>

route file: Pid must be hexa <pid>

route file: Odd length pid <pid>

route file: Pid too long <pid>

route file: PSTN number already set <PSTN_number>

route file: PSTN missing <PSTN_number>

route file: PSTN number must not exceed 16 digits <PSTN_number>

route file: too many items on line <line_number>

route file: X.121 address already set <x121_address>

route file: bad X.121 <x121_address>

route file: bad X.121 <x121_address>

route file: bad right-hand part of X.121

route file: too long X.121 <x121_address>

x25secuconf, line <line_number> :Bad address

x25secuconf, line <line_number> : No more than 15 digits in X121
address

x25secuconf, line <line_number> : Invalid character in address

x25secuconf, line <line_number> :Bad date

x25secuconf, line <line_number> :Bad day number

x25secuconf, line <line_number> :Bad link id

x25secuconf, line <line_number> :Bad month

x25secuconf, line <line_number> : Invalid repetition period

x25secuconf, line <line_number> :Bad time

x25secuconf, line <line_number> :Bad year number
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x25secupid, line <line_number> : Error in reading pid

x25secuconf, line <line_number> :error in get_service_name

x25secupid, line <line_number> : No * after 128 digits in pid

x25secupid, line <line_number> : pid len must be even

Missing service name <service_name> in x25secuconf file

x25secuconf, line <line_number> :Service name too long

x25secupid, line <line_number> : Invalid Character in pid

x25secupid, line <line_number> :character not authorized in
service name

Unexpected Hold-Down Timer value <timer_value> Assumed to be
X.25 mode from V8 config file

Unexpected ’Unconfigured Host’ value on line <line_number>
Assumed to be Reset Action from V8 config file

Unrecognized option at line <line_number>, processing PAD Daemon
file

Invalid Characters or Invalid Length in PID

x25secupid, line <line_number> :error in read_service_name

x25secupid, line <line_number> :Service name too long

Error Codes
A problem with an X.25 application might be a result of a problem communicating
with the PSDN or a problem with the remote host. When a problem causes your call
to be cleared, you receive a diagnostic code in the form of two pairs of digits. The
first pair indicates why the call was cleared; the second pair gives additional
diagnostic information. The tables on the following pages specify the meanings for
these numeric codes. Table C–1 specifies reasons for call-clearing. Table C–2 specifies
diagnostic information in addition to the call-clearing cause.

In many instances, if you receive any of these error codes, you will need to contact
your service provider. However, in some instances the error code may indicate a
configuration problem that you can correct yourself.
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A zero (00) call-clearing code indicates that the call-clearing request originated in the
remote host. A non-zero call-clearing code indicates the call-clearing request
originated in the PSDN.

For example, your call is cleared with a code 03 42. As specified in Table C–1, 03
indicates an invalid facility request. Table C–2 tells you that 42 (hex) means that a
facility parameter (that you used) is not allowed. This combination of messages tells
you that:

1. The problem was detected by the PSDN, not by the remote host.

2. One or more parameter settings that you made in x25tool are unacceptable to
the PSDN.

Often, a diagnostic gives only a general clue as to the source of a problem. For
example, your call might be cleared with the code 00 42, indicating an invalid facility
parameter setting. You might, in fact, have a facility parameter set to a value outside
of the range of what you subscribed to. However, you can also receive this message
if the maximum I-frame size is set to a size lower than the PSDN expects. Solstice
X.25 clears the call rather than allow it to start and possibly fail later.

If you receive error code 00 42 and are not subscribing to any facilities, or are
confident that your facilities parameters settings are correct, confirm that you and
your PSDN agree on the maximum I-frame size. Remember that any adjustment of
the maximum I-frame size, a LAPB parameter, might also require a change to the
default packet size parameter, at the X.25 Packet Layer. Use x25tool to modify your
link configuration as necessary.

In Table C–1 note the four categories of codes, separated by the double horizontal
lines:

� The first category, code 00 , indicates that the call-clearing request originated with
the remote host. The remaining codes, in all other categories, indicate that the
call-clearing request originated within the PSDN.

� Codes in the second category (hexadecimal code 01 through 29) indicate problems
between the PSDN and the remote host.

� Codes in the third category (hexadecimal code 03 through 13) indicate problems
between the local host and the PSDN.

Codes in the fourth category (hexadecimal codes 05 through 15) indicate problems
within the PSDN. Table C–1 lists the fourth category causes for call clearing codes:
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TABLE C–1 Causes for Call Clearing

Hexadecimal
Code Decimal Code Meaning

00 00 Originated by remote DTE

01 01 Number busy

09 09 Out of order

11 17 Remote procedure error

19 25 Reverse charging acceptance not subscribed

21 33 Incompatible destination

29 41 Fast select acceptance not subscribed

03 03 Invalid facility request

0B 0B Access barred

13 19 Local procedure error

05 05 Network congestion

0D 13 Not obtainable

15 21 RPOA out of order

Table C–2 lists the X.25 diagnostic codes.
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TABLE C–2 X.25 Diagnostic Codes

Hexadecimal
Code Decimal Code Meaning

00 00 No additional information

01 01 Invalid P(S) (send-packet sequence number)

02 02 Invalid P(R) (receive-packet sequence number)

10-1F 16-31 Invalid packet type

20 32 Packet not allowed

21 33 Unidentifiable packet

22 34 Call on one-way logical channel

23 35 Invalid packet type on a permanent virtual circuit

24 36 Packet on an unassigned logical channel

25 37 Reject not subscribed to

26 38 Packet too short

27 39 Packet too long

28 40 Invalid general format identifier

29 41 Restart with nonzero in bits 1-4, 9-16

2A 42 Packet type not compatible with facility

2B 43 Unauthorized interrupt confirmation

2C 44 Unauthorized interrupt

30 48 Timer expired
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TABLE C–2 X.25 Diagnostic Codes (continued)

Hexadecimal
Code Decimal Code Meaning

31 49 For incoming call

32 50 For clear indication

33 51 For reset indication

34 52 For restart indication

40 64 Call setup problem

41 65 Facility code not allowed

42 66 Facility parameter not allowed

43 67 Invalid called address

44 68 Invalid calling address

Note in the table above that hexadecimal codes 0, 20 , 30 , and 40 (decimal 0, 32 ,
48 , and 64) stand for general messages that include the specific conditions indicated
by the codes that follow them. Your PSDN might return only the codes that stand for
the general messages.

Table C–3 lists X.25 diagnostic codes that you might receive when you are running
Solstice X.25 over the Connection-Oriented Network Service (CONS).

TABLE C–3 CONS Diagnostic Codes

Hexadecimal
Code Decimal Code Meaning

Sent by CONS

E0 224 Unspecified

E1 225 Disconnect—transient

E2 226 Disconnect—permanent
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TABLE C–3 CONS Diagnostic Codes (continued)

Hexadecimal
Code Decimal Code Meaning

E3 227 Reject—transient

E4 228 Reject—permanent

E5 229 QOS not available—transient

E6 230 QOS not available—permanent

E7 231 NSAP unreachable—transient

E8 232 NSAP unreachable—permanent

E9 233 Unspecified Reset

EA 234 Reset due to congestion

EB 235 Unknown NSAP

Sent by CONS user (TP0/TP2)

F0 240 Unspecified

F1 241 Normal disconnect

F2 242 Abnormal disconnect

F4 244 Reject—transient

F5 245 Reject—permanent

F6 246 No QOS—transient

F7 247 No QOS—permanent
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TABLE C–3 CONS Diagnostic Codes (continued)

Hexadecimal
Code Decimal Code Meaning

F8 248 Incompatible NS user data

FA 250 User Reset

Note that you receive the reset codes, hexadecimal numbers E9, EA, and FA, in Reset
Request/Indication packets. You receive the remaining codes in Clear Request/
Indication packets.
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APPENDIX D

Installing the Solstice Site/SunNet/
Domain Manager Agent

The Solstice Site/SunNet/Domain Manager agent (hereafter referred to as Domain
Manager agent) is included with Solstice X.25 in the SUNWx25bpackage. When
Solstice X.25 is installed, the Domain Manager agent and its associated files are
copied to the /opt/SUNWconn/x25/snm directory.

The Domain Manager agent is designed for use on Solaris 7 and Solaris 8 systems.

Note - The Solstice Site/SunNet/Domain Manager agent was formerly called the
SunNet Manager agent.

To install the Domain Manager agent on a system running Solstice X.25, log in as
root and do the following:

1. Install the SUNWsnmagpackage on the system where this agent is to run.

This package is part of the Solstice Site/SunNet/Domain Manager product. It
contains all the standard Domain Manager agents, together with the libraries they
need to run.

Note - If you are installing the Domain Manager agent on an x86 system, you
will need to install the SUNW86nmaand SUNW86nmcpackages instead.

2. Copy the files na.x25 and x25.schema from the /opt/SUNWconn/x25/snm
directory to the Domain Manager agents directory.

This directory is usually named /opt/SUNWconn/snm/agents .

3. Add the following line to include Solstice X.25 in the inetd.conf file:
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na.x25/10 tli rpc/udp wait root /opt/SUNWconn/snm/agents/na.x25 na.x25

4. Add the following line to either the /etc/rpc file (if you are not using a
naming service such as NIS), or to your rpc.bynumber map (if you are using a
naming service).

x25 100114 na.x25

5. If the Domain Manager console is not running locally, add the following line
to the file /etc/opt/SUNWconn/snm/snm.conf

na.x25.trap.host hostname

where hostname is the name of the system where the Domain Manager console is
running.

6. Kill then restart inetd .

Use the ps ---e command to display the process number of the inetd process.
Then, as root, enter a kill -HUP command to restart the inetd daemon. For
example:

hostname# ps -e | grep inetd | grep -v grep
120 ? 0:02 inetd hostname# kill -HUP 120

Repeat steps two to four and step six on the Domain Manager console.

On the Domain Manager console machine, to retrieve information on a Solstice
X.25 VC from a target Solstice X.25 machine, use the “quick dump” or “data
report” SNM requests. The following is an example of output received from the
X.25 agent:

Wed Jul 15 05:20:32 1999 [ fullmoon ] : Quick Dump: x25.circuit
pid lcn linkid in/out hdlc_state pkt_lev state opkts ipkts address

0 4095 2 IN UP UP Data Transfer 25 39 222210101

The fields in the agent output are explained as follows:

lcn

logical channel number of virtual circuit being reported on
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linkid

link number on which the virtual circuit takes place

in or out

direction of virtual circuit (either the initiator or receiver of call)

hdlc_state

state of the LAPB link, up or down

pkt_lev

state of the X.25 layer, up or down

state

state of the X.25 network software, unknown, up, or down

opkts

Number of packets sent (valid only if connection is up; reset to zero when
connection is up)

ipkts
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Number of packets received (valid only if connection is up; reset to zero
when connection is up)

address

X.121 address of remote host

For more information on Domain Manager and the Domain Manager Agent,
consult the Solstice Site/SunNet/Domain Manager Administration Guide.
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APPENDIX E

Using the Solstice X.25 SNMP Agent

The Solstice SNMP agent (simple network management protocol) is included with
Solstice X.25 9.2. SNMP is a non-proprietary network management protocol that runs
over TCP/IP. If you have SNMP installed on a server, you may want to also install
the Solstice X.25 SNMP Agent. You can then run the SNMP agent over a network
that includes non-Sun machines. You can also use the SNMP agent with the Domain
Manager (formerly SunNet Manager).

Solstice X.25 9.2 implements three MIBs (management information bases) which are
defined in the IETF standards: RFC1381, RFC1382, RFC1461.

Using the SNMP Agent with SNMP
The snmpx25d daemon is the background server process for SNMP requests. To start
the daemon, in x25tool , select Options ⇒ Start SNMP Agent automatically. The
snmpx25d daemon will start when X.25 starts as long as the file
/etc/rc3.d/snmpx25.control exists.

Alternatively, you can link the script /etc/init.d/snmpx25.control with
/etc/rc3.d/snmpx25.control to allow automatic starting of this server process
when the system is booted.

To stop the daemon, in x25tool , select Options ⇒ Don’t Start SNMP Agent
automatically

Note that:

� The snmpx25d daemon does not implement the SNMP SET commands

� The snmpx25d daemon does not implements the SNMP TRAPS

� The snmpx25d daemon does not reply to incoming SET request
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The SNMP configuration file is /etc/opt/SUNWconn/x25/snmpx25d.conf . The
snmpx25d program logs traces in the file /var/opt/SUNWconn/snmpx25dlog.

Using the SNMP Agent with Solstice
Site/SunNet/Domain Manager
Note - The Solstice Site/SunNet/Domain Manager was formerly called the SunNet
Manager (SNM).

The SNMP agent can also be used with Solstice Site/SunNet/Domain Manager. To
install the SNMP agent so that you can run it on a console running Solstice Domain
Manager, log on as root and do the following:

1. Copy the files snmp-x25.oid and snmp-x25.schema from the /opt/SUNWconn/
x25/snmp directory to the SNM Agent directory.

This directory is usually named /opt/SUNWconn/snm/agents .

2. Use the build_oid command to rebuild the SNM OID database.

Refer to the Solstice Site/SunNet/Domain Manager Administration Guide for more
information about this process.

For more information, consult the Solstice Site/SunNet/Domain Manager
Administration Guide.
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APPENDIX F

Compatibility with SunNet X.25 7.0

Solstice X.25 9.2. is compatible with earlier versions of X.25, however, if you are using
SunNet X.25 7.0, you need to know about some particular features of Solstice X.25
9.2 that make it backwards compatible with version 7.0. You have no need of these
features if you do not use SunNet X.25 7.0. The backwards compatibility features are:

� The sockets programming interface. This is described in the Solstice X.25 9.2
Programming Guide.

� The vcstat command. This is described below.

� Direct access to layer two (HDLC) . A number of communications applications use
HDLC. It is therefore possible to run layer two as a standalone protocol.

This appendix also contains a section of “Compatibility Tips” on page 223, to help
you make the most efficient use of your configuration.

The vcstat Command
Note - This command has been included as it is familiar to users of SunNet X.25 7.0.
In general, use x25stat , see “Checking the Datalink Layer” on page 162.

The vcstat command allows you to monitor link and virtual circuit statistics, on a
cumulative or periodic basis. The command has the following syntax

% /opt/SUNWconn/bin/vcstat [-L] [-n] [-l interface] [-i interval ] [-p period]

The vcstat options are explained as follows:

-L Display link-related statistics instead of virtual
circuit statistics. By default, vcstat displays
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virtual circuit statistics. Examples of displays for
each type of statistics are shown below.

-n Display only cumulative (since reboot) statistics,
instead of periodically updated display. By
default, vcstat displays current statistics at
30-second intervals.

-l interface Display statistics for the link specified by
interface. This interface corresponds to the number
specified for the interface parameter in your link
configuration file.

-i interval Sampling interval for display of cumulative
statistics. If you omit this and the -n options,
vcstat displays cumulative statistics at 30-second
intervals.

-p period Specifies the length of time, in minutes, vcstat
will run when it is displaying current statistics.
By default, vcstat displays statistics for 1440
minutes (24 hours).

-v virtual circuit Specify a virtual circuit or range of virtual
circuits.

-S symbolic address Specify a symbolic address.

Virtual Circuit Statistics
Without the -L option (that is, by default), vcstat displays statistics for all currently
active virtual circuits, rather than for links. For example:

hostname% /opt/SUNWconn/bin/vcstat -i10
Tue Sep 18 16:24:23 1990

If LCN State Substate Sent Recv Remote address MAC address
O 1 0x200 Data 0/0/0/0 130 130 129.144.133.2
O 1 0x201 Data 0/0/0/0 679 5180 10002244
I 2 0x202 Data 0/0/0/0 501 641 20009988 08:00:20:07:11:a1,0e

The fields and headings in the above example display are explained as follows:

Column 1 (no heading) In the first column you see either O, for an
outgoing call; I, for an incoming call; or P, for a
permanent virtual circuit.
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If Identifies the link over which the call was made.
Corresponds to the value of the Link Number
parameter in the Link Editor window in
x25tool .

State Displays Data when the call is in the data
transfer phase of the connection.

Substate Displays four toggles (1 is true, 0 false). From left
to right these are:

� Sent Receive Not Ready

� Sent Interrupt

� Received Interrupt

� Received Receive Not Ready

Sent and Recv Displays the number of frames sent and received
since the last reboot. (These counts are not reset if
you stop and restart your link.)

Remote Address This field displays the following types of
addresses:

� IP addresses for virtual circuits used for IP
connections

� AEFs. This type of address is accompanied by
a string, osi, partial-osi, or non-osi, indicating
the type of AEF.

� X.121 addresses

To display a name or partial name from the
xhosts table, use the ---s option.

MAC Address An LSAP address is present for virtual circuits
running over LLC2.

Link Statistics
With the -L option, vcstat displays link-related, rather than virtual-circuit-related,
statistics. It displays statistics for all currently active links. For example, to see
link-related statistics, updated every 10 seconds, you enter:
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hostname% /opt/SUNWconn/bin/vcstat -L -i10
Wed Sep 19 08:56:52 1990
If Type State SABM Recv Sent Abort Crc Over Under

0 hdlc UP 3 1112 1141 8 20 13 21
1 hdlc UP 3 239 268 17 45 4 4
2 llc UP 1 601 589 4 12 0 0

The fields in the vcstat output are explained as follows:

If Identifies the link number over which the call
was made. Corresponds to the value of the Link
Number parameter in Link Editor window in
x25tool .

Type Can be lapb or llc, identifying the type of
connection. The designator lapb indicates a
serial-link connection, while llc indicates an LLC2
connection over a LAN.

Note - For LLC2, vcstat collects statistics on a
per-physical-link basis, not per dynamic LLC2
link.

State Displays UP when the call is in the data transfer
phase of the connection and DOWN when the
call is being set up or taken down. Further,
displays DOWN-SABM when the link is down
and a SABM has been sent; DOWN-FRMR, when
a link is down and a Frame Reject has been sent;
and DOWN-DISC, when a link is down and a
Disconnect has been sent.

SABM Indicates the number of Set Asynchronous
Balanced Mode frames that have been sent. This
type of frame is used to establish a frame-layer
connection.

Recv and Sent Displays the number of frames sent and received
since the last reboot. (These counts are not reset if
you stop and restart your link.)

Abort Displays the number of aborted received frames.
Occurs when the local serial port received a
sequence of eight consecutive ones, in violation
of LAPB framing rules. Abort errors result from
an interruption in the service provided by the
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link or from clocking problems. Such errors
might also be caused by the software running
over Solstice X.25. A small number of abort
errors probably indicates a software problem
rather than a broken link or a persistent clocking
problem.

Crc Reports the number of received frames with CRC
(Cyclical Redundancy Check, an error detection
method) errors. A CRC error is recorded when
the checksum on a received frame is incorrect.
CRC errors occur when there is a clocking
problem (different rates on each side) or a noisy
line.

Over Reports the number of receiver overrun errors.
Such errors occur when the local system is
unable to accept data fast enough and the port
hardware buffers overflow. A frame that is not
completely received is aborted, triggering error
recovery. Underrun errors can occur when the
signaling rate in use on a link is too fast for the
local system.

Under Reports the number of transmitter underrun
errors. Such errors occur when the local system is
too busy to service the serial port hardware. A
frame that is not completely sent is aborted,
triggering error recovery. Underrun errors can
occur when the signaling rate in use on a link is
too fast for the local system.

High-Level Data Link Control
Note - The Solstice X.25 9.2 LAPB driver implements an interface that is compatible
with SunNet X.25 7.0’s HDLC interface. This has been included for
backward-compatibility with SunNet X.25 7.0 only. In other situations, use LAPB
plus DLPI. This implementation of HDLC does not support hdlcconf .

Solstice X.25 9.2 supports the Application Program interface that was available in
SunNet X.25 7.0. An application program can open an HDLC device as a file and can
control HDLC through SunOS system calls.
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Before starting X.25, you need to associate the HDLC driver with the relevant WAN
port. To do so, enter:

hostname#: iflayer ifdn portname

Application Program
You can access HDLC from a program with the same interface used at the user level,
the ifnet device. A program can perform all the user-level tasks presented above with
standard system calls.

Note - This description assumes that you are familiar with the system calls open(2),
close(2), read(2), write(2) and ioctl(2). It also assumes that the ifnet device has been
initialized and layered.

All of the contents and structures used are in the following include files:

#include <stdio.h>
#include <fcntl.h>
#include <errno.h>
#include <sys/ioctl.h>
#include <sundev/syncstat.h>
#include <nethdlc/hdlc_ioctl.h>
#include <sys/types.h>
#include <sys/socket.h>
#include <net/if.h>

Access HDLC by opening the ifd device attached to it. In the examples, this is
/dev/ifd0 . For example:

fid = open (‘‘/dev/ifd0’’, )_RDWR);

To configure HDLC, invoke ioctl(2) as follows:

int fid, error;
struct hdlc_param_req hpr;
struct hdlc_param *hdlc_param

hdlc_param = &hpr.hp:
/* set fields in structure pointed to by hdlc_param */
error = ioctl(fid, HDLC_SET_PARAM, (caddr_t) &hpr);

where fid is the value returned by open, HDLC_SET_PARAMis the call to set the
parameters, and hdlc_param is a structure defined as follows:
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struct hdlc_param {
u_short hp_t1; /*T1 - P-bit timer (msec) */
u_short hp_t2; /*T2 - max delay before ACK (msec) */

u_short hp_t3; /*T3 - max idle link time (msec)
u_short hp_t4; /*T4 - LLC2 busy timer (msec) */
u_short hp_t5; /*T5 - LLC2 reject timer (msec) */
u_short hp_t6; /*T6 - Ack timer (msec) */
u_short hp_tick; /* resolution of timer (msec/tick) */
u_short hp_n1; /*N1 - max frame size - bytes */
u_char hp_n2; /*N2 - max retries (used with T1, T4) */
u_char hp_xcntl; /* extended control - mod 128 */
u_char hp_k; /* K - window size */
u_char hp_addr; /* address */

The value hp_t1 corresponds to the ---t1 flag parameter of hdlcconf command
and the values hp_t2 , hp_t3 , hp_tick , hp_n1 and hp_n2 correspond similarly.
The hp_xcntl is a boolean value. If it is set, then the implementation will operate in
Asynchronous Balanced Mode Extended. Otherwise, it will run in Asynchronous
Balanced Mode. The window size is set with hp_k . Lastly, set the HDLC address
with hp_addr and the following values:

#define LAPB_ADDR_A 0x03 /* commands to DTE secondary */
/* responses from DTE secondary */

#define LAPB_ADDR_B 0x01 /* commands to DCE secondary */
/* responses from DCE secondary

Setting Parameters
The kernel does not check the parameters, it assumes they are set to reasonable
values. Take care when setting them, as wrong parameters can affect the operation of
the HDLC link.

Before setting the parameters, it is advisable to get them first with the ioctl call
HDLC_GET_PARAM. The HDLC_SET_PARAMand HDLC_GET_PARAMcalls have the
same parameter format.

After setting the HDLC parameters, start HDLC by making the following call:

int fid;
error = ioctl (fid, HDLC_INIT, 0);

In Solstice X.25 9.2 this is equivalent to executing hdlcstart in SunNet X.25 7.0.

Data Transfer
To transfer data to or from HDLC, use read (2) and write (2) . Each operation
corresponds to an HDLC frame, which means that each read call will return only
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one packet, even if there is more data waiting and room in the buffer. If there is not
enough room in the buffer for the current frame, read fails, and the frame is
discarded. The buffer passed to a write call corresponds to a single HDLC frame.
Calls to write with a length greater than the maximum frame size (hp_n1 ) fail.

Statistics

Note - The command x25stat returns more complete statistics than those returned
by the procedure shown below.

To get the same statistics as those returned by hdlcstate in SunNet X.25 7.0, your
program should run the HDLC_STATSioctl call as follows:

int fid, error;
struct hdlc_stats_req hsr;
struct hdlc_stats *hdlc_stats;

hdlc_stats = &hsr.he;
error = ioctl(fid, HDLC_STATS, (caddr_t) &hsr);
/* results are in structure pointed to by hdlc_stats */

The hdlc_stats is of type struct hdlc_stats shown below:

struct hdlc_stats {
u_short hs_state; /* hdlc state */
u_short hs_sentsabms; /* sabms sent */
struct ss_dstats hs_data; /* data stats */
struct ss_estats hs_errors; /* error stats */

The value hs_sentsabmns is the cumulative total of SABMS that were transmitted,
including retry attempts. The field hs_state can be any one of the following:

#define HDLCLINK_DOWN 0 /* initial state */
#define HDLCLINK_SABM 1 /* SABM outstanding
#define HDLCLINK_FMR 2 /* FRMR outstanding */
#define HDLCLINK_DISC 3 /* DISC outstanding */
#define HDLCLINK_UP 4 /* information transfer state */

The structures ss_dstats and ssestats are defined in the file
<sundev/syncstat.h> as follows:
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struct ss_dstats {
long ssd_spack; /* input packets */
long ssd_opack; /* output packets */
long ssd_ichar; /* input bytes */
long ssd_ochar; /* output bytes */

];

struct ss_estats {
long sse_abort; /* abort received */
long sse_crc; /* CRC error */
long sse_overrun; /* receiver overrun */
long sse_underrun; /* xmitter underrun */

Their values correspond to the Total bytes and Errors lines of the hdlcstate
display.

Shutdown
Normally, HDLC remains up for as long as the remote host is physically connected
to the local port. For this reason, close (2) does not affect the state of HDLC, and
any packets queued for output are transmitted.

To shut down HDLC, execute the following ioctl:

int fid;
error = ioctl(fid, HDLC_RESET, 0);

This puts the line into the HDLCLINK_DOWNstate. Calls to read and write will fail,
and errno is set to ENETDOWN. This is the same call that hdlcstop uses.

Compatibility Tips
Follow the tips in the section to make the best possible use of a network that has
systems running both SunNet X.25 7.0 and Solstice X.25.

Point-to-Point Configurations
If you configure an IP point-to-point link between a machine running the current
release of Solstice X.25 and a machine running SunNet X.25 7.0, configure the 7.0
machine as the “caller”, rather than “called”. This role is determined by the value of
the mode parameter in the x25mgr configuration file. See page 118 of the SunNet
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X.25 7.0 System Administration Manual for a description of the mode parameter. Also,
you should set the Disconnection Timer to a high value.

The reason for this is the different treatment of IP point-to-point links by SunNet
X.25 7.0 and the current release of Solstice X.25. The 7.0 product keeps switched
virtual circuits up all of the time in support of point-to-point links, while the current
release drops the virtual circuits after a specified period of inactivity. If a 7.0 machine
is configured as “called”, rather than “caller”, it is not able to establish an IP
connection with a current-release machine until the latter machine sends a Call
Request. This does not occur until the current-release machine has IP packets to send
to the 7.0 machine. If the 7.0 machine is configured as “caller” (as it should be), there
remains the problem that the current-release machine drops the virtual circuit upon
inactivity. When this occurs, the 7.0 machine immediately calls to re-establish the
virtual circuit. If your PSDN charges for call setup (as many do), such behavior
becomes very expensive. To avoid this, change the Disconnection Timer to a figure
that will keep the virtual circuit up long enough to outlast periodic gaps in IP traffic.

Setting the Max. NSDU
If you have an IP/X.25 link between a current-release Solstice X.25 machine and a
machine running SunNet X.25 7.0, set Max NSDU to at least 1024. Otherwise IP
connections can hang when a high volume of data is sent from the 7.0 machine. If
you have two current-release machines on each side of the link, set Max NSDU to be
the same on both sides. It can be as high as 8192.
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Glossary

agent A process, usually corresponding to a particular managed object,
that carries out request from a manager.

Bits per second
(bps)

The number of bits passed per second.

Call Communication between two DTEs using a virtual circuit.

CCITT Consultative Committee for International Telephony and
Telegraphy. Previous name of the ITU-T.

Closed User Group
(CUG)

A PSDN-provided service that permits the DTEs belonging to the
group to communicate with each other, but precludes
communication with other DTEs. A single DTE can belong to
multiple CUGs. The PSDN, not the caller or called parties, enforce
the limitation inherent in a CUG.

Data
Circuit-terminating
Equipment (DCE)

The network side of the user-to-network interface. Commonly
corresponds to a modem or other device used to connect to a PSDN.

Data Network
Identification Code
(DNIC)

A four-digit number that identifies a specific PSDN. The DNIC is
the first component of a complete X.121 address and is comparable
to the exchange portion of a telephone number used for switched
telephone service. In a DNIC, the first three digits make up a data
country code, which identify a country, while the remaining digit
can be used to distinguish up to 10 different networks within the
specified country.

Data Terminal
Equipment (DTE)

The device at the user’s side of a user-to-network interface. This
might be a computer system (packet-mode DTE) or a character-mode
terminal (DTE-C), and is both a source and destination for data.
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Data Terminal
Equipment-
Character Mode
(DTE-C)

A character-mode (asynchronous) terminal that uses a PAD to
connect to a remote host across a PSDN. Part of the Solstice X.25
software plays the role of a DTE-C when you use the PAD
application that is shipped with the product.

Defense Data
Network (DDN)

A network administered by the US Department of Defense, that
uses a form of X.121 to IP address mapping defined in RFC 1236.

Duplex Circuit or modem that allows for simultaneous two way data
transmission.

Facility An optional service offered by a public network’s administration.
Usually requested by the user when subscribing.

Flag A sequence of bits that signifies the beginning and end of a frame.

Frame The unit of information used at layer 2 of the X.25
Recommendations.

I-Frame A frame containing data—an Information Frame.

International
Telecommunication
Union—
Telecommunication
Standardization
Sector (ITU-T)

An international organization of communication carriers, most of
which are government telephone and telegraph agencies. The ITU-T
develops telecommunication standards through the use of their
recommendations. The X.25, X.3, and X.29 standards are ITU-T
Recommendations.

LAPB The datalink layer protocol specified by the X.25 Recommendations.

Logical Channel An association between two DTEs through which they exchange
data.

MLP MultiLink Procedure. This provides the datalink layer allowing a
DTE and a DCE to connect using more than one WAN interface.

MIB Management information base. A collection of objects that can be
accessed through the SNMP agent.

Octet The ITU-T’s term for an 8-bit byte.

Packet A sequence of bits representing data and associated control
information. Is self-contained in that it has routing and
packet-sequence information. Commonly used to refer to the
structure and format defined by the X.25 recommendation.
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Packet switching A data transmission technique in which user information is broken
up into discrete, self-contained units called packets. Packet
switching has two distinctive characteristics: 1) it allows a
communication channel to be shared by many users, each using the
circuit only for the time required to transmit a single packet and 2)
it allows for the individuals packets that make up a message to be
routed over the optimal path of a given moment. See packet.

Packet Assembler/
Disassembler (PAD)

A device that resides between one or more character-mode devices,
such as asynchronous terminals (or terminal emulation software),
and a PSDN. On the terminal side, the PAD accepts asynchronous
characters, assembles packets from these characters, and forwards
the packets to the PSDN. On the PSDN side, the PAD accepts
packets, disassembles the packets into asynchronous characters, and
forwards the characters to the terminal(s).

Packet-Switched
Data Network
(PSDN)

A more general term than Public Data Network, refers to any public
or private packet-switching network that provides X.25-compliant
interfaces to its users.

Permanent virtual
circuit (PVC)

A permanent, logical association between two physically separate
DTEs that does not require call set-up or clearing procedures.
Analogous to a leased line in a circuit-switched telephone network.

Public Data
Network (PDN)

A data communications network whose services are available to any
user willing to pay for them. Tymnet and Telnet are examples of
PDNs in the United States; the public telephone and telegraph
agencies of European and Asian nations are also examples of PDNs.
Solstice X.25 product documentation usually uses the term
“Packet-Switched Data Networks” in preference to “Public Data
Network”, as the former is more general than the latter.

Recognized Private
Operating Agency
(RPOA)

An X.25 user facility that provides for user specification of a
particular RPOA transit network through which a call is to be
routed internationally when more than one RPOA transit network
exists at an international gateway.

SNMP Simple Network Management Protocol, the standard network
management protocol used in TCP/IP networks.

SNMP agent The process that carries out requests from SNMP.

Subaddress An optional component of an X.121 address that identifies a specific
application on a DTE.
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Switched virtual
circuit (SVC)

A temporary logical association between two physically separate
DTEs that exists only for the duration of the data transfer. Call
setup and call clearing procedures are required with a switched
virtual circuit. Analogous to an everyday phone call on a
circuit-switched telephone network.

Throughput The rate at which data is passed through a particular system.

V25bis The recommendation that defines dial-up X.25.

Defines the interface between PADs and packet-mode DTEs or other
PADs.

X.3 Describes the functions of the PAD and the various parameters used
to specify its mode of operation.

X.21bis A set of CCITT recommendations that define the physical interface
between a DTE and a DCE of a public data network. Access to the
DCE is through synchronous modems and voice-band lines.
Equivalent to RS-232-C and V.24/V.28.

X.25 client An application layered above X.25.

X.28 Defines the format of the terminal user’s instructions to the
PAD—referred to as PAD command signals—and the format of the
PAD’s responses to the terminal—referred to as PAD service signals.

X.29 Defines the interface between PADs and packet-mode DTEs or other
PADs.

X.32 The recommendation that defines the security procedures used for
dial-up access to public PSDNs.
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Index

Numbers
7-bit mode

setting, 100
8-bit mode

setting, 100
1984 and 1988 features, 5

A
Abandon X.32 registration on SABM, 73
Accept Calls

call filtering, 114
Accept Incoming PAD calls, 101
Accept Unknown Hosts, 96
accept_revchg, 79
access_delay, 90
acc_hex_add, 81
acc_nodiag, 80
Ack Timer (T1)

LAPB parameter, 70
LLC2 parameter, 74

ackdelay, 89
action on BREAK, 106
Address Extension

routing, 112
Address is, 103
Address Mapping, 94
admintool

setting up printer, 57
AEF

default, 112
host, 111
prefix, 112

Alias
PAD calls, 99

Allow hex digits in DTE address, 81
Allow omission of diagnostic packets, 80
arp, 143
authentication, 11

B
back to back

example configuration, 115
backward compatibility

interface description, 219
Bar non-priviledged listeners, 81
bar_call_x32_reg, 79
bar_cug_in, 79
bar_diag, 81
bar_incall, 79
bar_nonpriv_listen, 81
bar_outcall, 79
bar_toa_npi_fmt, 79
binary speed, 106
bits per second, 225
Boards

definition, 33
browser

specifying, 34
Busy-state Timer

LAPB parameter, 71
LLC2 parameter, 75

busy_timer, 71, 75
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C
cable

straight-through, 35
cabling

instructions, 175
problems, 158

Call Accept In, 91
Call Accept Out, 91
call filtering

accept calls, 114
Call Filtering parameters

configuring, 63
calling address, 114
link number, 114
service name, 113

Call Indications, 81
Call Request Response, 87
Call User Data, 94, 130

outgoing PAD calls, 99
PAD configuration, 103
PAD printer, 109

call-clearing codes, 203
Called Address, 94

listener criteria, 56
matching pattern for incoming calls, 102
specifying, 69

Calling Address
call filtering, 114
listener criteria, 56
matching pattern for incoming calls, 103

Calling Procedures, 74
CCITT, 225
ccitt_clear_len, 81
character delete, 107
checking

hardware, 161
high speed interface line status, 162
licensing, 173
line status, 161, 162
network layer, 169
NIS operation, 172
permissions, 172
physical layer, 161
protocol status, 169
remote operations, 172

Circuit is, 96
Clear Flag

PAD printer, 109
Clear Req Response, 88
clocking alternatives, 176
closed user group

Closed User Group parameter, 79, 97, 100
number, 98
type, 97

compatibility with X.25 7.0, 215
component layers, 12
configuration files, 41

conversion, 41
editing, 45
format, 43
keywords, 43
template, 44
templates, 43
values, 43

configuration, updating, 23
connection

checking, 170
identifying, 66

connectvalue, 89
connect_proc, 74
CONS diagnostic messages, 206
CRC errors, 162
CUG, 225

format, 79
NUI, 110, 111
Number, 98
number, 100
type, 100, 111

CUG Type, 97
cug_format, 79

D
D-bit, 91
D-bit Control, 90

response to, 91
data delivery, 106
data forwarding, 105
Data In, 91
Data Out, 91
datalink layer, 13

troubleshooting, 162
DATAPAC

(1976), 82
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Priority Bit, 82
Traffic Class, 82

datapac_priority, 82
dbit_accept_in, 91
dbit_accept_out, 91
dbit_data_in, 91
dbit_data_out, 91
DCE, 225

setting, 69
DDN, 226
Defense Data Network, 4, 130
description, 66
device, 66, 68
Device

link level, 66
Device Number

PAD printer, 109
Devices file, 154
diagnostic packets

allowing omission of, 80
Disallow diagnostic packets parameter, 81
disallowing, 81
specifying use of, 81

dial-up
access, 10
Dial-up parameter

idle disconnect, 89
example configuration, 136
link, 35

Dialcodes file, 154
Dialers file, 155
Discard diagnostics on non-Zero LCN, 81
disconnection timer, 95
disc_nz_diag, 81
DNIC, 69, 83
dnic, 83
DNIC, 225
Domain Manager

using with SNMP agent, 214
DTE, 225

address—allowing hex digits in, 81
clear request, 89
registration request, 90
reset request, 89
restart request, 89
setting, 69
window status, 88
window status transmission timer, 88

DTE/DCE
resolution, 89
selection of, 69

duplicate MAC XID
count, 76
timer, 76

dynamic mode, 24, 32

E
echo, 104
echo mask, 107
Edit menu, 26
Editing, 107
Enable X.32 Authentication, 73
error codes, 202
error messages, 195

STREAMS, 169
error state in LAPB

specifying behavior, 72
Exit menu, 25
exiting x25tool, 25
Expedited Data Action, 95
Extended Address, 78, 96, 98
Extension, 78, 97

PAD configuration, 98
external clocking, 176

F
facilities

Facilities parameter, 79
list of supported, 5
specifying optional, 79

Fast Select, 80, 100
fast_select, 80
features

1984, 5
1988, 5

File
Load from, 25
Load running, 25
menu, 25
Save, 25
Save as, 25

flow control, 18
by PAD, 105

Index-231



by terminal, 106
Forced Packet Size, 83
forwarding delay, 105
FR on Inv. Resp. if in ERROR, 72
FR on receipt of FR if in ERROR, 72
Frame Window Size, 68
frmr_frmr_error, 72
frmr_invrsp_error, 72
full_address, 78

G
Global Defaults, 101
Group Busy Timer, 77

H
hardware

checking, 161
HDLC, 215, 219

application program, 219
Help

using, 34
high speed interface

che, 162
loopback test, 161

Hold Down Timer, 95
hsi_loop, 161
hsi_stat, 162

I
I-Frame, 18
identifying connection, 66
Identity, 73, 92
Idle Disconnect, 89
idlevalue, 89
idle_timer, 71, 75
ifconfig, 169
Ignore UA if in ERROR state, 72
ign_ua_error, 72
in.routed, 171
incoming call

specifying barring of, 79
inc_range, 70
Initial Command

entering, 56
global, 101, 103

Initial state of link, 73

initial_down, 73
Insert X.121 address in Call Indications, 81
insert_x121_from_lan, 81
Interface Type

WAN, 69
internal clocking, 176
Internal Delay, 90
international calls

prioritization of, 82
specifying treatment of, 82

International Telecommunication
Union—Telecommunication
Standardization Sector, , see
ITU-T,

Interrupt Response, 88
intl_addr_recogn, 82
intl_prioritised, 82
IP Interface Configuration, 49
IP Mapping, 51

window size, 97
X.25 packet size, 97

IP network number, 19
IP over X.25, 49

example configuration, 126
IP router, 137
IP routing, 19, 129
IP Subnet Mask, 93
ISO 8208, 86
ISO 8882, 73, 81
iso8882, 73
iso_8882_mode, 81
ITU-T, 11, 226

Recommendations, 2

K
Keep X.121 address in Call to LAN, 81

L
LAN

example configuration, 141
idle disconnect, 89

LAP mode
WAN, 69

leased lines, 10
licensing
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checking, 173
Line Delay, 90
Line Delete, 107
Line Display, 107
Line Feed Insertion, 107
Line Folding, 106
line speed, 18
line status

checking, 161, 162
checking onboard serial port, 162

troubleshooting, 161
line_speed, 68
link

adding, 26
checking status of, 215
copying, 26
deleting, 26
Link(s) Status parameter, 31
modifying, 26
pasting, 26
resetting, 31
routing, 111
starting, 31
stopping, 31

Link Description, 66
Link Editor

overview x25tool, 26
Link Idle Timer, 71

LLC2 parameter, 75
link layer

bringing up, 158
link level

device name, 66
traces, 163

Link Number, 66, 96, 99
call filtering, 114
PAD printer, 109
routing, 112

Link Selection, 99
Link Type, 66
Listen Information

X.25 parameters, 94
Listener Criteria, 102

changing, 56
local address

WAN interface, 69
local charging

preventing, 79

Local IP address, 93
Local Packet

PVC Options, 85
Local SAP, 78, 143
Local Window

PVC Options, 85
local_address, 69
local_delay, 90
local_probe, 71, 75
locdefpktsize, 69
locdefwinsize, 68, 87
locmaxpktsize, 69
locmaxwinsize, 68, 87
Log PAD calls, 101
logging trace information, 167
logical channel ranges, 36, 45, 144, 159

Logical Channel Ranges parameter, 70
loopback

example configuration, 115
over LAPB, 115
over LLC2, 119
test high speed interface, 161

Loopback SAP, 78, 143
Lost Frame Timer, 77

M
MAC address, 143

MAC Address parameter
routing, 112

mapping remote IP addresses, 130
Max Conns, 78
max NSDU length, 224
Max RR Delay

LAPB parameter, 71
LLC2 parameter, 75

Max Tries
LLC2 parameter, 74
(N2)

LAPB parameter, 71
maximum transmissions (N2) LAPB

counter, 71
maximum unacknowledged I-frames

LAPB parameters, 71
LLC2 parameter for, 75

maxnsdulength, 86
MaxUnACKed IPDUs, 71

Index-233



LLC2, 75
max_lan_conns, 78
MLP, 14, 17

Physical Ports associated with this
Link, 77

MLP Priority, 72
MLP Window, 77
mlp_priority, 72
mlp_window, 77
mn1_val, 77
mode, 69
modem, 35, 136

cables, 161
problems, 158

modulo
specifying modulo, 86

MT1, 77
mt1_val, 77
MT2, 77
mt2_val, 77
MT3, 77
mt3_val, 77
MTU, 93
multilink operation, 14
multiple WAN links

example configuration, 131

N
N1 Count, 77
N2, 71, 74
N2 counter

LLC2 parameter, 74
n2_count, 71, 74
name

link level device, 66
National DNIC, 83
national DNIC, 83
National DNIC

specifying, 83
Native mode

PAD paramaters, 102
Negotiate Towards Defaults, 86
netstat, 170

—i, 169
—r, 169

network, 69
Network

Link(s) Status, 31
menu, 28
Reset link, 31
Start link, 31
Start X.25, 28
Stop link, 31
Stop X.25, 28

network address
checking, 170

network layer
checking, 169

Network Profile
specifying modulo, 86

Network User Identifier Parameters, 110
NIS, 172

operation, 169
checking, 172

No DM on entry to ADM state, 73
Non-native mode

PAD parameters, 102
nonprivileged listeners

barring, 81
no_dm_adm, 73
NSAP, 78
NTN, 69
NUI, 110

CUG, 110
NUI Parameters

configuring, 59
override, 80
packet format, 110
packet size, 110
throughput class, 110
window size, 110

null modem cable, 175
building, 176

O
onboard serial port

checking line status, 162
OSI NSAP, 78
outgoing call

specifying barring of, 79
Outgoing International Calls, 82
out_range, 70
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P
P-bit Timer

for LAPB, 70
LLC2 parameter, 75

packet acknowledgment, 18
Packet Format

NUI, 110
packet header, 15
Packet Layer Protocol, 15
packet level traces, 163
Packet Map, 92
packet size, 18

Packet Size parameter, 69, 97
Maximum NSDU Length, 86
NUI, 110
PAD configuration, 99

specifying non-default, 69
Packet Switched Data Network, 10
PAD calls, 131
PAD configuration, 52, 123
PAD Daemon Listen Database, 125
PAD Hosts Database, 52, 98
PAD Listen Database, 54
PAD parameters, 102

native mode, 102
PAD printer

Call User Data, 109
clear flag, 109
configuring PAD printer, 57
device number, 109
link number, 109
printer name, 108
setting timeout, 59
timeout, 109
X.121 address, 109

PAD Printer parameter, 57
PAD profiles

PAD Profile parameter
X.3 parameters, 99

supported, 99
padding after

carriage return, 106
line feed, 107

page wait, 108
parameters

obtaining text record of values, 162
parity, 108

PC
example configuration, 144

pending acknowledgement delay timer, 89
Pending Ack Delay parameter, 89

permanent virtual circuit, 11
permissions

checking, 172
Permissions file, 154
pf_timer, 70, 75
physical layer, 12

checking, 161
troubleshooting, 161

Physical Ports associated with this Link
MLP, 77

PID, 112
ping, 169, 170
Point to

point or multipoint, 93
point-to-point link

compatibilty with X.25 7.0, 224
Port Number, 68
power cables, 161
Pre-emption Timer, 95
prev_chg, 79
printer

setting up using, 57
Printer Name

PAD printer, 108
Prioritize International Calls, 82
Priority Encoding, 82
protocol, 69
Protocol ID

routing, 112
protocol statistics, 166
protocol status, 169
prty_encode_control, 82
prty_pkt_forced_value, 83
PSDN, 2, 35, 45

messages returned from, 202
public network, 17
PVC, 18
PVC Number, 85
PVC Options, 84

Local Packet, 85
Local Window, 85
Remote Packet, 85
Remote Window, 85
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setting, 85
pvc_range, 70

R
R20, 89
r20value, 89
R22, 89
r22value, 89
R23, 89
r23value, 89
R28, 90
r28value, 90
recall character, 104
Registration Request, 88
Reject Timer

LAPB parameter, 71
LLC2 parameter, 75

reject_timer, 71, 75
remdefpktsize, 69
remdefwindsize, 68, 87
remmaxpktsize, 69
remmaxwinsize, 68, 87
remote address

PAD configuration, 98
remote IP address, 93
remote operations

checking, 172
Remote Packet

PVC Options, 85
Remote Window

PVC Options, 85
Remote X.121 Address, 98

PAD printer, 109
Remote X.25 Address, 96
Reset Action, 95
Reset Confirm Timer, 77
Reset Link, 31
Reset Response, 87
Restart Response, 87
Restrict Clear Lengths, 81
retransmission counter

R20, 89
R22, 89
R23, 89

reverse charge, 100
Reverse Charge parameter, 100

IP mapping, 97

reverse charging, 79
rlogin, 131, 137, 169
Route Type, 111
routes

static, 171
routing

address extension, 112
configuring parameters, 61

IP, 129
link number, 112
MAC address, 112
Protocol ID, 112
Routing parameter, 111, 134
telephone number, 113
X.121 address, 112

routing table
checking, 171

RPOA Numbers
IP mapping, 97
PAD configuration, 100

rr_ack_delay, 71, 75
RS-232-C interface, 177
RS-232-C null modem cable, 177
RS-449 interface, 178
RS-449 null modem cable, 178
RS-449 Signals, 180, 181

S
sabm_in_x32, 73
SCiiExpress-X card, 144, 161, 182
Send FR if S-Frame and no P-bit, 73
send_x121_to_lan, 81
Service Name

call filtering, 113
service signals, 105
Services, 49, 51, 52
sframe_pbit, 73
Signature, 73
single link operations, 13
size negotiation

Size Negotiation parameter, 80
specifying setting for, 80

SNMP agent
starting, 32
stopping, 32
using with Domain Manager, 214
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using with SNMP, 213
sockets programming interface, 215
Solstice X.25 overview, 1
source address

Source Address Control parameter, 83
specifying control of, 83

SPARCstation IPC/IPX, 182
Start link, 31
static mode, 24, 32
statistics

generating for X.25, 28
stop link, 31
strace, 162, 167

summary, 167
STREAMS

error messages, 169
strerr, 162, 169
Strict ISO8882 Conformance, 81
sub_cug, 79
sub_cugoa, 79
sub_nui_override, 79
sub_pref_cug, 79
sub_toa_npi_fmt, 79
sun_cugia, 79
SVC, 18
switched virtual circuit, 11
syncloop, 161
syncstat, 162
Systems file, 155

T
T1 timer, 70, 74
t1_timer, 70, 74
T20 timer, 87
t20value, 87
T21 timer, 87
t21value, 87
T22 timer, 87
t22value, 87
T23 timer, 88
t23value, 88
T24 timer, 88
t24value, 88
T25 timer, 88
t25value, 88
T26 timer, 88
t26value, 88

T28, 88
t28value, 88
tariff structure, 17
TCP/IP, 49, 126
TELENET

non-standard throughput classes, 86
Telephone Number

routing, 113
template

configuration files, 44
terminal type, 107
terminology, 225
testing

loopback, 161
thclass_neg_to_def, 86
thclass_pmap, 92
thclass_type, 86, 91
thclass_wmap, 92
throughput class, 18

Throughput Class parameter, 86
NSDU length, 86
NUI, 110

Throughput Class Type parameter, 91
Throughput map, 92
timeout

setting for PAD printer, 59
Timeout parameter

PAD printer, 109
timer

T1, 70, 74
T20, 87
T21, 87
T22, 87
T23, 88
T24, 88
T25, 88
T26, 88

Timers, 95
tip

configuring, 156
TOA/NPI addressing

specifying, 79
TP Class

throughput class, 110
trace information

logging, 167
traces
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packet and link level, 163
Transmit Probe, 71

LAPB parameter, 71
LLC2 parameter, 75

troubleshooting, 158
line status, 161
permissions

checking, 172
physical layer, 161
system panic, 161

two_range, 70
Tx Clock

line speed, 68
type, 66

U
unack_max, 71, 75
Use diagnostic packets, 81
use_diag, 81
use_negotiation, 80
uucp, 153

V
V-series interfaces, 12
V.25 Call Request Timer, 74
V.25 calling procedures, 139
v25_callreg, 74
vcstat, 215
Version

network, 69
virtual circuit, 11

checking status of, 215

W
WAN link

configuring, 35
Welcome Banner

configuring, 55
global, 101, 104
incoming PAD calls, 101, 104

Window Map, 92
values for non-standard X.25 networks, 92

Window Rotation, 88
window size, 18

Window Size parameter
NUI, 110
PAD configuration, 99
throughput class, 87

Window Size
X.25 parameters, 97

X
X.121 address, 36, 45, 69, 140, 144

in call indications, 81
in call request, 81
prefix, 136
X.121 Address parameter

routing, 112
X.121 defaults, 111
X.121 host, 111
X.121 prefix, 111
X.21 interface, 182
X.21 Signals, 181, 187
X.21-to-RS-449 converter, 180
X.25

dynamic mode, 32
starting, 28, 32
static mode, 32
statistics, 28
stopping, 28, 32
technical overview, 9

X.25 Adapter Cable
for SPARCstation IPC/IPX, 182

X.25 packet size, 97
X.25 parameters, 93

Listen Information parameter, 94
window size, 97

X.25 Parameters for IP Mapping, 97
X.25 Recommendation, 144
X.25 Retranmission Counters, 89
X.25 routing, 134
X.25 routing table, 140
X.25 Timers, 87
X.25 Transit Delays, 90
X.3 parameters, 104
X.32 authentication procedures, 139
X.32 protocol, 11
x25info utility

for creating configuration record, 162
x25stat, 162, 166
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x25tool
Boards, 33
Edit menu, 26
File, 25
Help, 34
menu items, 25
Network, 28
Options, 32
overview, 21
Services, 32
setting PVC options, 85
starting, 21
using, 22

x25trace, 162, 163
x25_x32_enable_authen, 73
x25_x32_identity, 73, 92

X29 type, 100
x86, 35

example configuration, 144
XID Window Size

LLC2 parameter, 76
xid_ndup, 76
xid_tdup, 76
xid_window, 76
xmit hung, 158
xty device, 153

Y
ypbind, 172
ypwhich, 172
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